
SAWStudio / SAWStudioLite Latest Release Info

Introduction
Welcome to SAWStudio. This environment offers an exciting new vision from Bob Lentini. The interface is
built around the idea of a virtual console and multitrack recorder intimately interwoven together to offer an
entirely new way of manipulating audio and building entire audio projects in the virtual world.

Please take some time to explore the built-in HelpFile and also download the .pdf version of the manual,
available at www.SAWStudio.com. The navigation capabilities are powerful and complex and will require some
getting used to. Reading, exploring and practicing inside the environment will greatly enhance your experience
of the interface. We feel the rewards gained for the time invested, will be great. Have fun!

Version History Follows:

>====<

Version 5.8a
Enhancements
* Expanded the max Output Channels for VST Plugins to 64 which should help with compatibility for plugins

like Kontakt 6 and others.

Bug Fixes
* Adjusted code to compensate for VST Plugins that store very large amounts of data with their settingsin edls

and other file saves. This code should now fix some plugins ability to save settings with session and other
template files.

>---<

Version 5.8
Enhancements
* Modified code to enhance performance in Win 7, 8 and 10. The use of the SACLink in these newer

operating systems no longer suffers with performance bogdowns. Performance now matches or exceeds XP.

* The helpfile now includes specific Win 10 tweaks.

Bug Fixes
* Fixed code that could overrun a few array variables when Max Count input and output devices are used.

>---<



Version 5.7
Enhancements
* Corrects HtmlHelp issues on some systems which will fail on the first attempt after a system reboot.

* A new menu item has been added to the Options/SACLink menu called Input Mix Data From SAC Input
Chans To Cur Track (Active/Selected). This option imports mix data from selected active SAC input chans
and offsets the first one to the current MultiTrack HotTrack. The following chans stack in order without
altering the MT layout. This option allows specific SAC chans to be offset in the MT for overdubbing to any
track, while still importing the SAC chan settings. The Track order in the MT is not altered. The Record
template is properly setup as well.

Video Track Viewer Version 3.8
* Added code to use the Lav Splitter in the K-Lite Codec Pak for .mov files.

* Now allows File dialog resizing.

Video Track Viewer Version 3.9
* Allows Extended Monitor rendering to external video projectors to stay active even when SAWStudio is

minimized off the screen.

Bug Fixes
* Fixed Edit Dialog box sizing to not cut off text on Win 7, 8 and 10.

* Fixed an issue with VST Plugin initialization that could cause certain VST Plugins to crash when patched.

* Fixed code that could cause a crash when displaying the Record Setup window under certain conditions.

* Opening a Mix Template with selected Mixer chans no longer disturbs existing plugins on non-selected
Mixer chans.

>---<

Version 5.6
Enhancements
* Opening Mix Template Files will now respond to selected Mixer Chans and only overlay those chans with
the new template data.

* All window views are now "Border Padding" aware for better Win 7, 8 and 10 compatibility.

* Re-compiled the helpfile into the newer html help .chm format. This allows for better searching and
indexing as well as allows the helpfile to open correctly in Win 7 and 8 and 10.

* Added code to keep Helpfile ontop and keep from loading multiple instances.



* When the SACLink is active, playback in the Soundfile View will now warn if SF Samplerate is different
than SAC instead of play at the incorrect speed.

* Added code modifications for better Win 8 and 10 compatibility.

Bug Fixes
* Fixed code to avoid crash when Record is activated thru the SACLink and no active record meters are set in

SAWStudio.

* Fixed code to properly control Midi Control Surface STOP, PLAY and REC lites on the MCUPro thru
SACLink.

* Fixed code for the Blend Session function to only affect mix data for blended tracks with active entries. All
other chan mix data is untouched.

>---<

Version 5.5
Enhancements
* Added SACLink Record Bus functionality. When the SACLink is now active with a SAC Host of Version
4.0 or greater, the SAC record chan list offers an extra 8 record bus channels. These will process data from SAC
Out Assigned Record bus links. Each of the SAC Master Outs and Aux Master Outs on all mixers can now be
assigned to the Record Buses as well as Device Outs. This allows you to direct outputs for record as well as
inputs. These assignments must be made manually. They will not automatically import with the Import SAC
Mix Data function.

* Added SACLink midi ctrl template transport functions. Now the Mackie and Icon midi templates can send
stop, play and record messages to SAWStudio thru the SACLink.

Bug Fixes
*

>---<

Version 5.4
Enhancements
* Enhanced the code to help recognize more wav file formats that could not be opened previously.

* Added Smpte Format 60 Non-Drop and 59.94 Non-Drop to the Smpte Format Menu. These options can be
used on the timeline with the Video Viewer but can not be generated, triggered or chased.

Video Track Viewer Version 3.7



* Added code to recognize Smpte Format 60 Non-Drop and 59.94 Non-Drop.

Bug Fixes
* Fixed code that could cause record meter latency on slave machines recording in SRP mode with a host that

includes an active Midi Workshop session.

* Fixed code to stop SRP playback across a marked area from muting armed record track data when Record is
not actively engaged and one of the Tape Style Monitoring modes is active.

>---<

Version 5.3
Enhancements
* Modified code to allow closer to sample accurate host/slave recording start and end points when using SRP

and punching in and out before stopping. This allows the host and slave sessions to be blended with close to
sample accuracy of both sets of files. This, of course, depends on using a word-clock sync between machines
or a common master clock feeding both machines. Some slight adjustment between files from both
machines may still be required once the session is blended.

* Modified code to extend VST Plugin compatibility to the 2.4 version changes which should help with newer
plugin compatibility issues. Not all new options are yet supported but this should allow many newer plugins
to be used that otherwise would not load.

Bug Fixes
* Added .aif and .aiff files to the qualifier field when browsing for a missing file location.

>---<

Version 5.2
Enhancements
* Modified the wav file header routine to handle newer format wav files with extended header chunks. This

will now open some wav files that would not open before.

* Included new MotorMix Midi Controller Template that adds the Next and Last switches to jump console
sections.

* Enhanced Show Control Playback mode to recognize Control Track Stop commands within a Show Control
entry and allow the next Show Control playback toggle to continue playback within the same entry instead
of forcing a new start over of Show Control entry playback. If the entry selection has been changed then the
next playback will load and start the new entry from the beginning as normal.

* Added a new feature to the Show Control playback. During playback in Show Control Mode you may now



use the Shift Right-Click or Shift SpaceBar or Shift-Return to force an automatic fadeout of the current
session entry and an immediate jump to the next entry which will then continue, wait or preload according to
the current entry’s setting. You may also activate this feature by Right-Clicking in the Show Control Light.
The light will flash during the duration of the automatic fade.

* Added a new option to the Show Control Options menu to set the default fade time. This value is saved with
the current Show Control File and is reset each time a new Show Control File is opened.

* Added a new feature and menu item to the MultiTrack menu called Shift MT Center To Quarter Position.
This option will shift all automatic centering operations within the multitrack to the left first quarter position
instead. This offers more editing room to the right of the newly positioned cursor when using the zoom and
other functions that would normally automatically center the cursor position. This option saves with the
preferences.

Video Track Viewer Version 3.6
* Added code to recognize a few newer HD video format FourCC codes.

Bug Fixes
* Fixed code that corrects the FBCenter XYPan adjustment for tracks greater than 1. This previously only

worked correctly on track 1.

* Fixed code to properly update the Show Control listbox on Remotes when a new entry is loaded on the host
and sitting in Wait or Preload mode.

* Fixed Code to properly import the track re-order data from SAC without duplicating return and output data
on SAWStudio Full.

* Fixed Code to further correct stretching automation entries and keeping any entries that are exactly on the
marked end boundary from moving off the end boundary.

* Adjusted code to help window views draw correctly under different conditions when switching between
apps using various methods. This should help keep views from disappearing off the screen and ontop
windows correctly ordered.

* Fixed code in the midi controller 14 bit resolution conversion routines which result in much more accuracy
and smoothness of hi resolution fader controllers like the Behringer BCF and Mackie MCU controllers. All
Hi-Res templates have been adjusted. Make sure to test and adjust any custom templates you may have
created.

* Fixed code that allows modal message dialog boxes to respond correctly to pen and touch commands in
Windows 8.

* Fixed code to stop the MultiTrack Cursor from disappearing in close zooms in Windows 8.

Eq Plugin Version 3.3
* Fixed code that traps max/min crashes when adjusting controls in Win 8 with a pen or touch. Forces you to



be close to the knob when grabbing a control with a pen or touch so the value does not jump far to the
current cursor position.

Echo Plugin Version 3.3
* Fixed code that traps max/min crashes when adjusting controls in Win 8 with a pen or touch. Forces you to

be close to the knob when grabbing a control with a pen or touch so the value does not jump far to the
current cursor position.

>---<

Version 5.1
Enhancements
* A new option has been added to the File Menu called Open SoundFile And Fix Header. This option can be

used to fix a corrupted wav file header that was caused by a crash during a recording which then never had a
chance to finish updating the header data when the recording was finished. This generally results in wav
files with a zero data length value in the header which will not open correctly later. This option will
calculate the data length based on the file length and the header length and write in the corrected values. A
new peak data file will then be created.

* The Zoom Mixer has been fully integrated into the SAWStudioLite version. Add it into your F-Key views
and enjoy the extra power of multiple E-Mixer modules.

Bug Fixes
* Fixed code to adjust the VSTTimeInfo play flag to allow the Melodyne plugin to respond correctly to

BuildMix operations.

* Fixed code to properly read Temp group names from Mix Template Files.

>---<

Version 5.0
Enhancements
* Enhanced the track count to 120 tracks (Full) and 48 tracks (Lite). When loading existing edls, the extra

tracks will be found at the end after the last output track. Reset the track order or move the new tracks into
position at the end of the input tracks if desired, then re-save the session.

* Enhanced the recording capabilities to extend up to 80 (Full) and 40 (Lite) record tracks when using the
SACLink. Each record meter can handle mono or stereo signals from SAC.

* Cleaner display switching between SAC and SAWStudio.

* The Full Mixer labels now display in upper and lower case rather than being forced to all upper case
characters.



* Added a new option to the Options Menu called TCP/IP Slave To Host Disable Warning Messages. This
option blocks any warning message dialogs from being sent from TCP/IP Slaves to the Host when active.
This then allows a single slave machine to have trouble loading a session without stopping the host and
other slaves from continuing on in a Show Control setup while waiting for a message dialog reply. This
option saves with the preferences.

* Added code to allow midi control processing for VST Plugins that support it and are not classified as VST
Synths.

* A new menu keyboard link has been added to the Main Menu to allow a keyboard switch to SAC thru the
SACLink with a press of the Alt-Key and then the L-Key.

* The TCP/IP Options have been gathered under a sub-menu called TCP/IP Options on the Options menu.

* The Wide Mixer View in the Full Version can now be sized and vertically scrolled to fit onto smaller
netbook size screen resolutions.

* When the program is started for the first time or after the default F-key file has been cleared, F-Keys will
now be automatically generated to fit the screen resolution. You can save these as the default F-Keys, or use
them as a starting template to be modified and then saved as your own. I recommend you look at each one
and consider using them as a guide to creating useful ones of your own.

* A new enhancement has been added to the Extract Session feature which will prompt you to automatically
move the extracted session start position to zero on the TimeLine. If you answer Yes, the entire session will
be slipped forward to the zero TimeLine position before it is saved. Use this option if you have no reason to
keep the session start position offset within the master session TimeLine.

Eq Plugin Version 3.2
* Added a new option to the Options menu called Clear Preferences, which clears the preference file and

resets the plugin to its default behavior.

Echo Plugin Version 3.2
* Added a new option to the Options menu called Clear Preferences, which clears the preference file and

resets the plugin to its default behavior.

Bug Fixes
* Fixed code to allow the SACLink to work correctly with SACRemote.

* Fixed code to center the MT cursor position in SAWStudio when switching from SAC.

* Modified code to eliminate Windows memory management issues when repeatedly opening and closing
sessions, such as when using the Show Control View. Memory no longer gets fragmented easily which helps
eliminate memory allocation errors when new sessions open.

* Fixed code to properly sync a slave connection activated while the host is sitting idle in a preload waiting
condition.



* Modified code to handle higher performance Counter Frequencies that are now starting to appear on the
newer i5 and i7 motherboards. All Performance Counter math is now handled completely in 64 bit math
variables. This assures the accuracy of the CPU load percentage readout on these newer faster motherboards.

* Fixed code to properly handle and display the 4 decimal place value for VariSpeed.

* Fixed code to trap for false value jumps on popup fader activation by accident when mouse-click release is
held long enough to release just as the popup fader is beginning to display.

* Fixed code to trap for possible divide by zero errors in the fader display scaling routines.

* Fixed code to trap for the X key softedge function on Return and Output tracks.

* Fixed code to toggle the VSTTimeInfo play flag correctly with the engine status.

* Fixed code to eliminate meter and monitor delay on SF record with any input device higher than device 1.

* Fixed code to softclip and avoid wrap-around on recording when using the input level adjust and pushing the
signal to clipping.

* Fixed code to properly chase Peak Limit meter display in SoundFile View as the cursor is manually swept
through the file.

* Fixed code to jump cursor position to the end of the track after a Library add selections to HotTrack
operation.

* Fixed code to properly display mono L/R input source settings when recalling stored chan data from the
popup Store/Recall menu functions.

* Fixed code to properly jump the HotChan when using the Ctrl-Left-Arrow and Ctr-Right-Arrow commands
in the Full and Zoom Mixers.

* Fixed code to properly update the DirX and VST window views after a shade change.

* Fixed code to lock automation entries on the end boundary when stretching or shrinking an automation
marked area.

* Fixed code to allow Midi Control Templates that include a Master Fader to properly follow re-ordered Out
channels and stay locked to Out Chan 1.

Eq Plugin Version 3.2
* Fixed code to stabilize patching the plugin from SAC remotes and scene changes. Also made changes to

keep the processing thread from being blocked during preset and paramset loads.

* Fixed code to stop host paramset corruption when canceling a load preset operation on a remote.



Echo Plugin Version 3.2
* Fixed code to stabilize patching the plugin from SAC remotes and scene changes. Also made changes to

keep the processing thread from being blocked during preset and paramset loads.

* Fixed code to stop host paramset corruption when canceling a load preset operation on a remote.

Video Track Viewer Version 3.5
* Fixed code to save the Keep Original Video Aspect On Extended Monitor option with the video preferences.

>---<

Version 4.9a
Enhancements
* Enhanced code to better resolve network file paths to avoid missing file error messages on SAWStudio

remotes when first connecting or opening files.

* Enhanced code to allow drive substitution on slaves when opening files from host. If the slave does not have
a matching drive as the host, the drive letter will be substituted from the default session path in the path
setup dialog.

* Enhanced the MultiTrack Slide Entry Data function (Shift-Right-Drag) to respond to number-selected tracks
for multiple track editing operation. You can cancel the group editing temporarily for this function by using
the Alt-Key along with the Shift-Right-Drag to perform the operation.

* The current Shade name in use, if any, is now displayed in the Shades/Open menu option.

Eq Plugin Version 3.1
* Enhanced code pertaining to SAC.

Echo Plugin Version 3.1
* Enhanced code pertaining to SAC.

Bug Fixes
* Fixed code when using the Fx Bypass switch with multiple channels selected to only update the switch

bypass condition on channels with patched plugins.

* Changed code to help with activating another application on the first click when switching from
SAWStudio.

* Fixed code to extract region name, instead of filename, as the base name for new regions created by Alt-Left-
Clicking a marked MT Entry and dropping a new entry on the MT.

* Fixed code in the message dialog windows which could have chopped titlebar message text short under



certain conditions.

Echo Plugin Version 3.1
* Fixed code to properly dissolve FeedBack delays as they near -infinity db.

>---<

Version 4.9
Enhancements
* Enhanced the SACLink protocol to pass necessary information between SAC and SAWStudio to allow for

record loopback latency compensation and an overall more accurate record sync alignment during overdub
recording using the SACLink.

* Added a new TCP/IP mode called Activate TCP/IP Video Slave Mode to the Options Menu. This option
allows you to use a slave machine specifically as a video slave only, meaning no audio is being played from
its engine. The video viewer playback sync is locked to the host machine network position, not the local
soundcard playback position. Therefore this machine does not require any special word clock or other clock
sync connection to keep host and slave accurately synced for the video playback. Normally a slave machine
plays its own soundcard outputs and handles its own internal positioning, depending on some sort of
hardware clock sync between the host and slave soundcards to keep from drifting.

* Added TCP/IP control of the AutoRewind Switch for Remotes.

* Added a new option to the Host Mode TCP/IP functions that allows you to now see a list of all Remote and
Slave computers currently connected. Left-Clicking in the main titlebar Host/Master zone when you have
active connections will display a list of each computer connection and the computer names.

Video Track Viewer Version 3.4
* Added two new options on the popup Options Menu called Render RealTime To Extended Monitor and

Keep Original Video Aspect On Extended Monitor. These options emulate the Hardware Overlay Render
features on video cards that do not support the second monitor full-screen video playback options. These
options will output a full-screen display on a secondary extended monitor. The display is scaled using hi-
speed software manipulation to replace the missing overlay output capabilities. This now allows you to
create very inexpensive video slave machines using small NetBook computers or laptops, as long as they
have a dual monitor video output, which most currently do. You can then run them as TCP/IP remotes or
video slaves for perfect video sync, feeding video projectors in shows using separate video streams.

Bug Fixes
* The SAC Link Import Mix Data From SAC option now correctly ignores the Input Att, Swap LR, Phase Rvs

and Mono Switch.

* Modified code to trap for TCP/IP packet splitting of long command string data that could cause corruption
in the command execution under certain conditions.

* Modified code for loading VST Presets and forcing a screen update of the new settings for certain plugins



that would not update properly on their own.

* Modified code to force a MT Cursor redraw when switching back from other applications.

Eq Plugin Version 2.8
* Fixed code to properly initialize all parameters when loading presets while the engine is live.

* Code modified to stabilize sending and receiving parameter set data for preset saves and loads while the
processing engine is live.

Echo Plugin Version 2.9
* Fixed code to properly initialize all parameters when loading presets while the engine is live.

* Code modified to stabilize sending and receiving parameter set data for preset saves and loads while the
processing engine is live.

>---<

Version 4.8
Enhancements

Bug Fixes
* Fixed TCP/IP Slave Mode communications which were broken in 4.6 and 4.7.

* Fixed code to trap Output Chan Solo switches from writing as automation entries under certain conditions.

Eq Plugin Version 2.7
* When SAWStudio was in Realtime Priority mode, certain system configurations could cause the left-click

up/dn parameter adjustment feature to fail. This code fixes that issue.

Echo Plugin Version 2.8
* When SAWStudio was in Realtime Priority mode, certain system configurations could cause the left-click

up/dn parameter adjustment feature to fail. This code fixes that issue.

>---<

Version 4.7
Enhancements
* Enhanced the Aux Send processing to allow for a Pst Fader – Pre Pan send scenario by disengaging the Aux

Send Pst FX switch.

* Enhanced and renamed the SACLink Import Mix Data from SAC option to now read as Import Mix Data
From SAC Input Chans (Active/Selected). This function includes only active (input source assigned and not



disabled) input chans and properly handles re-ordered SAC chans when creating the new Record Template.
If SAC chans are selected, then only those chans are included in the import. Another new SACLink option
called Arm Last Imported Record Template assures that the record arming begins on the proper imported
start track so that all record input assignments will correctly follow the imported SAC channels. You can
also engage the record template on the proper track by Alt-Clicking on any track Rec switch.

Bug Fixes
* Fixed code to correct problems with the SACLink Recall Scene By Name function that would cause certain

scenes not to recall based on naming length conditions and other recall order factors. Also fixed code to stop
a crash that could occur when the SACLink was not active and a Recall Scene By Name entry would be
exercised..

* More work done on saving VST settings and presets. This new code should fix compatibility issues with
Voxengo plugins and UAD plugins (and others) that were having trouble saving presets and session settings.

* More Work done on VST Multi-In/Out plugins like some of the newer Voxengo plugs to stop the possibility
of a hard crash once playback is initiated.

* More work done on retaining the last active window when switching between apps using the SACLink or
minimize functions.

* Fixed code to stop SRP playback across a marked area from muting armed record track data when Record is
not actively engaged.

>---<

Version 4.6
Enhancements
* Included the new 32 chan Behringer BCF2000 midi controller template. See details in the helpfile for setting

up multiple BCF2000 units.

* Enhanced the Copy Track (Or Marked Area) to Layer feature to allow copying to all layers at the same time
by holding the Shift-Key when activating the command. This will also apply to multiple track options of the
same function.

* Enhanced the Copy All (Or Marked)Automation to Layer feature to allow copying to all layers at the same
time by holding the Shift-Key when activating the command. This will also apply to multiple track options
of the same function.

* Modified the SRP auto-punch function. When SRP is engaged with a marked area on the MT, an auto-punch
operation is ready to engage at the marked area. The auto-punch will not activate unless the REC button has
also been pressed sometime before the auto-punch area. When the REC button has been armed, it will flash
until the actual auto-punch area is reached, at which point it will engage record and display solid red. This
helps eliminate accidental record operations when using SRP to playback after an auto-punch. If the REC is
armed, you will see the REC light flashing, giving you ample warning that you are about to overwrite the



punch area with a new recording. The Shift-SRP can also be used to engage SRP and arm the REC at the
same time. The auto SRP/REC latch option can also be used. You can also override the flashing REC button
by pressing the REC again before reaching the auto-punch area and recording will start immediately.

* Added a warning prompt if you attempt to clear the marked area while Offset Mode is active. This can help
prevent offset changes from being applied to the entire track by accident. Also added the creation of an undo
file when exiting Offset Mode and applying changes.

* Enhanced the TCP/IP options to save with the preferences so you can automatically boot into one of the
Host, Remote or Slave modes.

* Added support for using Show Control View and show playback on Remote computers.

* Right-Clicking on the Show Control View Blue Pyramid Options icon will now allow the window to float
over top of other programs.

* Show Control Mode now has a new Continue enhancement… you may now select Wait to load the next
session and wait, not starting playback and not preloading and placing a prompt on screen. Playback may
then be started at any time with any playback command when ready.

* Show Control Mode now also allows for Global Midi Play and Stop notes to control the Show Control
playback. These save with the Show Control File and allow a single note-on to control global play and
another to control global stop within the entire Show Control list of individual session files.

* Show Control Mode now also allows for Global Midi Prev and Next notes to control the Show Control
selection listbox. These save with the Show Control File and allow a single note-on to move to the previous
or next Show Control listbox entry within the entire Show Control list of individual session files.

* Enhanced the TCP/IP Remote capabilities to now allow connecting during live playback… the remote will
be synchronized into the playback loop, including the detection of Show Control Mode.

* TCP/IP Remote computers will now display a popup notice when the Host is waiting to answer a message
dialog. The wait can be overridden by pressing Shift-Esc on the remote computer.

* TCP/IP Host computers will now display a popup notice when a Remote is waiting to answer a message
dialog. The wait can be overridden by pressing Shift-Esc on the host computer.

* The MT and SF play cursor freeze action has been extended down 2 more zoom levels from 256 to 64.

* The Control Track Built-In Commands have been enhanced to now include two new SACLink functions;
SACLink Recall Cur Scene and SACLink Recall Scene By Name. The first command recalls the currently
selected SAC Scene View entry. The second command jumps the SAC Scene View listbox to the named
scene and then recalls it.

* Added modifications to allow compatibility with new Waves 6 VST plugins. The plugins need to first be
extracted from the Wave Shell using the Shell2VST utility.



* Enhanced the SRC resolution in the Lowest Quality setting to retain better accuracy of the samplerate during
a conversion.

* BuildMix will now automatically ignore live device inputs. VST synths will still be included in the build.

* The Export Region function now defaults to the current Session folder. It will retain any path change you
make until you open a new session at which point it will now reset and default to that session folder.

Video Track Viewer Version 3.3
* Enhanced the Video Viewer to allow it to be moved to a secondary monitor. Be aware that some DirectDraw

driver implementations may not function correctly on monitors other than the Primary monitor. If you loose
the video viewer from the Primary monitor due to screen resolution changes, you can force the viewer to the
current monitor resolution by opening the viewer from SAWStudio while pressing the Shift-Key.

Echo Plugin Ver 2.7
* Modifications made to properly update settings display on an open plugin altered by a SAC Scene change

using the SACLink option.

Graphic Eq Plugin Ver 2.6
* Modifications made to properly update settings display on an open plugin altered by a SAC Scene change

using the SACLink option. Also now allows the Options menu to open while the engine is live.

Bug Fixes
* Code modified to display Chan labels in the Wide Mixer popup Dynamics Key menu in the same manner as

the Zoom and Exploded Mixer views.

* Fixed code to display the Export Region progress bar window without cutting off the word “Cancel”.

* Fixed code to retain whether the Ctrl key was pressed when clicking on a track record switch to open a
record template and the save session dialog pops up asking for a session name. Once the name is entered and
the dialog is closed, the entire record template will now correctly open.

* Fixed code to trap for duplicate record filenames for track labels that are the same and when rate, res, or
filetype is changed midstream.

* Fixed code to properly shutdown Soundfile playback with SAC-Link at end of file and end of marked
regions in SF view.

* Fixed code to initialize the timeline mode when opening a saved preference file.

* Fixed code to stop MT Cursor from jumping back to starting play position if playback is stopped when
zoomed in past the cursor freeze zoom ratio.

* Fixed code to break the MT-SF cursor link when jumping to a Control Track marker position after
transferring data from the MT to the SF view.



* Fixed code to properly repaint mixer top client mixer label zones whenever labels are cleared or entered,
including maintaining selected channel status.

* Fixed code to trap for SoundFile Playback crash on a TCP/IP computer remote. SF playback on a remote
computer is not currently possible.

* Fixed code to ignore Label Selected tracks when using the Remove Silence function. This eliminates a
possible crash that could otherwise occur.

* Fixed the Frontier AlphaTrack Midi Controller Template to stop fader chattering when playing thru fader
automation and the readout display was not set to Fader.

* Fixed the SampleRate Conversion algorithms to output more accurate final filesizes based on the rate
conversion predicted size.

* Fixed code to allow midi controllers to properly follow track re-ordering for Rec Meter engaging and
Section jumps.

* Fixed code to correct for Show Control Mode stopping at the end of each session when SACLink is active.

* Fixed code to correct for possible display corruption when the engine is active on multiple cpu systems and
under moderate to heavy load.

* Fixed code to correct loading of the various Recent File List data when any one of the .ini files does not
exist.

* Fixed code to maintain the hide/show windows as the active window when returning back into SAWStudio.

* Fixed code to automatically skip save session prompts during Show Control playback which would normally
popup if any mixer controls had been altered since the current session had been loaded.

* Fixed a misspelling in a File View file relocation message box.

>---<

Version 4.5
Enhancements
* The DirectX and VST plugin windows now allow you to load and save presets while playback is active.

* The Backspace-Key Record Retake functions can now be used during Rec/Rdy mode.

* Snapping marked Control Track Entries to the current MT cursor position has been enhanced to allow you to
snap the end offset to the current MT position by using the Shift-Backspace-Key variation.



* Enhanced the Record Loopback Latency Adjustment to now accept a max value of 999,999 samples…. This
option counteracts record latency due to hardware in the loop by adjusting the record data within the region,
effectively sliding the recorded data earlier in the timeline.

* Activated all of the Shift, Ctrl, or Alt key MT region manipulation functions on the first click, even when
changing hottracks.

* SAC-Link playback is now available from the SoundFile View and will show up in SAC as the SS-Out
Chan corresponding to the SoundFile View Out Device setting.

* The SAC-Link setting can now be saved with the preferences so it can automatically activate when starting
SAWStudio if SAC is already running.

* The View Filter (V-Key) and View Filter popup Menu (Right-Click on Aut Switch) can now both be
operated during playback, or any other live engine mode.

* The File View window re-path options now display all files in destination browse folders.

* Enhanced network data handling for more remote and slave efficiency across wireless networks… including
Wireless-B, G and N.

* TCP/IP Slave Mode can now be initiated while the host is currently playing back and the slave will load the
proper session, jump to a delayed sync trigger position, using the MTC Trigger Advance setting, and
actively sync live into the current playback operation.

* The Ctrl-S Save Session keyboard shortcut can now be used to save a session during MultiTrack Play,
PlayMark, and PlayLoop modes, as well as Live and Rec/Rdy modes.

* The SnapShot Session (* Key) function can now be used during Rec/Rdy mode to manually force the
creation of an Undo File.

* Track selection in the MultiTrack using the drag method on the track numbers, now works during playback.

* Enhanced Auto-Rewind switch operation. If you engage the Auto-Rewind switch during playback while
pressing the Shift-Key, the original rewind position is reset to the current playback cursor position.

* Added a Recent Show Control File List option to the Show Control View.

* Enhanced the marked area special automation feature which writes the new automation at the mark begin
position and returns the automation to its origin value at the mark end position. This feature will now
automatically set the slope to zero if either entry falls on an exact MTEntry boundary.

* Writing any automation entry that falls on an MTEntry end boundary will now automatically set the slope to
zero.



Echo Plugin Ver 2.6
* Enhanced the Delay ms popup menu to display a reference distance in Feet or Meters (selected in the

Pyramid Logo Options menu) based on the speed of sound through dry air at 68 degrees F (20 degrees C).

* A new Tap Mode feature is available by clicking on one or both of the Tap Lights (Pressing the Ctrl-Key
while clicking on either will activate both channels). When this mode is activated, you can click the Left
Mouse button in the Tap zone between the Tap lights twice in succession, or tap the Left, Right, Up or
Down Arrow keys twice in succession or the SpaceBar twice in succession or any combination of those keys
once each for quicker response times and the delay time will be calculated between taps. You can leave this
mode active and tap a new delay at any time. If the time between taps is longer than the max delay time for
your specific samplerate, then the taps will be ignored.

* Enhanced the DelayTime, FeedBack and Strength controls to stereo latch when using the Ctrl-Key and any
of the control adjustment methods.

* The Pyramid Logo Options menu may now be used while the engine is active.

Video Track Viewer 3.2
* Enhanced code to eliminate network traffic load when using remote mode containing video files and the

video viewer is closed. If no external firewire or overlay render options are active and the viewer is closed,
the remote machine will not attempt video file seeks across the network, thereby dropping the network load
tremendously.

* There is also a new option in the Special Options menu called TCP/IP Remote Mode – Ignore Video. This
option can be activated to completely ignore video file requests on a remote machine whenever the host
machine opens sessions that contain video files. This is another way to save video network loading from a
remote machine and this option can be saved with the Video Preferences.

Bug Fixes
* Code modified to improve SAWStudio SAC-Link playback and eliminate possible audio glitches when the

system is under heavy load.

* Fixed code to trap F-Keys when program is minimized.

* Fixed code to allow windows to activate on first mouse click when switching between hide/show floating
app windows.

* Fixed code to keep the Control Track listbox in the same scroll position and re-select the same entry when
done editing that entry.

* Fixed code to trap for using the Shift-Right-Drag mouse command to slip region data on a blank track area.

* The File View window will now correctly open on top of the Video Viewer and other OnTop windows.

* Fixed code to trap for illegal softedge problems when adjusting regions that incorrectly extend past the
soundfile length.



* Fixed code to properly display channel recalls when Automation Mode is active.

* Fixed code in the FX Eq and Echo plugins to trap mouse-click control adjustments from crashing looped
playback under certain conditions.

* Fixed code to properly update the FX SampleRate shared variable every time the MT Rate is changed.

* Fixed code to correct for meter timing in SAWStudio when using the SAC-Link for playback.

* Fixed code to properly handle un-assigned wave devices used in the session when the SAC-Link is active
for both playback and buildmix operations.

* Fixed code to properly redraw the Multitrack display during live playback Sac-Link or minimize/restore
switching.

* Fixed code that could cause Automation Gallery inserts to jump down the timeline from the cursor position
when certain VST plugins are patched anywhere in the MultiTrack.

* Fixed code to correctly display the Wide Mixer view with default mix templates that start with a Return or
Output track as the first track.

* Fixed code that would lock up remote and slave network data when the About Window was open.

* Fixed code to stop a slave machine lockup that could occur when the slave is missing it’s own copy of the
host file trying to be played.

* Fixed code to properly chase the Control Track View entries on a remote machine.

* Fixed code in the Extract Session routine to properly restore the current edl if the process encounters an
error and to also parse track labels for illegal filename characters as those track labels get used in the
extracted soundfile names.

* Fixed code in the Export Tracks routine to parse track labels for illegal filename characters as those track
labels get used in the exported soundfile names.

>---<

Version 4.4
Enhancements
* Moved the [SAC-Link] menu option to the front of the main menu for more consistent placement between

SAWStudio and SAC.

Bug Fixes
* Code modified to fix possible crash issues with ASIO drivers and more than 48 channels of soundcard



devices when opening the Sync Devices Setup window.

* Assigning a record meter input source to SAC channels with the SACLink active will now assign the correct
SAC channel, even if SAWStudio tracks have been re-ordered.

>---<

Version 4.3
Enhancements
* A new Main Menu option next to the Info Menu called [SAC -Link] is now available to switch to SAC when

the SAWStudio-SAC Link is active.

* Added a new Midi Control Template for the Behringer BCF2000 unit. There is a sysex preset dump
included in the SAC Configuration folder that must be sent down to the BCF2000 unit first and assigned to a
preset. You can dump this file with any midi sysex dump utility program like Midi-Ox, or something
similar.

The BCF2000 template gives you control of the 8 faders, in high resolution mode, as well as mutes, solos
and pans. The top 2 buttons in the bottom right corner of the unit can be used to bank switch up or down,
and the bottom 2 buttons of that group can be used to jump forward to the next console section (I, R, O).

Bug Fixes
* Code modified to fix issues when importing SAC data into SAWStudio Lite using the SACLink feature.

This fix makes adjustments for the lesser channel count in Lite and corrects mis-aligned Input, Return and
Output data.

Video Track Viewer 3.1
* Fixed code to trap for miscalculated Dropped Frames during Timeline playback that could report negative

numbers under certain conditions and result in the display of a ridiculously large positive value.

* Modified code to keep overlay output from tearing on certain video cards. This modification also
overrides other video apps that use overlay flipping chains from locking out SAWStudio’s use of the
overlay.

* Modified code to help hold sync when using small buffer sizes of 128 and under.

>---<

Version 4.2
Enhancements
* Added the hooks to SAC. The SAC Link option is activated from within the SAWStudio app and once a

connection link between SAWStudio and SAC has been established, you can now pass data in both
directions for recording and playback with SAWStudio using internal shared memory buffers that
completely bypass the Windows soundcard drivers. SAWStudio will automatically disconnect from the



drivers and use the internal shared buffers to communicate with the outside world through the SAC engine.

The menu options are selected from within SAWStudio and show up as follows:

The Activate SAC Link option on the SAWStudio Options menu will establish the internal connection
between the two programs. SAC and SAWStudio must both be running at the time, and when the connection
is established, a SAC<–>LINK icon will appear in the left corner of the SAWStudio main titlebar.

The SAC Link Options option expands out to include these following choices:

The Export Mix Data To SAC option allows you to instantly transfer the main MT track and channel mix
data directly to the SAC FOH console. This will also automatically preset each SAC console channel input
source to point to the associated SAWStudio MT track. This option allows you to playback the SAWStudio
MT tracks in a 1 to 1 configuration through the SAC console. You can then use the SAC Monitor mixers to
setup separate performer mixes. SAWStudio will not play audio through its own driver devices while the
SAC Link is active. You do not have to make any preference changes in SAWStudio… the buffer settings
will be internally set to relax the SAWStudio cpu load and rely on SAC to handle the low latency
performance. The internal link will adjust for SAWStudio playback buffer size changing and latency causing
plugins and deliver a fixed data stream to SAC with no changes needed to your edl session in SAWStudio.

The Import Mix Data From SAC option allows you to instantly transfer the SAC FOH console setup directly
into SAWStudio, including automatically creating a record template with all channel input assignments
preset, ready for a live recording of the current SAC session. All that is needed after this option is activated
is to Ctrl-Click the first track’s record button in the SAWStudio MT to open all record meters for all active
SAC channels, already pre-assigned. Once again, SAWStudio completely bypasses the soundcard drivers
and gathers its audio data directly from the SAC engine. This allows SAWStudio to perform the MT record
operation with very little added cpu load on the system, and also relaxes the buffer settings to essentially
coast along quietly in the background while SAC handles the low latency monitoring load.

The Input Chan Play Tap At SRC option selects the SAWStudio tap for sending its track data to SAC. This
option sends the data from the SRC position at the top of the chan module just after the Mono section. Using
this option means you are essentially sending the playback data directly from the wav files on each track
with no added processing from the SAWStudio virtual console.

The Input Chan Play Tap At PRE-PATCH option selects the SAWStudio tap for sending its track data to
SAC. This option sends the data from just after the PRE-PATCH position within the chan module. This
option would allow VST Synths data to be passed onto SAC and the Pre-Patch position routing options
within SAWStudio will still apply, so some signal processing from SAWStudio may be part of the signal
chain before the data reaches SAC.

The Input Chan Play Tap At PST-FDR option selects the SAWStudio tap for sending its track data to SAC.
This option sends the data from the bottom of the chan module, which includes all chan processing and
automation. Very useful for show playback of pre-recorded tracks.

Once the SAC Link is initiated, the SAC input source options will expand to allow individual SAWStudio
Mixer Chan selections instead of just the hardware device selections. You will see all SAWStudio label
references for each channel in the list. You may select any Input Chan from SAWStudio or any Output



Chan. Selecting an Output Chan allows you to maintain a complete mix in the SAWStudio environment and
only use one stereo input chan in SAC to playback the entire 72 tracks from SAWStudio. Any Input Chan
selection is subject to the above mentioned Tap points set in SAWStudio.

Likewise in SAWStudio, the record meter Input Zone will display the SAC channel list with the SAC labels.
You may record from any SAC channel which will automatically adjust the record meter to mono or stereo
based on the SAC source assignment. An added bonus here is that you now have the ability to record extra
channels in your current SAWStudio version than is possible with SAWStudio alone. For instance…
SAWStudio Lite allows up to 24 record meters which are normally connected to the 12 possible stereo
hardware devices. Normally that translates to 12 stereo tracks or 24 mono tracks or any combination in
between. But with SAC’s ability to handle 36 stereo devices, you would now have the ability to pass on up
to 72 signals in any combination of mono/stereo to the 24 record meters. Therefore, you can now record up
to 24 stereo tracks (48 channels worth of data) in Lite as long as you have that many channels of hardware
devices connected to SAC.

* The H/S Hide/Show option has been activated on the Record Remote Transport. Left-Clicking in this zone
will hide (minimize) SAWStudio and leave the transport visible on top of whatever is underneath. This can
be used to control SAWStudio’s recording functions from inside SAC for instance. Clicking the zone again
will restore SAWStudio to the screen.

* The Hide/Show option has also been added to the Control Track view. Right-Clicking in the Control Track
Pyramid Options zone will hide (minimize) SAWStudio and leave the Control Track view visible on top of
whatever is underneath. This can be used to control SAWStudio’s playback functions from inside SAC for
instance. Right–Clicking the zone again will restore SAWStudio to the screen.

* Record Retake will now function while RecRdy mode is active.

Bug Fixes
* Fixed the illegal softedge correction routine to trap for region entries with bad file links. This solves the

mysterious appearance of giant softedges that keep coming back even after they have been removed.

* Fixed the ASIO menu text display to properly display the 16 bit integer format.

* Fixed code to handle right-click options in the MultiTrack Label area even if the mouse button is held down
for a time instead of released in a normal quick click operation.

>---<

Version 4.1
Enhancements
* The Solo Bus Device option has been enhanced to automatically internally assign and keep properly updated

even if no active track assignment is setup, whenever one of the Solo Bus options has been activated. It will
properly output whatever data is assigned to it or blank buffers if no data is assigned to it and swap to the
solo data when a solo is activated. You will no longer be flagged with an assignment error message if no



active track assignment has been setup.

* Enhanced the Record Mode keyboard shortcut Ctrl-Spacebar to force a stop condition from any REC, SRP,
or REC/RDY mode, thereby stopping the engine immediately.

* Enhanced the Midi Controller API functions to handle the Frontier AlphaTrack special functions. The
AlphaTrack Midi Template is included in this update.

The LCD display is used to show parameter and channel labels in the various selection modes.

Make sure your controller is set to Native Mode (TaskBar Icon) to ensure compatibility with this template.

Using the Shift Mode does not require you to hold down the Shift Button. Just press it once and it will
engage and light up to show that Shift Mode is active. You can cancel Shift Mode by pressing the button
again. Most commands that use Shift Mode will automatically disengage it after the command is executed.

Fader: Control mixer channel faders. Can operate Input, Return, and Output channels based on track /
channel select switches. If the Mixer Views to Hardware Controller navigation link is active, the surface
will chase SAWStudio's Hot Track selection. Touching and adjusting the fader will automatically switch the
LCD to Fader Mode and display the fader data.

Shift Button: Toggles Shift Mode on / off. Using the Shift Mode does not require you to hold down the
Shift Button. Just press it once and it will engage and light up to show that Shift Mode is active. You can
cancel Shift Mode by pressing the button again. Most commands that use Shift Mode will automatically
disengage it aftter the command is executed

Rec Button: Toggles the record meter open/close for the current track.
Shift Mode: Operates the record meters as a record template, allowing multiple channels to be armed or
disarmed at once.

Solo Button: Toggles Solo on and off for the current channel.
Shift Mode: Toggles all active solos off.

Mute Button: Toggles Mute on and off for the current channel.

Left or Right Parameter Knob: Either of these knobs act as a function selector, scanning through different
control types. Use the left or right knob, depending on whether you are left or right handed so you do not
cover up the display as you turn the knob.

The current selectable control types are: Layer; Fader; Pan; Aux 1 In; Aux 1 Pst Fdr; Aux 1 Lvl; Aux 1 Pan;
Aux 2 In; Aux 2 Pst Fdr; Aux 2 Lvl; Aux 2 Pan; Aux 3 In; Aux 3 Pst Fdr; Aux 3 Lvl; Aux 3 Pan; Aux 4 In;
Aux 4 Pst Fdr; Aux 4 Lvl; Aux 4 Pan; Aux 5 In; Aux 5 Pst Fdr; Aux 5 Lvl; Aux 5 Pan; Aux 6 In; Aux 6 Pst
Fdr; Aux 6 Lvl; Aux 6 Pan; Comp In; Comp Gn; Comp Thr; Comp Ratio; Comp Rel; Comp Att; Gate In;
Gate Rvs; Gate Thr; Gate Flr; Gate Rel; Gate Att; Dyn Key Listen; Dyn Eq Lo; Dyn Eq Hi; Dyn Key; Eq In;
Eq LoCut In; Eq LoCut Frq; Eq HiCut In; Eq HiCut Frq; Eq Gn 1; Eq Frq 1; Eq Q 1; Eq Gn 2; Eq Frq 2; Eq
Q 2; Eq Gn 3; Eq Frq 3; Eq Q 3; Eq Gn 4; Eq Frq 4; Eq Q 4; Eq Gn 5; Eq Frq 5; Eq Q 5; Mono; Swap LR;
Phase Rvs; Attenuator; MultiTrack Position



The LCD dislays the currently selected type and value.

Center Parameter Knob: This knob adjusts the value for the currently selected control type. If the current
type is the MultiTrack Position display, this knob has no effect and the position is adjusted by the various
transport controls and touch strip.

Pressing the knob as a switch sets the control to the default value.
Shift Mode: For Aux_Lvl control types sets the control to -inf.

Pan Button: Switches the Control Type to Pan for the current channel. The Pan LED lights when in Pan
Mode.

Send Button: Switches the Control Type to Aux_Lvl_1 for the current channel. Repeated pressings switch
to Aux_Lvl_2, Aux_Lvl_3, Aux_Lvl_4, Aux_Lvl_5, Aux_Lvl_6, and then back around to the beginning.
The Send LED lights when in Aux Mode.

EQ Button: Switches the Control Type to Eq_In for the current channel. Repeated pressings switch to
Eq_Lo_In, Eq_Hi_In, Eq_Gain_1, Eq_Gain_2, Eq_Gain_3, Eq_Gain_4, Eq_Gain_5, and then back
around to the beginning. The EQ LED Lights when in Eq Mode.

Plug In Button: Activates and opens (if needed) the FX_Pre and FX_Pst views. If the current Hot Track is
an Output track, it also activates the Final Res patch view.
Shift Mode: Closes all FX patch views.

F1 Button: Jumps to Locate Point 1.
Shift Mode: Sets Locate Point 1.

F2 Button: Jumps to Locate Point 2.
Shift Mode: Sets Locate Point 2.

F3 Button: Jumps to Locate Point 3.
Shift Mode: Sets Locate Point 3.

F4 Button: Jumps to Locate Point 4.
Shift Mode: Sets Locate Point 4.

Track < Button: Decrements the Track / Channel.
Shift Mode: Marks the begin position. When any marked area is active, the LCD displays a small mark in
the top right corner.
Ctrl Mode: Set by pushing the left or right parameter knob. Lights both track button LEDs and jumps down
one section from Output to Return to Input channels.

Track > Button: Increments the Track / Channel.
Shift Mode: Marks the end position. When any marked area is active, the LCD displays a small mark in the
top right corner.



Ctrl Mode: Set by pushing the left or right parameter knob. Lights both track button LEDs and jumps up
one section from Input to Return to Output channels.

Loop Button: Toggles AutoRewind on and off. When active, regular MT playback will jump back to the
starting point when playback is stopped. If there is an active marked area, MultiTrack playback will continue
to loop the marked area.
Record Mode: Toggles AutoRecord Loop Mode on and off. SRP recordings will continue to create new
takes of the marked area, looping back to the cursor position pre-roll starting point.
Record-Shift Mode: Toggles AutoRecord Layer Loop Mode on and off, which fills layers with new takes
on the Lite and Full SAWStudio versions.

Flip Button: Switches the Control Type to MultiTrack Position. The LCD now displays Timeline position
information in the current Timeline display mode. Pressing the button again switches the Control Type back
to the previous type selection.

Transport Rewind Button: Moves the current cursor position back 10 seconds on the timeline. This
function will auto-locate the playback if active.
Shift Mode: Jumps to the session home position.

Transport Fast Forward Button: Moves the current cursor position forward 10 seconds on the timeline.
This function will auto-locate the playback if active.
Shift Mode: Jumps to the session end position.

Transport Stop Button: Stops playback, record and live input operations.
Shift Mode: Saves and updates the session edl.
Msg / Dialog Mode: When a message dialog box is active, acts as a cancel or "no" response. The LCD will
display many important messages directly.

Transport Play Button: Starts MultiTrack play or SRP play operations.
Shift Mode: Activates Live Mode.
Msg / Dialog Mode: Acts an Okay, Yes, or Enter response.

Transport Record Button: Starts a multitrack record operation or punches in during SRP play mode.
Shift Mode: Starts a RecRdy operation.

Touch Strip: Acts as a position shuttle which adjusts the MultiTrack cursor position. When first touched,
the Flip button is activated and the LCD will display the cursor position.

FootSwitch Jack: Toggles Playback on and off.
Record Mode: Toggles Punch-In and Punch-Out during an SRP operation. Does a Punch-In on a straight
Record operation.

* Modified the Trigger Sync record behavior to always trigger an SRP operation, allowing for a manual
punch-in operation, or an auto-punch-in operation based on a marked area, or an instant auto-punch-in based
on the auto SRP/REC option setting.

* Modified the record behavior when stopped to snap the cursor position back to the newly recorded region



end position. This will happen only when record mode is active at the time of the stop command. If you have
punched out during an SRP record operation prior to executing the stop command, the cursor will stay at the
current stop position. If using the Midi WorkShop add-on, this feature requires version 1.7 or higher to
function correctly.

* Sample Edit Mode in the SoundFile View has been modified to switch samples at the mid-point between
samples instead of the start of each sample. This makes Sample Edit control much easier when modifying
sample values.

* Replaced repeating audio device missing and changed warnings with a single warning message if current
devices no longer match your preferences.

* A new option has been added to the Mixer Menu called Mixer Chan Record-Tap Routed Before Eq / Dyn.
This option allows you to force the Mixer Chan Record tapoff point in front of the Eq/Dyn section without
re-routing the Pre-Patch point. The normal default behavior when recording from a Mixer Chan source is to
tap the record signal after the Pre-Fx-Patch point, which is normally after the Eq/Dyn section. You can re-
route the Pre-Fx-Patch point before the Eq/Dyn section and the record tap will follow along, however, so
will the Pre-Aux Send point. When using the virtual console as a PA mixer, this would force all Pre-Aux
monitor sends to remain flat without the benefit of any Eq or Dynamics. Many times this is not the desired
method of sending monitor mixes to stage performers, so this new option allows you to break the link
between the record tap point and the Pre-Fx-Patch point, allowing you to record flat signals while still
processing front of house and monitor mix signals.

This setting saves with the Mixer Templates and also with each session edl file. This setting clears when
sessions are closed. If you use a default Mixer Template, you can arrange the default console signal routing
any way you like and those settings will be used each time the console is reset.

* The record meter displays will now actively chase MultiTrack tracks and keep the hottrack meter (if active)
visible within the Record Meter window. If mixer navigation links to the MT are active, the record meter
displays will also chase mixer hotchan changes. Right-Clicking the Record Meter window Close zone will
toggle a lock option to freeze the meter displays from chasing. You are still free to scroll the meters within
the window with the wheel mouse or arrow keys.

* A new option has been added to the Options Menu called TCP/IP Host-Remote Receive HotTrack Link. This
option toggles the reception of the hottrack link between the Host and Remote machines. If the option is
active on the host, the host chases any hottrack changing happening on the remote machines. If the option is
active on a remote, the remote chases any hottrack changing happening on the host machine. This can be
useful for a visual reference of changes being made from the connected machines. If you are using the
console as a PA mixer and are controlling from the host and remote machines at the same time, you may
find it nice to leave this option off so that the individual machines are not jumping around from actions
taken on the connected machines.

* The manual adjustment resolution of Vari-Speed has been increased to .0001%.

* The Default EDL Undo Path option in the File Path Setup in the Options Menu has been enhanced. You
may now enter a sub-folder of the EDL project folder by starting the folder name with a backslash character.
For example, entering \Undo will force all undo files for each session to be saved in a sub-folder named



Undo under the session folder. This helps keep the session folder better organized and easier to maintain. If
you decide to use this feature, you must manually create the same folder under existing session folders and
copy all existing undo files for current sessions into this folder in order for them to be automatically
available. New sessions will automatically create this folder when the first undo file is created.

* A new item has been added to the File / Mix Template menu called Open Without Labels. This option opens
a mix template without disturbing labels in the current session.

* Added code to trap and adjust for invalid softedge entries as entry boundaries are altered, moved and copied,
and as new entries are inserted. Invalid softedges will now be corrected on the fly as editing operations
create them.

* Enhanced MT Entry deletion to now include automation enclosed by entry softedges.

* The Copy Automation To Layer function has been enhanced to respond to selected MT Tracks and also to
copy all track automation if there is no marked area. You may also use the Ctrl-Key when activating the
function to do all tracks without having to select them.

Video Track Viewer 3.0
* Added compatibility for some HD mp4 formats, and extended compatibility for more mpeg and quicktime

formats. Many DVD .vob files can now also be opened and converted directly inside the viewer, depending
on the actual compression format used to create them. Some HD formats may require the installation of the
ffdshow codecs available on the web.

* Two new menu options have been added to the Zoom Options menu to help display HD files; 1/2 Actual Size
and 1/4 Actual Size.

* Two new menu options have been added to the Overlay Render Size Options menu to help display HD files;
1/2 Actual Size and 1/4 Actual Size.

Studio Fx Eq 2.4
* Changes added to correct possible display corruption on dual processors.

Studio Fx Echo 2.4
* Changes added to correct possible display corruption on dual processors.

Bug Fixes
* Fixed Priority Class overrides to work properly when loading new preference files from the File menu.

* Fixed the Sweep To Vari-Speed and Vari-Pitch Destination option to trap for very small destination changes
and also added a much higher degree of accuracy across the marked area.

* Fixed the Slip Track command for All Layers to properly handle Control Track entry positions.

* Fixed Undo History Window positioning to trap for F-Key views that could cause the window to be
positioned off-screen when first opened.



* Adjusted FX Buff Chng message window to a larger size to accommodate plugins with longer names.

* Trapped F-Key View changes while actively grabbing Mixer Controls.

* Fixed the Alt-I, R and O jumps to work correctly when tracks are re-ordered.

* Fixed Exploded Mixer View code to clear meter when playback is stopped even when Zoom Mixer view is
sized very short.

* Shift-Right-Dragging operations in the MT now lock the cursor into the MT wave display area and eliminate
possible crashes which could occur under certain circumstances when moving the mouse outside the MT
boundaries.

* Adjusting the compressor threshold, when the program is set to Remote Mode will no longer crash the
system.

* Fixed code to correctly display Aux Master meters on TCP/IP connected remote machines.

* Fixed code to correctly display Dynamics GR meters on TCP/IP connected remote machines.

* Toggling Automation Mode On/Off when Offset Mode is active will now cleanly cancel Offset Mode and
any offset changes in progress.

* Fixed code to allow regions to be moved to the last tracks even when Return and Output tracks have been
re-ordered to the top of the MT.

* Adjusted code to fix display corruption above the MT ruler when scrolling the MT up or down.

* Fixed code to reset an active marked area started during playback with the B-Key that never received the E-
Key command to end the mark when playback is stopped.

>---<

Version 4.0c
Enhancements
* Added a new function to the FX API to allow plugins to link to the dual monitor configuration info from the

main program.

* Updated the Echo and Eq plugins to utilize the new API function to be dual monitor aware.

* A new enhancement has been added to Live Mode Automation chasing with Locate Points or Cue Location
commands in the Control Track. Snapping down the timeline to a new position with automation written in,
will now follow mute, pan and fader slopes, allowing for automatic fades and pan sweeps based on long
slope values to be executed at the new Cue. This can be used for live show automation to auto fade out and



in various mixer channels.

* Added some extra keyboard functionality for operating the Record Remote panel:

* {Enter} activates Record Mode or punches in and out when SRP Mode is active.

* {Shift-Enter} activates Rec/Rdy Mode.

* {SpaceBar} toggles between SRP Mode and the last active state of Stop, Rec/Rdy or Live Mode.
* {Shift-SpaceBar} toggles between SRP/Rec Mode (forcing a record punch) and the last active state of
Stop, Rec/Rdy or Live Mode.

* {Ctrl-SpaceBar} forces Stop Mode breaking any links to Rec/Rdy or Live Mode toggling.

Bug Fixes
* Fixed the ZLM Monitor Switching protocol to work correctly for odd and even mono channel record meter

assignments in any combination.

>---<

Version 4.0b
Enhancements
* Modified the SoundFile View recording engine to now allow the same low latency live monitoring of input

signals as the 4.0 MT engine whenever either of the Tape-Style monitoring options are selected.

* The SoundFile View Lock zone will now also lock the SF Out Device and keep it from changing when
transferring regions from the MultiTrack or Regions view.

* The code has been enhanced for handling display screen resolutions of multiple monitor configurations. The
code now attempts to determine the full virtual screen resolution across all monitors. This will not work on
all systems or video card drivers, so the reported resolution can now be overridden and new values can be
manually entered and saved with the preferences. The Max Screen Resolution Override option on the
Options menu allows you to set a new max screen resolution which will control the limits of all window
positions. The main window size no longer sets the limits.

* Many more initial popup windows and small dialogs will now follow the Dual Monitor Configuration
setting in the options menu to keep from spanning across the monitor boundary between dual monitors.

Bug Fixes
* Fixed code to stop a crash that could occur when using a marked area auto-punch record operation with the

Region Memory Caching option activated.

* Fixed code for SoundFile View recording while Tape-Style Monitoring is selected.



* Fixed error trapping code for Selected entry track conflicts of moves and copies in the MultiTrack.

* Fixed disappearing automation moves and copies in all directions.

* Changed code to clear buffers when switching from a blank layer during playback to make for a smoother
transition to the new layer.

* Modified code to help with allowing the taskbar to popup ontop of SAWStudio on certain Windows
installations that may have trouble doing so.

>---<

Version 4.0a
Enhancements
* Two new options have been added to the Options menu to allow adjustment of the base Priority Class of the

program. I have adjusted code to allow for safely increasing the Process priority internally to High or
RealTime priority. You may force the priority of the program to be raised above Normal for a possibly more
robust performance level. Be careful with the RealTime option, however, because you will force
SAWStudio above other system processes and if the program locks for some reason, you may not be able to
escape, even from the Task manager. This can be useful, however, for stopping interference from other
background services and processes and may allow smooth audio operation at very low latency settings.

* A new option has been added to the Command Line processing when the program first starts.

SAWStudio will now accept multiple FKY filenames on the command line when starting up. The first .fky
filename found will load as the default F-Keys. The next one found will load as the default Alt-F-Keys. The
third one found will load as the Midi WorkShop default F-Keys (requires MWS Version 1.6f or higher).
You do not need path information for the Fky files, only the filenames. The SAWStudio files must be stored
in the Configuration folder under the SAWStudio folder. The Midi WorkShop file must be stored in the
MidiWorkShop_Configuration folder under the SAWStudio Native_PlugIns folder.

Example: C:\SAWStudio\SAWStudio.exe Test.fky TestAlt.fky TestMws.fky

Bug Fixes
* The new Slide MT-Entry data function undo creation has been fixed.

* Both new Export Tracks to SoundFiles options have been fixed to properly handle automation and Fx buffer
size changes with no glitches.

* Fixed the loss of window focus when using Ctrl-S and other menu commands with message and dialog
boxes.

* Fixed code to keep Solo Bus options from interfering with the performance of BuildMix operations.



* Fixed Solo Bus mode solos to be active in Rec and Rec/Rdy modes.

* Fixed MTLoad readout to be active in Rec and Rec/Rdy modes and for the MTLoad and SrcLoad windows
to be properly cleared when the engine is stopped.

* Code modifications have been extended to the SoundFile View to enhance stability and eliminate corruption
of screen displays with multi-processors, multi-core processors and hyperthreading processors.

>---<

Version 4.0
Enhancements
* Added a new feature called Roll-Over Context Help to the Info Menu. You may activate this feature from

the menu or by pressing the Alt-H key in any window. When this feature is active, each active zone, switch
and control is outlined in red as you roll the mouse over the screen, while a text display window chases the
mouse position. By Left-Clicking in one of the active areas, information about how to use that zone is
displayed in the text window which freezes in position. You can scroll the text in the display window by
using the MouseWheel or Up and Dn arrow keys or the PgUp and PgDn keys. Pressing the H key while the
text is displayed will jump you directly to the related section of the Help File. Pressing the Esc key or Right-
Clicking the mouse will unlock the freeze and allow you to scan for more screen zones. Pressing the Esc key
or Right-Clicking again de-activates the Context Help Feature.

* Added engine modifications to support Tape-Style Record Monitor Switching. This new feature now allows
full live input monitoring direct from device inputs during recording. This does require low latency
operation capabilities of your system. Buffer settings of 3 x 128 or less are generally very good. There are
two new choices available on the Options Menu in the Auto Audio-Monitor Switching Protocol option.

One is called Tape Style – Playback / Input Switching. This option will switch between the Stereo or Mono
Device input and the MT playback automatically when you punch-in record. In Rec/Rdy or Rec mode, the
device input will be routed through the record channel console module. When SRP is engaged, the MT
playback will be the monitor source and when you engage the Rec button to punch-in, the monitor source
will switch to the device input, exactly like most professional multitrack tape decks.

The second option is called Tape Style – Input Always On. In Rec/Rdy or Rec mode, the device input will be
routed through the record channel console module. When SRP is engaged, the MT playback will be mixed
with the device input allowing you to monitor both sources together. When you engage the Rec button to
punch-in, the monitor source will switch to the device input only, muting the MT Playback signal.

These new engine features make virtual recording and monitoring possible completely in the virtual
environment. It’s now very easy to setup headphone mixes using the pre-aux sends and even blend reverb
into the phones mixes without the need for any external mixing hardware.

These features do not require you to use Live Mode console inputs, and therefore keep the recording process
much easier to setup and manipulate. Each console input source is kept as MultiTrack and the monitoring
now comes direct from the device inputs selected in the record meter input source zone.



You can also use this type of monitoring when using Live Input mode console inputs. In this case, all live
input channel assignments will automatically switch to MT playback for all tracks that have region data on
them. Those tracks with live input assignments which are armed for record will mute the playback when
record is punched in. If the Tape Style – Input Always On option is active, the live input channels will stay
active and blend with the MT track playback until record is punched in.

The Pre Patch Signal Flow routing will be handled correctly in that, if your recording point is post Eq and
Dynamics, the monitor playback will be post of the processing also, so you will not double process the
playback data. If you record the data pre Eq and Dynamics, the monitor playback will route pre processing
so it sounds the same as when monitoring the input source.

* New Solo Mode options have been added to the Mixer Menu:

The Solo In Place (Mutes Other Channels) mode is the original standard default SAWStudio mode. This
mode internally mutes channels that are not soloed, giving a true exact In Place Solo for critical mix
decision making. This allows full use of the engine buffer size changing and auto-latency VST
compensation capabilities with no problems.

The Solo Bus – Pre Fader mode functions as a true console PFL Solo. This mode leaves all other channels
alone and feeds the pre-fader signal of soloed channels into a separate mix bus which can be assigned with
the Solo Bus Out Device option. If this device is your main mix bus, the solo signal will interrupt the main
mix output, but not disturb any other channel signals, leaving Aux Send headphone feeds intact on other
devices. This option also allows you to monitor the output of different devices on any other device, so it
makes it possible to send multiple headphone mixes to different hardware outputs and still be able to solo
each mix into the main control room device, without the use of external switchers or mixers. The solo level
may also be adjusted with the Solo Bus Level option. It is generally recommended that certain latency
producing plugins, like Time Compressors, not be used with this option. Strange behavior may result when
combining signals from different routing paths that each run in a different time frame.

The Solo Bus – Post Fader mode functions as a true console bus Solo. This mode leaves all other channels
alone and feeds the post-fader signal of soloed channels into a separate mix bus which can be assigned with
the Solo Bus Out Device option. If this device is your main mix bus, the solo signal will interrupt the main
mix output, but not disturb any other channel signals, leaving Aux Send headphone feeds intact on other
devices. This option also allows you to monitor the output of different devices on any other device, so it
makes it possible to send multiple headphone mixes to different hardware outputs and still be able to solo
each mix into the main control room device, without the use of external switchers or mixers. The solo level
may also be adjusted with the Solo Bus Level option. It is generally recommended that certain latency
producing plugins, like Time Compressors, not be used with this option. Strange behavior may result when
combining signals from different routing paths that each run in a different time frame.

A special feature has been added to the Aux Master Sends. If an Aux Master is assigned to a device out, to
be used for a headphone mix, for instance, and the corresponding Output track is assigned to itself as a
device out, then the Output track solo button also acts as the Aux Master solo and blends the Aux Master
data into the solo bus. This allows you to solo and hear the aux mix in the main output device or whichever
device is assigned to the solo bus output.



The Solo Bus Out Device option can be used to route the solo signal to a separate device output to monitors
or headphones, leaving the main mix bus intact when using SAWStudio’s virtual console as a Live Mode
Front Of House replacement. Some signal routing must be active on the Solo Bus device. You can duplicate
the main mix assignments if you like, or assign an empty Aux Send to it. You can also assign an empty
muted track set in Live Mode to supply the needed routing signal.
The Solo Bus Level option can be used to adjust the Solo level feeding the Solo Device.

* The popup Aux Send Menu has been enhanced with new features. Clicking on the Aux Send section label or
any of the individual Aux Send number labels on the E, Z or W mixer views opens up a popup menu. This
menu shows the list of Aux Send Master labels and now also includes some quick Aux Send setup options.
When using one of the Solo-Bus modes, you can Solo this Aux Mix Device-Out if it is linked to a hardware
assigned Out-Track, as when used for a headphone mix. You can duplicate a mix into the current Aux Send,
across all channels, from the main mix settings or from any other Aux Mix settings. This only duplicates
Input Channel settings. You should adjust Aux Send Master Fader settings manually to make sure the mix is
not clipping. You also have choices to Engage and Disengage the Aux Mix, or to set the mix to Pre Fader or
Pst Fader, and to also Clear the Aux Mix.

* The Store and Recall Channel file functions have been enhanced and can now act as a very powerful Partial
Mix Template recall.

Storing channel settings to a file now operates across selected channels. The starting channel opens the File
Dialog allowing you to specify a path and name. The default name is filled in to match the channel label.
Each selected channel will write a separate file named the same as the channel label. This creates a channel
mix template of individual files, one per selected channel. Recalling channel settings from a file now also
operates across selected channels. The starting channel opens the File Dialog allowing you to specify a path
and name. The default name is filled in to match the channel label. Each selected channel will look for a file
named the same as its label and if one is found in the specified path, it will load. If no matching file is found
it will leave this channel alone. This allows you to recall settings to multiple channels in a new edl with
channel labels that match the channel template names. This is extremely useful for an album project, for
instance. You have recorded 10 songs, all of which are very similar, but not identical in track layout. The
basic rhythm tracks are the same, Kick, Snare, Toms, Cym LR, Bass, Guitar, etc… Now, after finishing the
mix of the first song, you select all the channels and store the settings to files. It’s a good idea to create a
Mix Template folder under the main project folder. You then open the next song, and select all channels and
recall the files from this folder. This will find and match each channel with its associated file settings,
including patched plugins, even if the track order has been changed, and ignore any channel with a different
label that was not part of the other song. By labeling tracks in a similar fashion across all projects, you can
easily exchange mix settings from one unrelated project edl to another, one channel at a time, or all at once.

A new option has also been added to the popup menu called Recall All From File And Duplicate To Selected
Channels. This option opens the file dialog and allows you to select a file. The settings will be recalled and
duplicated on all selected channels.

* A new feature has been added to the Driver Protocol Menu for the Asio Protocol option. Now, whenever the
Asio Protocol mode is selected, the ASIO Data Format Type will be displayed on the Asio Protocol Menu
option line. This information will display the Integer or Floating Point data format type that the driver uses.

* Starting playback when Live Mode is active from the MWS version 1.6d or higher will now auto toggle



back to Live Mode when playback is stopped.

* Many functions have now been enhanced to work while Live Input Mode or Rec/Rdy Mode are engaged.
This makes it much easier to keep these modes active during a recording session with live monitoring and
still manipulate the MultiTrack. The functions now active in Live Input Mode and Rec/Rdy Mode are:

Cursor positioning with mouse.
Position display.
Marking MT areas.
Changing MT layers.
The RTZ zone.
The Home-Key.
The End-Key.
The Tab-Key.
The D-Key.
The G-Key.
The K-Key.
The M-Key.
The R-Key.
The S-Key.
The U-Key.
The *-Key.
The Select Mode button.
The Grid zone.
Locate Points.
Disabling MT tracks.
Clearing all track entries.
Entering track labels.
Moving MT-Entries.
Alt-Grab adjustment of MT-Entries.
Changing record tracks with the record meter Track zone.

Undo files are created the same as when the engine is stopped.

* Changed the Left-Right-Click Set To Default value to zero db for aux send level controls. This makes it
much easier to snap the levels to a starting mix value for aux send mixes.

* Automation changes In Live Input Mode are now processed if you jump the cursor down the timeline. This
allows Cue Location Markers to be used for Live Mixer automation within songs.

* The Select Mode nudge feature has been enhanced. In Select Mode, the Left and Right Arrow keys can be
used to snap and then nudge the selected entries one cursor step at a time, keyed from the front of the key
entry. Pressing the Shift key at the same time will key from the end of the key entry. Pressing the Shift-Alt
modifiers at the same time will key from the key entry offset position, if one has been set.

* Double-Clicking the F Mixer view label area now opens the E Mixer offset to the main fader position for
quick level adjustment.



* Live Input Device source assignments to mixer channels are now displayed in the F Mixer as small patch
bars in the I/A zone. L-Only sources display as a bar on the left side of the zone. R-Only sources display as a
bar on the right side of the zone. Stereo and other combined mono sources display as a bar in the center of
the zone.

* Increased the maximum buffer size for VST preset settings saves to compensate for more and more VST
plugins that are taking huge amounts of data space to save their presets.

* Layers may now be changed during playback to blank layers. When changed back to layers with data, the
data will remain in sync with the playback. If you start playback on a blank layer, the layer can be switched
to a layer with data on it, but the data will not be part of the current playback cycle because the track was
never initialized into the playback loop. You must stop and restart playback to hear the new layer data.

* Working with Group Presets has been enhanced and works differently than earlier versions.

Right-Clicking the MultiTrack titlebar opens the Group Preset Menu.

Shift-Left-Clicking any group preset will set the group to the current number-selected tracks. This setting
will overwrite any previous group entries in that preset, not append them.

Left-Clicking any group preset will clear any existing number-selected tracks and select the preset group, not
blend them.

Ctrl-Left-Clicking any group preset will blend the preset with any currently number-selected tracks.

Alt-Left-Clicking any group preset will clear any existing label-selected tracks and select the preset group,
not blend them.

Ctrl-Alt-Left-Clicking any group preset will blend the preset with any currently label-selected tracks.

Right-Clicking any Mixer View titlebar opens the Group Preset Menu.

Shift-Left-Clicking any group preset will set the group to the current selected mixer channels. This setting
will overwrite any previous group entries in that preset, not append them.

Left-Clicking any group preset will clear any existing selected mixer channels and select the preset group,
not blend them.

Ctrl-Left-Clicking any group preset will blend the preset with any currently selected mixer channels.

* The FX API has been enhanced to allow plugins to request track label information.

* The BuildMix To Current HotTrack function has been enhanced to allow the HotTrack to be one of the
tracks that carries mix source data. This option now creates an undo file, since it can destroy current edl
data, and will force an insert and overwrite existing data on the destination HotTrack(s). This allows you to
replace a track’s data with the new processed buildmix data in one operation. Pay attention to warnings of



existing mix files. Make sure to append the data if you are performing multiple separate mix operations to
the same file, or existing regions connected to the mix file may be corrupted.

* A new BuildMix option has been added to the Process/Mixdown menu called BuildMix To Current
HotTrack / Layer. This option allows you to select a destination layer for the Buildmix operation. This will
build the mix and place it on the current HotTrack and the selected destination layer.

* A new option has been added to the Mixer menu called Clear Selected Mixer Labels. This option clears only
selected mixer channel labels, leaving other labels alone.

* FX Buffer Size Changing plugins will now cause a notice to appear on the Main Window TitleBar when the
engine is activated. Clicking in the displayed msg zone will display the plugin’s name and the channel it’s
patched into. This warning msg picks up and displays the first plugin to alter the buffer size only. Be aware
that when you are depending on any live input monitoring during Live Mode, playback or recording, buffer
size altering will most likely cause latency drift due to the engine attempting to loop multiple times to fill the
buffer in a look-ahead mode and live device inputs have no look-ahead data available so blank buffers are
inserted. You should find and bypass all plugins causing this warning while attempting to monitor live
device inputs.

* The Record Meter Input Zone is now sensitive to Channel Input Device Mono L-Only and R-Only
assignments and correctly enables unassigned Mono Devices in the popup menu.

* A new feature allows you to copy an MT marked area directly to a Region by pressing Ctrl-C. The region is
automatically selected in the Regions View allowing you to instantly follow up with an Insert or Shift-Insert
keystroke to paste the data to a new location.

* All On-Top windows will now drop beneath overlapping application windows when SAWStudio looses the
application focus and be restored to On-Top status when SAWStudio again gains focus.

* MultiTrack Waveform scaling with the Mouse-Wheel or the Ctrl-Numeric-Keypad now responds to number
selected tracks and adjusts all selected tracks at the same time.

* Recall From Memory Cells and Files now creates an undo file.

* Altered buildmix base or device filenames are now cleared in the new edl file created when using the Save-
As or Save Copy-As functions. This helps accidental buildmix overwrites of the original mix files when
later working in the newly created edls.

* Marking areas in the SoundFile and MultiTrack Views has been enhanced to allow you to slide a fixed
marked area to a different position while maintaining the marked area size. The Shift-B key will adjust the
begin position to the current cursor location and automatically shift the end position to maintain the same
marked area size. The Shift-E key will adjust the end position to the current cursor location and
automatically shift the begin position to maintain the same marked area size. Shift-Dragging either the begin
or end position in the Timeline Ruler area will drag the marked area to a new location while maintaining the
marked area size.

* A new option has been added to the Mixer menu called Snapshot Chan Settings To MT Automation. This



option allows you to snapshot all basic mixer channel settings and write them as MultiTrack automation data
at the current cursor position. This function responds to and will write data for all selected Mixer Channels
simultaneously. You do not need to be in Automation Mode to use this function. This function will not write
non-automatable items such as solos and device assignments, or FX patches.

* The Numpad functions for MT-Zoom, WaveForm Scaling and Locate are now active in all Mixer Windows.

* The EQ and Echo plugins have been enhanced for faster overlapped redraws when activated. The new
versions are also now sensitive to offscreen positioning saved with edls from higher resolution displays and
will automatically correct themselves to fit on the current screen resolution.

* Two new options have been added to the Process/Mixdown menu called Export Track(s) To SoundFile(s) –
[No Mixer Processing] and Export Track(s) To SoundFile(s) – [With Mixer Processing]. These options
make it simple to export solid track wav files from SAWStudio to be easily used in any other DAW system.
The first option bypasses all mixer channel processing and automation and outputs the source file region
data, neatly assembled into a solid wav file. All edits and SoftEdges are processed for smooth transitions.
The second option processes the data through the mixer channel controls, patched plugins and automation.
Both options will translate the source files to the current MT SampleRate and Resolution settings.

If there are selected tracks, these options process all selected tracks only, otherwise all tracks are processed.

You are given a choice to process all layers or only the top layer. You are also asked to select a location for
the exported files as well as a base filename. The base name (usually the edl name) will be appended with
the track label and layer number if layers are chosen. I recommend creating a folder called Export in the
project folder to separate all exported files for easy transfer to another system. A separate folder also helps to
eliminate problems due to filenames matching existing source files in the current project folder. Duplicate
filenames in the same folder will be overwritten.

* Selecting MT Track Labels for special playback functions has been enhanced with the addition of two new
commands. Alt-Ctrl-Clicking will now label-select all tracks between the last selected track and the current
one. Alt-Shift-Clicking any label-selected track will transfer and add all the selections to the track numbers
for a quick way to group editing functions on the fly.

* A new MT-Entry editing feature has been added to allow you to slide the Region data within an existing
MT-Entry without repositioning the entry. Shift-Right-Dragging within an MT-Entry will slide the data
within the entry boundaries without affecting the entry size or position. This can be very helpful when
making slight adjustments on various tracks to align horn or vocal parts.

* Startup Command Line processing has been added with the following options:

SAWStudio will accept a WAV or EDL filename on the command line when starting up. WAV files will
automatically open into the SoundFile View. EDL files will automatically open into the MultiTrack View.
With EDL filenames, you may also include a /P command option to immediately begin playback of the
EDL. Make sure to include the entire path and filename and leave a space after an EDL name before adding
the /P.

For example, to have SAWStudio load and begin playback of an EDL upon startup from a shortcut icon on



the desktop:

1. From the Windows desktop, right-click the SAWStudio shortcut icon.

2. Select Properties from the shortcut menu.

3. Click the Shortcut tab.

4. In the Target textbox, click at the end of the command line.

5. Add a space, then type the pathname for the EDL followed by another space then add a /P.

Example: C:\SAWStudio\SAWStudio.exe D:\Audio\Test\Test.edl /P

6. Click OK.

7. Double-click the icon to start the program.

A WAV file example might look like this:
Example: C:\SAWStudio\SAWStudio.exe D:\Audio\Test\Test.wav

SAWStudio will also accept a PRF filename on the command line when starting up. In this manner, multiple
preference files (including different shades) can be maintained and loaded automatically. You do not need
path information for the prf file, only the filename. It must be stored in the Configuration folder under the
SAWStudio folder.

Example: C:\SAWStudio\SAWStudio.exe Test.prf

Note that if any of the target line paths or names contain spaces, be sure to enclose the full pathname in
quotes, with the /p option (if used) placed outside of the quotes.

Example: “C:\SAWStudio\SAWStudio.exe D:\Audio\Test 2\New Test.edl” /P

* A new option has been added to the Control Track Built-In Commands called Stop Playback / Cue Next /
Play. This option allows you to instantly jump to the next Cue Location and begin playback.

Video Track Viewer Version 2.9
* Framerate display has been expanded to 3 decimal places.

* A new option has been added to the File Menu called Stamp New Avi File FrameRate. This option allows
you to change the framerate stamped in an avi file header. This can be very useful to force odd framerate
stamps like 24.999 to 25.000 which will stop mismatched framerate warnings when adding clips and force
perfect frame accurate sync on the timeline.

Bug Fixes



* Fixed automation copies of overlapped automation data when using the V Filter.

* Live Input Mode now handles automation changes correctly and no longer chases the automation moves
while sitting idle on the timeline.

* Code modifications done to enhance stability and eliminate corruption of screen displays with multi-
processors, multi-core processors and hyperthreading processors.

* Alt-Drag MT-Entry boundary adjustments now correctly ignore the Auto-Zero Cross setting and allow exact
boundary adjustment in both directions on selected or non selected tracks.

* The active mixer window now stays active after using a popup fader from any of the controls.

* Locate points and Control Track View tempo entries now correctly display measure count offsets if used.

* Setting a new MT sample rate now correctly updates the MT Timeline.

* Changing Smpte Sync Devices while a Smpte mode is active, now correctly switches to the new device
settings without having to toggle Smpte Mode on and off.

* Adjusted code to fix SRP startup from sometimes failing when initiating directly from Rec/Rdy mode.

* Fixed code to properly display the Dynamics GR Meter on the E-Mixer when switching between F-Keys.

* Fixed code that could cause buffer crashes with certain VST Synth plugins when passing data streams
between SAWStudio and the MidiWorkShop.

* The Wide Mixer view now correctly displays marked channels when switching from the Return or Output
section to the Input section using the I, R and O zones.

* Offset Mode now correctly offsets default mixer values when you stop and restart playback without ever
exiting and committing Offset adjustments.

* Opening a Mix Template will now correctly disengage any active solo mode.

* Using any of the commands to mark the entire SoundFile in the SoundFile View now first correctly clears
any existing marked areas and then properly marks the entire file.

* Modified VST initialization code to compensate for certain plugins that seem to require the audio engine to
be running in order to initialize their interface properly.

* Control Track View long name entries are now truncated in the display window and no longer push the
tabbed columns out of alignment. The internal name length is preserved.

* The Control Track Listbox correctly updates back to the beginning now after the execution of the Cue
Beginning / Play command.



* Fixed link between Dynamics Hi and Lo Eq when using the popup fader with the Shift Key.

Video Track Viewer Version 2.9
* Video Track splits and moves will now correctly redraw marked areas.

* Edit Mode can no longer be toggled when Edit playback is active.

* The Render To DV File functions will now correctly re-sync the video viewer display and the MT cursor
when the render is finished.

>---<

Version 3.9n
Enhancements

Bug Fixes
* Adjusted the Tempo display format to allow display of tick resolution numbers up to 4 digits. The Measure

display was reduced from 5 to 4 digits to compensate. When measure counts beyond 4 digits are needed, the
measure and beat separator is reversed and the measure count wraps around at each 10,000 value. For
example, tempo display at position 9999>01>0000 will display as shown and when it wraps around past
measure 10,000 to 10,002 for example, the display will be shown as 0002<01>0000. This compromise was
done to salvage all existing shades and the current pixel layout of the MultiTrack Top Client area. The MT
and SF timeline ruler display will still show the 5 digit measure value.

* The SoundFile View will now correctly display the timeline ruler values in Sample Edit magnified zoom
mode.

* Fixed the Cue Next/Preload Control Track command to operate properly in Slave Mode. The Preload
command will be ignored on a Slave machine so the slave lock and go operates correctly.

* The MT and Mixer windows will now correctly display the window sizing cursor when the mouse is placed
over the window borders even in Live Mode and when a Trk or Chn cursor is selected.

* Changing the Base Record Filename or any Track Record Filename in the Record Setup dialog now checks
and corrects for duplicate filenames.

>---<

Version 3.9m
Enhancements
* The engine has been enhanced for tighter Live Mode operation with lower actual latency at the same buffer

settings than before and perfect record sync positioning in all combinations of recording modes, using the
Auto Loopback adjustment as well as automatic compensation for monitoring from Aux Sends assigned to



devices and Aux-Send-Return device loops for using hardware processing gear. The engine now senses and
adjusts in the following manner:

Normal recording direct from device- ins, while monitoring from an external mixer source, adjusts the
record region sync position using the Auto Latency Adjust value only. Sync is not dependent on buffer
latency size settings and therefore makes perfect recordings even on slow audio drivers and hardware.
Overdubbing will be in perfect sync when monitoring playback from any bus out directly or from Aux-Send-
Masters assigned to device outs. This mode uses an external mixer (or soundcard driver hardware mixer) to
split the source signal and blend it with the playback signal from SAWStudio for headphone monitoring
during recording.

Recording from mixer channels assigned to live device-ins, while monitoring direct from the SAWStudio
virtual mixer source, adjusts the record region sync position using a combination of the Auto Latency Adjust
value as well as the exact internal buffer latency present in the monitor chain. Recording from mixer
channels with VST synths patched into the Pre Patch point, while monitoring direct from the SAWStudio
virtual mixer source, adjusts the record region sync position using the exact internal buffer latency present in
the monitor chain only. These modes require low latency buffer settings of 4 x 128 or lower to be useful for
monitoring without distracting delays. The Out and In buffer sizes should be set the same. The In-buffer-
count should be set to 4 or higher and will not add to the monitor latency. The Out-buffer-count does add to
the monitor latency and should set as low as possible while still maintaining stable system operation. This
does require good audio drivers and hardware. Only a few soundcards can do this in MME mode… many
cards can do this using ASIO mode. Overdubbing will be in perfect sync, regardless of the monitor latency,
when monitoring playback from any bus out directly or from Aux-Send-Masters assigned to device outs.
The record signal is taken from the Pre Patch point when recording from mixer channel sources. The record
signal will include the EQ and Dynamics section of the virtual mixer unless the Pre Patch point routing has
been changed in the Mixer Menu Pre-Fx Patch Signal Flow option. You may monitor the Control Room
signal from the main faders and freely use the Mute and Solo buttons without disturbing the recording. You
may also use Pre or Pst Aux Sends to send monitor mixes to performers through headphones. Temporary
playback override of the mixer channel device-in source assignments can be done by pressing the Shift-Key
when you start playback. This will force all mixer channels to MT source for the duration of this playback so
you can easily listen back to the recording without having to change your input assignments. When you are
finished recording, you should then change all mixer channel source assignments to MT for normal editing
and mixing operations.

A special Live Aux-Send-Return processing loop feature is designed into the engine to allow the use of
hardware processing gear to be blended into the mix in perfect sync regardless of the latency buffer settings.
This mode is automatically engaged when an Aux-Send-Master is assigned to an out-device and its
corresponding Return is assigned to an in-device. This mode splits the engine and delays the out buffers
while leaving the Aux-Send signals in original time, thereby allowing the normally delayed hardware
processing data to arrive and mix into the playback in perfect time. This does not require low latency buffer
settings, but it does however delay the normal playback signal, and therefore will add latency to Live Mode
virtual monitoring. Only the Aux-Send-Return device pairs will be affected, therefore you may still use other
aux sends as headphone monitors, as well as any other bus out. The record signals will all be properly
adjusted to drop in perfect sync regardless of the added monitor delay. This mode is best suited for mix
operations where hardware processing gear is desired in realtime. It is recommended that you do not assign
Return channels to in-devices when using Live input channels for virtual monitoring, in order to obtain the
lowest possible monitor latency.



Bug Fixes
* Fixed the ontop status of the overwrite/append msg box for the BuildMix dialog.

* Adjusted code for the MT, SF, Record, F-Mixer, and Z-Mixer views to properly re-display memory images
when resizing with the Windows “Show Window Contents While Dragging” option ON.

* Added code to use an alternate query method needed for certain VST plugins to register themselves as a
synth.

* Adjusted code to compensate for LoopBack Latency only on active Mixer Channel Device recording tracks.
The engine now auto-senses the correct amount of adjustment required for each type of recording source on
a track per track basis regardless of the combinations of Live, VST, MT or direct sources being used at the
same time.

* The Live Aux-Send-Return slip devices delay adjustment feature has been fixed to allow for using hardware
reverb or other processing gear in the Aux-Send-Return loop assigned to audio device ins and outs.

* The engine modifications have taken away the DWave option of using a 1 buffer latency setting, although
the actual latency performance at 2 buffers is now the same as it was in the earlier engine at 1 buffer. If you
have been using a 1 buffer DWave setting, change it to 2 buffers…latency should remain the same.

>---<

Version 3.9l
Enhancements
* DirectX and VST Plugin positions will now save with the edl whether the plugin window is open or not at

the time of the edl save. Native plugins have their own control over this feature.

* The Aux Send mini faders have been enhanced to use the large popup faders by clicking and holding in the
Aux Send readout displays above the mini fader.

Bug Fixes
* Fixed VST code that could cause some plugins to open with only the SAWStudio VST titlebar and no

window display. This was caused by some of the VST crash code adjustments from 3.9k.

* Fixed ShowControl Midi Trigger code to work correctly with edl entries containing DV video. This fix
should stop the video graph error messages and allow the video to open properly.

* Fixed ShowControl Midi Note-Off Trigger code to correct for misfire possibilities.

* Fixed E-Mixer meters code which could stop responding based on Z-Mixer size adjustments… now
completely independent.



>---<

Version 3.9k
Enhancements
* Two new options have been added to the VST popup Options menu called Override Auto Latency

Compensation and Override Auto Latency Compensation Value. The first option will display the reported
latency delay in samples that the plugin returns to SAWStudio when asked. This option can also be used to
override that value. If overridden, the new compensation value used will be taken from the second option
setting, which can also be set to zero to bypass all automatic latency compensation. Some plugins report
latency differently than expected or not at all. These options allow you to correct for VST latency or bypass
it altogether. These options save with the edl and with individual saved presets to allow for the same plugin
to have different latency values dependent on the actual plugin parameter settings.

Bug Fixes
* Adjusted the VST auto compensation routines to fix some problems associated with odd sample latency

sizes interacting with buffer boundaries dependent on SAWStudio buffer size settings. This should solve
issues with pops and clicks in certain VST latent plugins.

* More VST code adjustments to help with compatibility issues concerning certain plugins that cause a crash
when patched into SAWStudio. This one takes care of the Applied Acoustics product line and also some
other plugins including the Ivory piano plugin.

>---<

Version 3.9j
Enhancements
* VST Plugin hosting has been enhanced to allow VST Plugins to reside in any folder on any drive. If the VST

Plugin dll is not installed into the VST_Plugins folder under the SAWStudio main folder, then you can now
place an ini file substitute in the VST_Plugins folder pointing to the full path of the dll file itself. Create an
ascii text ini file in the Notepad and name it the same as the original dll file. Inside the file type the full drive
and path and original dll filename on the first line of the file. Make sure to finish the line with a carriage
return. For example… if a VST Plugin called TestPlug.dll is installed to D:\VST\Work, then create an ini file
called TestPlug.ini and inside the file type the line D:\VST\Work\TestPlug.dll followed by a carriage return.
This ini file, placed in the VST_PlugIns folder under SAWStudio, will now link SAWStudio to find the
VST plugin in its originally installed path. This can help solve compatibility issues with certain hardwired
path plugins and their various copy protection schemes.

* VST Plugin hosting has been enhanced to automatically compensate for plugin latency as reported by the
plugins themselves. Using any external latency compensator or otherwise adjusting the track data to
compensate is no longer necessary. Realize that previous edls which include such adjustments must be
altered to remove the manual compensation, otherwise the data will now be incorrectly positioned on the
timeline. Note that the bypass switch is backward compensated to allow bypassing during live playback
without loosing sync. Unpatching the plugin during live playback is not backward compensated however,
and will cause data sync to be incorrect. You must stop and restart playback to correct the track sync. Also,



realize that plugins that have latency will add the latency to live inputs creating delays and in some cases
may force the engine to shutdown.

* Hot Track Solo Mode may now be used with the Shift-Key to keep the Return Channels active so you can
hear the Return effects. Each time you switch to a new HotTrack it will react to the Shift-Key, so you can
switch the Returns On and Off at will as you jump around by pressing the Shift-Key or not.

* The Full Mixer colored section icons can now be used to vertical scroll E-Mixer and Z-Mixer sections,
exactly like the section zones on the MT left edge. The dead zones just above the Full Mixer faders are also
active zones for jumping to the fader sections.

* The E-Mixer, Z-Mixer and Wide Mixer popup Aux Label Display zones have been altered to only be active
on the individual Aux Number text (1, 2, 3, etc.) and the main Aux Asgn text. This helps to keep the display
from popping up when mouse aim slightly misses a switch or other active aux control zone.

* All MT Entry moves and copies have been enhanced to now include Automation and Control entries within
any SoftEdge boundaries.

Bug Fixes
* Modified the BuildMix code to solve a crash that could occur when doing long mix builds (over an hour)

using the Hi Resolution SRC options.

* Fixed the Load Preference function to properly load new Midi Controller Templates when changing
preferences from within the program.

* Store and Recall channel operations now correctly handle FX Bypass switch settings.

* Fixed code that could cause a crash when naming tracks under certain specific conditions.

>---<

Version 3.9i
Enhancements
* The Store/Recall menu has 2 new options. Store All From Channel To File and Recall All From File To

Channel. These two options allow direct transfers to and from Channel Template Files to mixer channels
through Memory Cell 1.

* The Exploded Mixer View has been enhanced to accept the Left and Right Arrow keys and the Mouse Wheel
to scroll through the mixer channels while keeping the E Mixer view active.

Bug Fixes
* The Open and Save dialog box has been forced to an ontop status to open above other ontop windows.

* Modifications to the VST process routines to handle buffer size changes that come from other plugins



patched in front of VST plugins that might otherwise crash.

* Fixed live playback marked area updating in the MT to display correctly when zooming in and out.

>---<

Version 3.9h
Enhancements
* The Record Meter window scrolling has been enhanced. When the Record Meter window is smaller than the

current number of active meters, you can now use the Shift-Key with the mouse wheel or left/right arrow
keys to scroll an entire page of meters at a time.

* Extended API functions for Midi WorkShop enhanced features. MWS Virtual Port Names are now passed
back to SAWStudio when using MWS version 1.5d or higher.

* A new option has been added to the Control Track Built-In Commands called Stop/Cue Next/Live Mode.
This command stops playback, cues to the next Cue Location and then activates Live Mode.

* HotTrack Solo Mode has been enhanced to stay active through undo recalls.

* The I, R and O zone functions have been enhanced to retain the last vertical offset for each module type
when jumping to different types and jumping back.

Bug Fixes
* The Clear Current Mixer Channel option on the Mixer Menu now correctly clears the current Mixer Hot

Channel, rather than the last mixer channel clicked on. The clear operation uses the built-in default mixer
settings and does not react to any saved default mixer template.

* Adjusted code that stops automation entries at marked boundaries from disengaging when doing
stretch/shrink automation operations.

* Fixed code to stop MWS from playing back data when the SAWStudio RecRdy and Record modes are
activated with live inputs and no SRP playback engaged.

>---<

Version 3.9g
Enhancements

Bug Fixes
* Adjusted message and dialog box code to free the cpu during the modal loop.

* Adjusted the Memory Caching code to reduce cpu load on large sessions with many regions and MTEntries
by as much as 50-60%.



* Fixed Custom SampleRate entries to correctly accept values over 100,000.

* Fixed Goto Time Dialog keyboard function.

* Fixed EDL Undo Levels Dialog to correctly accept levels up to 99.

>---<

Version 3.9f
Enhancements
* A new Control Track Built-In Command has been added called Cue Location / Wait For Time. This

command allows you to place a Cue mark and designate a Wait For Time value in 24 hour time format.
When this Control Track Entry is activated, the system stops and displays a message window showing the
wait for time value and the current time value. The current time continues to update until the wait for time is
reached. At that point, the system starts playback, or SRP playback if record meters are active. If you have
the SRP/Record Latch turned on, then the system will begin recording immediately. If instead, you mark an
area on the multitrack, recording will auto punch in and out. Using this feature, you can designate a defined
length recording, and then stop the system with a Control Track Stop command at the end of the marked
area. You may cancel the wait for time feature when the time window is displayed and counting by pressing
the Esc-Key.

* The Replace MT Entry (Shift-R) function has been enhanced to preserve automation entries if Automation
Mode is active when you engage the operation.

* The BuildMix function has been modified to maintain the increased performance and no longer depend on
the Windows Program/Application priority setting. The Windows Performance Optimize for
Programs/Applications setting is still recommended for best overall SAWStudio performance, but you may
now use the Background Application setting without destroying the BuildMix performance.

Video Track Viewer Version 2.8
* New Video Viewer enhancement saves the current Overlay Render size and the Overlay Render Mode to the

Video Preferences, so you can now force the Overlay Render mode active as a default.

Bug Fixes
* Adjusted Shutdown code to correct for problems when Region Caching is active under certain session

conditions.

* Adjusted Relative Tempo position calculating routines to correct for display problems and add more
accuracy.

* Fixed display problems on Out Assign switches 19, 21, and 23 to keep them from overwriting part of the
numbers 20, 22, and 24 next to them.

* Fixed the Marked Time to display correctly even when the MultiTrack is not the active window on an F-Key



change.

* Fixed waveform display problems using .aiff files.

* Adjusted floating point accuracies for grid calculations.

* Hooked Mono settings for a Key Channel so keyed Dynamics and Fx are now properly following mono
settings.

* Fixed Dynamics GR Meter to properly handle L/R Rvs Gate data.

* Fixed Undos to restore video entries correctly when you move audio and video selected entries by grabbing
an audio entry to initiate the move.

* Fixed Selected audio and video moves to properly detect audio entry limits when grabbing a video entry to
initiate the move.

* Fixed full zoom out on large displays from crashing.

* Fixed Region split functions from causing crashes when region names are near the max length of 127
characters.

* Fixed Store/Recall Fx problems on Output Channels.

>---<

Version 3.9e
Enhancements
* Lowered the Memory Caching thread priority to keep it out of the way of normal user activity.

* A new option has been added to the MT Menu called Disable Retake-All Function. This option will allow
you to disable the use of the Retake-All function helping you from damaging a session by its accidental use.
When this option is active, the Retake-All command will be blocked. You must toggle this option OFF in
order to re-use the Retake-All function. This option saves with the preferences.

* The Record Setup window will now respond to the Enter-Key for OK and the Escape-Key for Cancel as well
as the mouse clicks.

* The Cue functions (Q, Shift-Q, Ctrl-Q) are now active from the Record Remote and Meter windows as well
as the MultiTrack.

* The Regions View Insert button can now be used with the Alt-Key to force an insert and overwrite function,
which inserts the currently selected Region View region to the current HotTrack at the MT cursor position
and overwrites any existing data. If Automation Mode is active, then existing automation data is preserved.



* A new option has been added to the Select Mode popup menu called Associate Selected In Regions View.
This option will select and hilite all Regions in the Regions View associated with all MT Selected Entries in
Select Mode. A very easy way to visually select groups of regions for an export or rename operation.

* The Regions View Rename option now creates an undo file.

* Two new options have been added to the Regions menu called Sequential Append Format “ {001}” and
Sequential Append Format “ – 001”. These two options work with the ReName Regions function and
control what the sequential appended number format looks like. These options save with the preferences.

* The Native Plugins are now listed in the FX Choices View as {SAW}.

* The Shift-Insert command for adding Time Stamped Regions to the MT has been enhanced to force an
insert, if necessary, overwriting underlying MT-Entries. This guarantees that the entry will be placed at the
original Time Stamp.

* A new option has been added to the Mixer Menu called Clear Current Channel. This option clears the
current mixer channel settings to default. If the current channel is part of a selected mixer group, all of the
group channels are affected.

* The Control Track Midi Global Play function has been enhanced to control the SRP button when armed
record meters are active. This means you can now remote trigger SRP/Rec mode from a midi keyboard
assigned note, or Midi Controller Footswitch. This option will press the SRP button when record meters are
active (instead of the Play button) and can trigger record in two ways. A marked area auto punch section or
by using the SRP/Rec latch option in the options menu.

* A new record feature has been added called Multi-Take Loop Record. This feature along with 2 other
options can be found on the Retake Popup Menu on the Record Remote Panel. Activating Multi-Take Loop
Record mode allows you to mark a punch-in/out area on the MT… place the start cursor position in front of
the marked section to allow for some pre-roll time and then start SRP playback. When the punch-in area is
reached, recording is engaged automatically and dis-engaged at the punch-out position. The region (or
regions for multi tracks at once) will be stamped with the starting date and time and take number as well as
the normal file or track label name. The system then automatically stops and restarts the process again at the
original pre-roll start position and continues to loop, each time dropping new takes in the recording area.
You can set a loop counter to stop after a certain number of loops up to 100, using the Multi-Take Loop
Record Count option. When you stop the process or when the loop counter runs out, you will be left with the
last complete take onscreen. The other takes are grouped together by the date and time stamp and it becomes
an extremely easy process to lay any take group back onto the MT. Simply select the take number region of
interest (or multiple regions for multi track recordings) and use the Shift key when you click the Insert To
MT button, or press Shift-Insert on the keyboard. The region or group of regions will instantly insert
themselves and overwrite the current set of regions at the original record position… nothing could be
simpler… you can instantly lay down multiple takes of multiple tracks and even mix and match takes on
different tracks. The insert of multiple regions lays down the tracks from the current HotTrack in order to
the next track. Make sure to have the MT track order in a normal sequential order when using this insert
feature to lay all take regions to their proper tracks at one time.

Another option called Multi-Take Layer Loop Record works in a similar fashion, but adds the extra feature



of placing each new group of takes on the next layer (automatically) until the layers are filled, at which time
it keeps inserting the new takes on the last layer.

* The B and E keys are now active during MT Play mode. Pressing the B-Key starts a live marking update on
the HotTrack, and pressing the E-Key stops the growing marked area. You may continue to press the E-Key
to expand the area to the current cursor position. Pressing the B-Key again, starts the live update of a new
area.

* Right-Clicking on the MT Play button will now toggle Live Input Mode.

* Opened up more functions in Live Input Mode like Marking Areas, Home, End, Tab, etc.

* Live Input Mode will now automatically be restored when play and record modes are stopped if Live Input
Mode was active at the time the other modes were started. Rec- Rdy will now behave the same… If Rec-Rdy
is active when you start SRP or Rec mode, Rec-Rdy will automatically restore when you stop the SRP or
Rec operation.

* VST plugins now save their OnTop window status with the edls.

* VST Synth Plugs now have a new option in the VST Popup Options Menu called Disable SoftSynth. This
option allows you to completely bypass the internal routing of a VST Synth plug and pass underlying audio
track data through. This allows you to keep a patched synth on the track, but still record the data as audio on
the same track and ignore the patched synth, while still keeping it in the edl with all its settings in case you
need to make changes and re-record again. When this option is active a large Red X displays across the Blue
Pyramid Options Icon. This option saves with the edl.

* Native support has been added for Frontier Design’s TranzPort wireless remote controller. A lot of control
has been packed into this very small control box. The controls with this Midi Controller Template operate as
follows:

The Track (Channel) buttons increment and decrement the track/channel. Used with the Shift key, they
increment and decrement by 8 tracks/channels.

The Rec button toggles the record meter open/close for the current track. Used with the Shift key, it operates
the record meters as a record template, allowing multiple channels to be armed or disarmed at once.

The Mute button toggles the mute on/off for the current channel.

The Solo button toggles the solo on/off for the current channel. Used with the Shift key, it toggles all active
solos off.

When Record Meters are active, The Undo button will Retake To The Last Record Position. Used with the
Shift key, it will Retake To The Cur Cursor Position.

The In and Out buttons will Mark Beg and End. Used with the Shift key, they will jump to the Mark Beg
and End positions. When any marked area is active, the LCD displays a small hatch mark just after the time
readout display.



The Punch button is used as a special Function button. When active, it causes the Scrub Wheel to act as a
function selector scanning through different control types within the program. Used with the Shift key, it
resets the current selected control type to its default value. The current selectable control types are: Layers;
Fader; Pan; Aux 1 In; Aux 1 Pst Fdr; Aux 1 Lvl; Aux 1 Pan; Aux 2 In; Aux 2 Pst Fdr; Aux 2 Lvl; Aux 2
Pan; Aux 3 In; Aux 3 Pst Fdr; Aux 3 Lvl; Aux 3 Pan; Aux 4 In; Aux 4 Pst Fdr; Aux 4 Lvl; Aux 4 Pan; Aux
5 In; Aux 5 Pst Fdr; Aux 5 Lvl; Aux 5 Pan; Aux 6 In; Aux 6 Pst Fdr; Aux 6 Lvl; Aux 6 Pan; Comp In;
Comp Gn; Comp Thr; Comp Ratio; Comp Rel; Comp Att; Gate In; Gate Rvs; Gate Thr; Gate Flr; Gate Rel;
Gate Att; Dyn Key Listen; Dyn Eq Lo; Dyn Eq Hi; Dyn Key; Eq In; Eq LoCut In; Eq LoCut Frq; Eq HiCut
In; Eq HiCut Frq; Eq Gn 1; Eq Frq 1; Eq Q 1; Eq Gn 2; Eq Frq 2; Eq Q 2; Eq Gn 3; Eq Frq 3; Eq Q 3; Eq
Gn 4; Eq Frq 4; Eq Q 4; Eq Gn 5; Eq Frq 5; Eq Q 5; Mono; Swap LR; Phase Rvs; Attenuator;

When Record Meters are not active, the Loop button toggles Auto Rewind on/off. When active, regular MT
Play will now jump back to the starting point when play is stopped. If there is a marked area, MT Play will
continue to loop the marked area.

When Record Meters are active, the Loop button toggles Auto Record Loop mode on/off. SRP recordings
will continue to create new takes of the marked area, looping back to the cursor position pre-roll starting
point. Used with the Shift key, Auto Record Layer Loop mode is engaged, which will fill the layers with
new takes on Lite and Full SAWStudio versions.

The Shift button is used as a momentary modifier key.

The Markers Prev button will jump to the previous Cue marker.

The Markers Next button will jump to the next Cue marker. Used with the Shift key it will toggle Live Input
Mode on/off. Live Input Mode is displayed on the LCD display as a small single character level meter.

The Markers Add button will add a new Cue Location marker at the current cursor position. Used with the
Shift key, it will delete any Cue Location markers at the current cursor position.

When the Selector Mode is not active, the Scrub Wheel will scrub the MT cursor position forward and
backward on the timeline. The LCD displays the current time position in all timeline display modes. When
the Selector Mode is active (the Punch button), it will select various control types for display and
adjustment. Used with the Shift key, it will actually adjust the current control type.

The transport Rewind button will move the cursor position back 10 secs on the timeline. This function will
auto locate the playback if active. Used with the Shift key, it will jump to the session Home position.

The transport Fast Forward button will move the cursor forward 10 secs on the timeline. This function will
auto locate the playback if active. Used with the Shift key, it will jump to the session End position.

The transport Stop button stops playback, record and Live Input operations. Used with the Shift key, it will
Save and Update the session edl. When a message dialog box is active, this key acts as a Cancel or No
answer.

The transport Play button starts MT Play or SRP play operations. Used with the Shift key, it starts an MT



Play PreLoad operation. When a message dialog box is active, this key acts as an OK, YES or Enter answer.
The FootSwitch Jack emulates this button.

The transport Record button starts an MT Record operation. Used with the Shift key, it starts a RecRdy
operation.

* Modified the older Midi Controller templates to control Return and Output channels when using the
Navigation Link Mixer Views To Hardware Controller option under the Mixer Menu.

* Enhanced the DWave engine to handle 1 buffer at 64 samples with much more stablity than before and even
be able to do 1 buffer settings on systems that could not do it before.

* Updated the Native Plugin API with a new function that allows a plugin to request the current TempoMap
information.

* Patch Views will now remain on their current tracks when switching to the Video or Control Track in the
MultiTrack.

* A new option has been added to the Library View File popup menu called Insert Selected To MultiTrack.
This option inserts the current Library Entry to the MultiTrack at the cursor position and overwrites any
underlying regions. This function can be activated by pressing Shift-Insert also when the Library View is the
active window.

Bug Fixes
* Modified Shutdown code to fix potential crashes when Region Memory Caching is actively loading data

during a program exit.

* Jumping to different module types with the I, R and O zones no longer freezes the meter on a locked Zoom
Mixer module.

* Canceling an ASIO Preload and then restarting playback will no longer playback at the wrong speed.

* In the SoundFile View, the Ctrl-Up-Arrow or Ctrl-Dn-Arrow now correctly resets any display vertical offset,
even if the offset is maxed to its limit.

* Fixed the SF View from following the MT Zero Locate setting.

* Fixed a problem with the Hi-Cut and Lo-Cut EQ filters which could cause them to change values internally
when starting playback in Offset Mode, thereby changing the mix between the two modes.

* System crashes caused by linking and inserting Library view file entries with extremely long filenames has
been fixed.

* Trapped for accidental Retake corruption. Anytime record settings that affect record files are altered, the
Retake flag is now cleared to block accidental retakes that may affect the wrong files.



* The Smpte/Midi Menu, Midi Control-In Active and Midi Control-Out Active options now correctly remain
off when an attempt to open the midi ports fails.

* Modified the VST TimeInfo code to help solve some problems with certain Tempo driven VST synth
plugins.

* Fixed issues with multiple out assigns and input tracks containing region data that would cause buffer
underrun errors when trying to initiate Live, Rec Rdy or Rec Mode, but would be fine in SRP or Play Mode.

* Fixed FX API Solo control to allow plugins to set solos on all Channel types. This now fixes the Levelizer
Key Listen switch for Return and Output Tracks.

* Fixed SF waveform drawing which would cause zero data value pixels to remain behind on the display
when using the vertical centerline shift feature.

* Code has been modified to leave the MT Cursor position untouched when aborting from certain Region
Insert operations that warn of a conflict.

* Fixed the SF Rec button display to update correctly when views change and the SF Record Meters are
active.

>---<

Version 3.9d
Enhancements
* Added a new feature to the MultiTrack Insert Key command. Using the Alt-Insert Key in the MT now

inserts the currently selected Region View region to the current HotTrack at the MT cursor position and
overwrites any existing data. If Automation Mode is active, then existing automation data is preserved.

* Added TimeLine support for Smpte 23.976 HD video.

* Added a new WheelMouse function to the MultiTrack and SoundFile View. Pressing the Ctrl Key with the
WheelMouse will now operate the waveform vertical scaling function.

* The I, R and O Jump To Channel zones have been enhanced to eliminate jumping to blank module sections
on the Return and Output channels. Whenever you jump to a different module type, the vertical offset is now
adjusted to display the fader section of the module.

* Changed these info files to .rtf format for compatibility with the newer XP Service Pack 2 WordPad installs.
The .rtf format is still compatible with older WordPad versions even back to NT.

* Pressing the T-Key in the SoundFile View will now transfer focus back to the MultiTrack window. If a
region transfer from the MT was active, then the cursor position in the MT will be updated to match the
current SF cursor position.



Video Track Viewer Version 2.7b
* Added TimeLine support for Smpte 23.976 HD video.

Bug Fixes
* Modified the Asio engine to correct for compatibility issues with some newer soundcard drivers. (M-Audio

and DigiDesign products).

* Fixed Live Insert Fx patches from causing following Fx plugs to stop functioning.

* In Select Mode, the Left/Right Arrow snap/nudge function now creates an undo.

* Fixed Video Track entry snapping and moving to grid… grid calculation precision has been improved with
new conversion routines.

* Fixed DirX and VST Plugin FX Bypass switches so they now correctly display the current status when first
opening the plugin window when automation entries have been written that alter the bypass settings.

>---<

Version 3.9c
Enhancements
* The Exploded Mixer View is now dual monitor aware. When popped up from within the Full Mixer View it

will maintain its position within the Full Mixer View even when that view is on the second monitor of a
dual monitor configuration.

* The Record Meters are now dual monitor aware and will look to the right edge of the Main Window for its
right-edge detection. If you stretch the Main Window background across both monitors, the record meters
will now operate correctly on the second monitor or can be stretched across both monitors.

* DirectX and VST windows are now dual monitor aware and will look to the right edge of the Main Window
for its right-edge detection. If you stretch the Main Window background across both monitors, DirectX and
VST plugin windows can be placed on the second monitor and will retain their positions correctly when the
session edl is re-opened.

* Popup mixer control faders are now dual monitor aware and will look to the right edge of the Main Window
for its right-edge detection. If you stretch the Main Window background across both monitors, these faders
will retain their positions correctly even in mixer views placed on the second monitor.

* The Zoom Mixer Locking feature has been enhanced. Shift-Right-Clicking in the Close Button zone of the
Zoom Mixer will lock the view from channel chasing and vertical chasing when using the MT Left Client
vertical hot zones. This mode displays two vertical red lines in the padlock display of the Close Button zone.

* The build mix routine performance has been enhanced to speed up the process by about 10% – 15%.



* The Ctrl-Tab and Ctrl-Shift-Tab keys are now active in the Wave Automation Display mode as well as full
Automation Mode.

Bug Fixes
* The File View Delete Files function now displays a warning message when video or midi files are selected

for deletion.

* Adjusted code to fix inversed MT Track Labels from randomly not clearing correctly.

* Fixed Record Template code to maintain track offsets and source assigns in record templates where
individual tracks are removed from an existing record template and a new one created.

* Fixed the Exploded Mixer View Compressor Gain Reduction Meter to now display properly at all E-Mixer
positions and offsets.

>---<

Version 3.9b
Enhancements
* Two new options have been added to the MultiTrack Menu called Disable Right-Mouse-Btn Engine Toggle

and Disable SpaceBar/Return Engine Toggle. These options can be used to lockout the mouse and/or
keyboard engine toggle commands so that during critical recording or Live Mode sessions, you cannot
accidentally toggle the engine to stop by pressing the Right Mouse Button or SpaceBar or Return keys. You
will be forced to use the play and stop buttons on the MultiTrack or use the SRP, REC or Stop buttons on
the Record Remote panel. These options may be saved with preferences, but realize that if both of these
options are left active, you will loose some editing playback capabilities in certain views like the Regions,
Library, Show Control, etc.

* A new enhancement has been added to the MT display. Right-Clicking on the Wv button or pressing the Alt-
W-Key now toggles a display mode that shows automation entries dimmed overtop of the waveform normal
display. This allows you to see automation entries while still being free to make control adjustments without
actually writing automation data. A red outline around the Wv button indicates that this special view mode
is active. When the normal Automation mode is engaged, the automation entries will display in full color
over the dimmed waveform display and automation writing will be engaged as normal.

* Relative Time display is now active while dragging in the Timeline Ruler area when in Select Mode.

* The Library Import feature has been enhanced to allow marked boundary SoundFile adjustments to override
the original Region boundary marks. If you double-click a Library EDL Region into the SoundFile View and
then adjust the marks to a smaller or larger segment, the new marked area will be the area used when using
the import function to bring the data into the current session.

* Two new options have been added to the File View Options Menu called RePath Selected Entries Only and



ReName Selected Entries Only. These options allow you to modify the paths or names of the EDL file
entries without modifying or altering any of the actual files on disk. This option then requires that you move
or modify the files in question yourself. This option will warn you of any missing files directly after you
alter the paths or names, if you have not already moved or renamed the proper files before changing the links
in the session EDL. These options only change the links in the EDL.

* A new enhancement has been added for MT playback of selected tracks. You may now select playback
tracks by Alt-Left-Clicking on the Track Label. The label will inverse. You may Alt-Drag the mouse to
continue selecting and the MT will scroll up or down. Alt-Left-Clicking a selected Label will un-select it.
Alt-Right-Clicking any Label will un-select them all. This works the same as the selected Track Number
function without causing group MT edits. The cpu load is reduced during these special playback modes
because only the selected tracks are loaded into the engine loop, all other track data is completely ignored.
The BuildMix function will respond to this track selection also as it does with selected Track Numbers. You
may also use this function with preset groups available from the Right-Click on the MT TitleBar. When
selecting a group from the popup menu, press the Alt-Key to select this special Label group instead of a
Track Number group.

* A small enhancement has been added to the Library Link option when in soundfile directory mode. The
filename now ignores the file extension and uses just the name portion of the filename as the region name
base.

Bug Fixes
* Increased the internal work buffers size to accommodate for the ever increasing parameter storage

requirements of newer VST and DirectX plugins.

* The Aux Master Pans have been fixed when adjusting live.

* The Hi-Res SampleRate Conversion routines have been fixed to maintain proper sync in sessions which use
multiple vari-pitched regions along the timeline.

* Alt-Drag to create and drop a new region from existing data on the MT now correctly responds to both
SampleRate and Vari-Pitch when displaying the new region ghosted drop length.

>---<

Version 3.9a
Enhancements
* Enhanced the Locate Point feature by adding the use of the NumPad keys to jump to the first 10 Locate

Points. Pressing Alt-NumPad-Key 1-9 will jump to Locate Points 1-9. Pressing Alt-NumPad-Key 0 will
jump to Locate Point 10. The use of the NumPad keys for zoom are still intact and the use of the Ctrl-
NumPad keys to adjust waveform vertical scaling are also still intact.

* Increased the accuracy of the meter data collection routines to check every data sample for clipping. This
now guarantees that peak display lights will catch even a single clipped sample rather than a previously



required 4 sample overage. This does increase cpu load slightly, but hopefully will not cause any problems.
The increased display accuracy should be worth the trade-off.

* Moving and copying MT-entries has been enhanced to allow a forced insert mode. When grabbing and
moving MT-Entries, you can force an insert and overwrite condition for conflicting entries at the destination
by pressing the Alt-Key as you release the mouse to finish the move. Normally the entry conflict will cause
the moved entry to snap and butt-splice to the front or back of the conflicting entry, depending on the
overlap condition.

* Enhanced Host/Slave code to pass the Shift parameter for starting MT playback and forcing all active
channel device assignments back to the MT.

* Enhanced Host/Slave code to pass solos in both directions to force a clean solo of the combined Host/Slave
mix when a solo is engaged on either the Host or Slave machines.

Bug Fixes
* Fixed the Extract Session routine to properly handle duplicate regions.

* Fixed a possible crash bug in the new eq code introduced in 3.9.

* Extended work buffer sizes even larger to correct for some of the new VST plugins that extremely large
buffer storage requirements for their parameter settings.

* Fixed marked area display from disappearing after changing to a new Shade.

* Adjusted code to properly maintain compressor release values when dynamically raising compression
threshold during playback.

* Fixed code to stop crashes in the Save And Trim operation when using mixed samplerates.

* Fixed the Recent SoundFile List to loop back around after removing an item using the Shift-Left-Click
option.

* Fixed crashes that could occur with grid cursor snapping across time signature changes less than quarter note
denominators.

Eq PlugIn Module Version 1.9
* Corrected code that could cause track changing commands (arrow keys, wheel mouse etc) in the MT to stop

working when the plugin is displayed with multiple plugins patched.

Video Track Viewer Version 2.7a
* Fixed Bitmap rendering to the overlay.

>---<



Version 3.9
Enhancements
* Added VST Time Info support for tempo syncing VST synth plugins to the TimeLine.

* Added the ability to read 32 bit floating point wav files directly and also expanded the wav parser code to
accept the same basic SAWStudio wav formats that have been saved with the new Microsoft “Extensible”
flag, by other programs.

* Added the ability to read 16, 20, and 24 bit mono and stereo .aif and .aiff files directly.

* The File View has been enhanced. The RePath and ReName File Entry features now actually re-locate
and/or rename the actual files also, and automatically saves and updates the session when closing the File
View window.

* A slight change has been made to import and auto-drag-and-drop region names. The brackets and file
extension are no longer included when default region names are created from existing filenames.

* A new option has been added to the File Menu called Extract Session. This option offers a sub-menu of
varying Region Handle sizes just like the Save and Trim Session. This option will extract all components of
a session from the Mark Begin to the Mark End position (or the entire session if there is no marked area)
into a new session folder and edl file. You will be prompted to include all layers or not. All active file
sections for each track will be re-written into new track files, labeled with the new session name and track
label. Regions within the marked area will remain intact. All remaining Sequence entries outside the marked
area or included layers will be removed and the new session will be opened at completion. The Sequence
Entries will be left in their original timeline positions, in case there might be Smpte references that need to
be retained. You can simply mark the data and use the Slip Track function for all tracks to snap the data to
the front of the timeline if desired in the new edl. This is designed with the original intent of extracting
separate and named song edls from a single long live recording session which was forced to be placed into
one giant session because there was no time to break and create separate edls for each song during the live
performance. Of course, I’m sure many other uses for this feature will come to mind for the creative
engineer. I recommend doing the session extractions before you begin editing and automating the original
session, which will then start each new edl out with a single region and file for each track, properly labeled
with the session name and track label. You may wish to setup a basic starting mix with eq and compression
and reverb plugs and so forth, before the extractions, which will then carry this starting setup into each new
edl as a starting point. This feature also has the added benefit that it can help clean up the intense amount of
disk fragmentation that can occur when recording 24 or more live files at once, due to the fact that the files
are all being written in small noncontiguous blocks. The new files are written 1 file at a time and can end up
being much less fragmented, which improves playback as you start building dense mixes with lots of
processing.

* The Master/Slave relationship has been enhanced to properly handle SRP and Record Mode sync.

* Extended the A-Key (Automation Mode Toggle) and the O-Key (Offset Mode Toggle) to all mixer views.

* Enhanced the Wide Mixer View to allow stable placement on the secondary monitor of a dual monitor
configuration.



* The popup Locate Menu has been enhanced. You can now Set, Clear and Rename Locate Points from the
popup menu. You can also use Shift-Click to set a point directly or Ctrl-Click to clear a point directly. When
setting a point, the Name Dialog now automatically pops up to facilitate setting and naming in one quick
operation. You may set and name live during playback. Locate points now display the position in the current
timeline format.

* Enhanced the Cue Location feature. The Cue Location dialogs will now popup even when playback is
active. The dialog has been enhanced to accept keystrokes for the Name (N-Key), Parameter Data (P-Key),
Midi Trigger (T-Key), and Midi Note On/Off (O-Key). This will help speed up live-on-the-fly Cue Location
entries.

* New code has been added to activate a complete forced Engine Shutdown to hopefully allow you to recover
from most driver or audio engine lockup conditions. Pressing the Break-Key (labeled Pause on many
keyboards) will force all engine threads to shutdown in sequence to break the engine out of a locked play
loop. A Forced Engine Shutdown message will display on the screen while the program attempts to reset the
threads to a stable condition. If the engine is in a locked play condition and you attempt to stop multiple
times back to back, it will force this Shutdown routine into action also.

* Default settings for the Aux Sends and the XY Center and XY Sub have been altered to drop to inf.

* Active Control ReadOut Zones have been enhanced for quicker control operation. Many controls that
required the push/pull scrolling operation for adjusting the control settings will now popup a variable sized
fader for instant and direct adjustment with a fader knob. The fader will adjust its length to fit the exact
number of parameter values available for the control. When you release the mouse, the fader will disappear.
The fader will popup to the right of the control zone to allow the readout to be used as a visible reference
while you adjust the value. The mouse will automatically jump to the current fader position and return back
to its original position when the fader disappears. Control zones that already have an associated built-in
fader will continue to operate in the original push/pull fashion if grabbed in the ReadOut zone area.

* MultiTrack Tab will now function in Live Input Mode.

* A new option has been added to the Mixer Menu called Mixer Hot Channel Color. This option allows you to
set the Mixer Hot Chan display color by designating an RGB color. Use your favorite Windows graphics
program color picker chart and find the RGB values for your color choice. Enter these three values,
separated by commas into this option to change the color of the highlite bars that display the Mixer Hot
Channel. This value saves with the preferences.

* Enhanced some of the device assignment error messages to designate the troubled device or track, which
should help when chasing down assignment problems.

* A new enhancement has been added to Automation Mode. Right-Clicking the Aut button displays a popup
filter menu of every automation data type. Selecting one of these options sets the View Filter On for that
data type. If the View Filter is active when displaying this menu, the current filter data type will be checked.
A special feature allows all Fx PlugIn automation data types to be shown at once if the cursor position is not
directly behind an Fx automation data type when selecting this option. If the last tracked data type is an Fx
automation type, only that specific type will be displayed.



* A new option has been added to the Automation Menu called Disable Automation. This option allows you to
disable all automation and reset all channel controls back to the starting default condition. This can be used
live during playback for comparison purposes also. You can also activate this option by pressing the Shift-A-
Key or by holding the Shift-Key down while Left-Clicking the Aut button.

* The L-Key Live Mode Toggle has been extended to work in the MultiTrack View also.

* A new option has been added to the Driver Model submenu called Record LoopBack Latency Adjust. This
option can be used to compensate for latency values resulting from a loopback recording through your
soundcard and converter chain. You can test and set this option by playing back a single track of transient
audio material, like a drum track, and looping the playback signal around and back to the soundcard inputs
and recording the same signal on the adjacent track. In an ideal situation, the two signals should line up
perfectly when looked at in a zoomed in display. In reality you will probably see the recorded signal is late
by a certain number of samples. You can zoom in and mark the difference between two identical transients,
set the timeline to sample mode and notice the value in the Marked Area readout display. Set this value into
this Latency Adjust option and then try the test again. Adjust this value so that the resulting recordings are
perfectly lined up. You should then be able to change buffer sizes and not affect the accuracy of the
recordings. If you change external converters or soundcards or even driver models, you should reset this
value, or set it back to zero. If set incorrectly, you could actually cause the resulting recordings to be placed
in front of the original source material and mess up recording sync. It is arguable whether this test is an
acurate representation of real recording sync for live overdubbing, but the option is here if you are so
inclined to use it. If not interested in using it, make sure to set the value to zero.

* The Phase Switch has been enhanced to now include phase reversal on both channels of a stereo track or just
the Left or Right channels only. Left-Clicking to the left of the switch itself will display a popup menu of
choices. This can be real useful when a stereo file contains left and right signals that are out of phase.
Playing such a file in mono will cause the signal to cancel badly. Using the Left Only or Right Only phase
reverse can instantly solve this problem.

Video Track Viewer Version 2.7
* Added special routines to detect and use the MainConcept Mpeg codecs and Ulead Mpeg Codecs for

decoding mpeg2 formats, and the CyberLink QuickTime DirectShow Source Filter, from the QuickTime
alternative program files, to help decode numerous QuickTime formats directly in the viewer. Be careful
with all of these special formats though, seek times can be very slow on slower machines.

* Modified code to allow the Conversion routines to detect and handle the new codec formats added above.

* Added code to access multiple firewire devices with the same name. This can happen when multiple devices
show up in the firewire device list as the generic Microsoft DV Camera And VCR device.

* Modifed the overlay code used to adjust for changes in Dx 9 that can cause overlay output to lock to
hardware clocks slowing frame rates internally down to exact hardware output speeds. For example, on my
test machine, DV-avi NTSC output in DX 9 and Windows XP using a Matrox P750 Parhelia video card
has been slowed to 33ms per frame in the running seek test when the overlay render is active. The new code
brings that down to 6ms per frame on the same machine. Quite a difference by bypassing the use of generic
Windows DirectShow filters. Overlays are tricky and very video card, OS and DX version dependent. For
example, the same machine with an ATI Radeon 9600 video card displays results of 16ms per frame, down



from 33ms per frame for the old code. Both video cards display 4ms per frame with the overlay turned OFF.
This new code also allows any open video file to be rendered externally to the overlay. The old code limited
overlay output to only DV-avi format files.

* A new option has been added to the Options Menu called Overlay Render Size. This option controls the size
of the internal overlay renders with the new code. Using larger sizes can improve overlay output quality, at
the expense of more cpu time. Using exact sizes as the source video can generally give the best combination
of quality and speed results. The default size of 360 x 240 (Half DV size) usually delivers good results. If
you are using PAL, select the Half DV PAL size of 360 x 288. A great compromise for speed and quality
can be achieved on DV-avi files by using the full DV decoder resolution with the half Overlay Render Size.

Bug Fixes
* Trapped Plugin param data buffers that are larger than the internal max buffer size from crashing edls and

Mix Templates.

* Modified routines to allow patching plugins live during playback that are slow to initialize without causing
buffer overruns or crashes. This fix should allow even the bulkiest and slowest plugins to patch live during
playback with no trouble.

* Modified code to help popup ASIO control panels for certain ASIO drivers that would not react to
SAWStudio’s ASIO Driver Setup function.

* Corrected code that could cause sustained waveforms to cut off prematurely under certain buffering
conditions and certain eq settings. This fixes pops and clicks that could be caused by that condition.

* Adjusted code to handle auto stopping at the end of the session even if there are channels that are unassigned
to a valid output.

* Fixed MT Cursor from disappearing after moving the MultiTrack window.

* Adjusted Dual Monitor Dialog/Msg Box positioning to keep dialogs from starting offscreen.

* Eliminated crashes that could occur when grabbing knob controls when the top range of knob motion is off
the top of the channel view by trapping the ability to grab the knob under these conditions.

* Recall Dynamics From Memory Cell now correctly sets the Reverse Gate switch.

* Saving and recalling Record Meter Templates will now work correctly even with re-ordered tracks in the
MultiTrack.

* The Automation display is now correctly updated when using the R command to split and remove MT entry
data that may have contained automation entries.

* Fixed code to properly draw region waveform displays with active softedges when Region Memory Caching
is turned ON.

Eq PlugIn Module Version 1.8



* Corrected code that could cause sustained waveforms to cut off prematurely under certain buffering
conditions and certain eq settings. This fixes pops and clicks that could be caused by that condition.

Video Track Viewer Version 2.7
* Corrected code to fix capture problems with Type 1 DV files.

>---<

Version 3.8a
Enhancements
* The Dynamics Gate Threshold, Gate Floor and Compressor Threshold waveform display reference lines

have been enhanced to track the Input Attenuator control for the channel that is keying the dynamics data.
Even though the waveform display itself does not change in regards to the Attenuator control, the reference
lines are now properly offset to display the an accurate reference to the full scale waveform data.

* A new option has been added to the FX Choices View Group menu called Set Cur Group As Default. This
option displays the current default group and will change it to the currently active group when selected. The
default group will be the active group when the program first starts.

Bug Fixes
* Trapped record activation with open record meters not assigned to legitimate input devices.

* Fixed Show Control column lineup of the Filename information in the listbox..

* Stopped the SnapShot Undo command from clearing the EDL Modify flag, so the prompt to save modified
sessions would work correctly when changing sessions or exiting the program with un-saved session
changes.

* Closing a session now correctly resets the Midi WorkShop default tempo.

* The Control Track Cue Location / PreLoad and Cue Location / Play commands are now correctly accepted
as plain Cue Location commands when used following any of the Stop / Cue Next commands.

* The Clr button in the Pre and Pst FX patch views now correctly responds to selected Mixer Channels instead
of selected MT Tracks. This is considered a mixer function rather than a MT function. The mouse cursor
will now display CHN as the cursor is moved over the Pre and Pst Client top area to reflect the fact that
mixer channels are selected.

* Recalling Fx from a memory cell or clearing the current mixer chan will no longer respond incorrectly to
selected MT Tracks, causing Fx clearing on those extra tracks.

* Fixed the Library View Right-Click in the Top Client Area to toggle playback, which was broken by the
code to toggle Library Lock mode on and off.



* Fixed the Corrupted Region message from falsely popping up during layer copies under certain conditions.

* Adjustments made to keep the SoundFile view from popping up on top of other windows when using the
BuildMix To HotTrack function and there is an active soundfile already opened.

* Adjusted code to fix multiple selected tracks layer switching which include video track layers. The video
layer, if also selected, will now correctly switch even if your hottrack is one of the selected audio tracks.

Video Track Viewer Version 2.6
* Corrected code to maintain image file lengths after they have been stretched and reloaded..

>---<

Version 3.8
Enhancements
* A new option has been added to the MultiTrack Menu called Record-Mark Display. When this option is

active and MultiTrack Record is engaged, each record track will display a growing red mark area
designating the actual record region areas. These areas will be replaced by the recorded regions when record
is disengaged.

* The File Read routines have been enhanced to accept a full DWORD position rather than the half Signed
DWORD position. Max file lengths that can be correctly handled have now been doubled.

* The MT Load display has been increased in resolution for a more accurate result at very small buffer sizes.
The readout display flickering has been smoothed to remain a little more stable between large value shifts.

* A new enhancement has been added to Select Mode moves and copies. If the Control Track is selected, any
audio or video selected entry moves or copies will now include all Control Track entries within the range of
selected entries from the earliest start position to the latest end position.

* A new enhancement has been added to adjusting MT-Entry boundaries. When using the Alt-Drag or the U-
Key methods, adjusting MT-Entry boundaries will now function on all selected tracks, for a quick multiple
track manipulation of splice points. Be careful that all selected tracks have associated entry boundaries at the
adjustment point, or you may obtain unexpected results on certain tracks.

* A new enhancement has been added to the X-Key softedge crossfade feature. This function will now operate
on all selected tracks. Be careful that all selected tracks have associated entry boundaries at the cursor point,
or you may obtain unexpected results on certain tracks.

* Live Layer Switching during playback has been extended to the Return and Output Tracks. The new layers
must have automation entries in order for the switch to occur.

* The copy layer submenus now display the <> marks to show which layers have data already on them.



* The Drag And Drop Region and Library entries function has been enhanced to properly handle horizontal
and vertical scrolling in the MT by using the Right-Hold Horz/Vert Scroll Modes, and zooms.

* The Drag And Drop Region and Library entries function has been enhanced to allow the entry to cut into
and insert itself over the top of existing entries at the drop position by Shift-Left-Clicking to drop the entry. If
Automation Display Mode is active, current automation entries at the insert position will not be disturbed,
otherwise, automation entries at the insert position will be cleared.

* A new feature has been added to the Library Views. Right-Clicking in the Close zone of any Library view
window will now toggle Library Lock Mode for that window. Only one Library view window may be locked
at a time. If Lock Mode is active, the use of the Insert-Key in the MT when the MT is the active window will
now default to inserting the locked Library view currently selected entry, instead of the currently selected
region from the Regions view.

* The Build Mix dialog window now responds to the Enter-Key for OK and the Escape-Key for Cancel.

* Two new Dither options have been added to the MultiTrack Dither Menu called NonCorrelated L/R and
Random. The NonCorrelated option causes different noise patterns of the selected type to be applied to the
Left and Right channels. Many suggest that this can help keep the stereo field more intact in the final mix
when using Dither and reducing bit resolution. The Random option takes this a step further and randomizes
the noise pattern with every buffer process, such that repetition of the applied noise pattern is much less
frequent. These options may be applied individually or together. Both of these options are global and save
with the preferences. These options do not save with individual edls.

* A new enhancement has been added to the Compressor and Gate Threshold Display Lines. If the channel has
a Key set to another channel, the Threshold Display Lines will display on the Key Channel for accurate
reference to what is actually keying the dynamics.

* The Blend Session function has been enhanced to now include Control Track data.

* The Blend Session function has been enhanced to now include Video Track data.

* The Shift-BackSpace key may now be used in Automation Mode to snap the back end of marked automation
entries to the cursor position.

* A new option has been added to the Control Track Built-In Commands list called Cue Beginning / Play.
This command loops back to the beginning and initiates playback immediately.

* A new view called Show Control View has been activated on the View Menu. This view offers features for
playlist style operation. The Show Control view resides outside of the session edls and actually allows lists
of independent edls to be controlled in a sequential or non sequential playback arrangement. Place the view
in an F-Key workspace where no other views overlap and from this view you can control an entire show of
independent edls.

The view is basically a listbox where you can add session edl entries in a specific order. Each entry may
have a Continue option and a Midi Trigger option that controls the playback flow of the list at that point.



The view contains a blue pyramid logo that will display the Show Control Options popup menu when
clicked. The Show light displays when playback is currently being controlled in Show Playback mode.

The options menu contains the following options:

Open Show Control File – This option opens a pre-saved Show Control file containing the list of edls with
all Show Control options. The file extension is .shw. Opening a Show Control file loads all entries and
settings into the listbox and opens the first edl in the list, ready for playback.

Close Show Control File – This option closes an open Show Control file. If unsaved changes have been
made to the current file entries, you will be prompted to save the file before closing.

Save And Update Show Control File – This option saves and updates the current Show Control file
without prompting, unless the current file has not yet been named.

Save Show Control File As... – This option prompts for a new name and saves the current file to that new
filename. The new file now becomes the current working Show Control file.

Save Show Control File Copy As... – This option prompts for a new name and saves the current file to that
new filename. The current file remains as the current working Show Control file.

Add New Session Entry {Ins} – This option opens a new edl session file and adds the session to the
listbox. The entry dialog box is displayed for you to set the entry options. You may edit the name of the
entry as it will appear in the list. You can also set the Continue option to one of three values; Yes – means to
continue on to the next entry when this session finishes playing; PreLoad – means to continue to the next
entry when this session finishes playing, but PreLoad it only, waiting for a manual play command; No –
means to stop the flow of the list when this session finishes playing. You may also select a Midi Trigger
note for starting playback of this entry. You may select a Midi Trigger note from the popup menu, or press a
key on your midi controller keyboard and choose the last midi note played as your selection. The Note-
On/Off option allows you to choose how the trigger is applied. If set to Note-On, the session will be opened
and playback will start as fast as it can. If set to Note-Off, the session will be opened and PreLoaded, waiting
for the Note-Off signal when you release the midi key to start playback instantly.

Edit Current Session Entry {Alt-Dbl-Click} – This option allows you to edit an entry by displaying the
entry dialog box with all options avaiable for editing. Closing the dialog from the close button in the upper
right corner will cancel any changes.

Midi Receive Trigger Active – This option toggles the ability for Show Control to receive midi trigger data
from the midi ports. This option must be On to trigger from midi data, along with the Midi Control In Active
option on the Smpte/Midi main menu.

Midi Receive Chan – This option sets the Midi receive channel for the Show Control midi trigger.

File Lock Active – This option locks the current Show Control file from being altered. No editing will be
allowed when this option is active.

All of these options save with the Show Control files.



Basic listbox operation includes a few mouse and keyboard controls. You may select multiple entries with
the mouse in standard listbox fashion. The Delete key may be used to delete selected entries. The Insert key
may be used to add new entries. The Spacebar key opens the currently selected entry and begins immediate
playback at the start of the session. The Return/Enter key opens the currently selected entry and PreLoads it
waiting for the playback go command. The Up/Dn arrow keys can be used to select different entries. The
Ctrl-Up/Dn arrow keys can be used to move an entry up or down in the list to a new position. Double-
Clicking an entry will open that session. Alt-Double-Clicking an entry will open that entry for editing. Right-
Clicking an entry will open that entry and begin immediate playback at the start of the session.

Whenever playback is started from the Show Control View, the Show light will display and playback will
flow through the Show Control list according to the Continue options of each entry. You can stop playback
from the Show Control View with the SpaceBar or Enter key or Right-Clicking an entry or Clicking directly
on the Show light. Any of these methods will de-activate Show playback mode and turn off the Show light. If
playback is stopped from any other view or method, Show playback mode will remain active and continue
through the list when the current session plays to its end.

You can use Show Control playback in combination with Control Track options inside each session to setup
some very powerful playback options for theater and production show automation.

Video Track Viewer Version 2.5
* Two new options have been added to the Special Options menu called DV Video Decoder Res = Half and

DV Video Decoder Res = Full. These options allow you to set the DV Video Decoder Resolution. Newer
versions of Windows XP default the resolution to full, which can slow down the DV decoding process quite
a bit and make live rendering to Overlay or FireWire not function properly if your machine is not fast
enough. This option defaults the resolution to half, like Windows 2000. The output video quality is only
slightly degraded, but the performance speed is significantly better. This option saves with the Video
Preferences.

Bug Fixes
* Fixed Record Device lock-outs from clearing in-devices that are assigned to multiple channel modules when

changing the assignment on one of those multiple channel modules.

* Fixed Mix Template to properly open DirectX PlugIns from earlier template files.

* Auto Punch record length is now correctly adjusted when Live Inputs are active.

* Stopped XYPan Mute Nodes from interfering with XY positioning information.

* MT PreLoad operations now correctly maintain the current window focus.

* The SoundFile View is no longer forced ontop after a Build Mix To Current HotTrack operation if it was
not already visible.

* Window focus is now maintained correctly after a SnapShot Session command.



* Copying marked areas to layers will now correctly also copy automation data when the marked area ends
exactly on an MT-Entry boundary.

* Refreshing or deleting entries in the File View Window will no longer clear the warning flag from re-
pathing or re-naming entries.

* The Red OutLine of the Aut button is now correctly redrawn after minimizing the program or when the
screen area is covered and re-exposed for any reason.

* Corrected the Aux Master Send 1 Label from overwriting the MT Video Track label area.

* Adjusted code to correct a possible ClipCursor function call failure in Windows 2K and XP on certain
machines which could cause crashes when grabbing a knob in a window that is not currently the active
window.

* Fixed a sync issue that could occur for following entries when starting playback in an entry’s End-SoftEdge
tail, that happens to extend beyond the end of file for that entry, which is also being vari-pitched or
samplerate converted.

* Fixed code that could cause a flash of the hand cursor at the top of the Zoom, Exploded, or Wide Mixer
View before locking the hand in the control zone, when grabbing any horizontal knob.

* Fixed Host/Slave mode MT PreLoad operation.

* Added code to trap for multiple quick playback start commands while in Host/Slave mode. This should
eliminate possible crashes from rapid mouse clicks during the Slave mode preload cycle.

* Copying Marked Areas to Layers now correctly adjusts for samplerate and vari-pitch.

* SRP Punch-ins with live inputs now correctly maintain sync between mono and stereo sources.

* Device Ins are cleared correctly now when using the Right-Click Set To Default method for Input Channel
Sources and Return Channel Sources.

* Corrupt regions with Memory Region Caching that could be caused with SRP Punch-Outs and live inputs
have been fixed.

* Fixed code to correctly set patched plugins starting automation when playing back using the Automation
View Filter.

* Trapped the Automation View Filter toggle during playback.

* Moving marked automation entries now correctly holds the mark when the screen is scrolled horizontally.

* Moving marked Control Track entries now correctly holds the mark when the screen is scrolled horizontally.

* Slipping a marked track area now correctly holds the mark when the screen is scrolled horizontally.



* Adjusted code in the Echo plugin to correct a possible ClipCursor function call failure in Windows 2K and
XP on certain machines which could cause crashes when grabbing a control.

Video Track Viewer Version 2.5
* Trapped for missing audio devices when opening Edit Mode video. The video will now open correctly

without a link to the audio device.

* PAL video FireWire capture is now fixed.

>---<

Version 3.7b
Enhancements

Bug Fixes
* Fixed Dynamics Compressor problem that could cause distortion at certain combinations of threshold and

ratio settings when using low latency buffer sizes. This fix also delivers more consistency at low latency
buffer sizes.

* Fixed output subgroups from being delayed when live inputs are assigned.

* Fixed Live Returns from loosing sync when preload buffers have been set to 4 or more.

>---<

Version 3.7a
Enhancements
* A new option has been added to the File View window popup Options menu called Delete Selected Entries.

This option will delete file links from the session. If there are any connected Regions and MTEntries, you
will be prompted to continue or not.

* The File View window now places a’#‘ character next to Audio File listings to denote an orphan file in the
session. This is a file link that is not connected to any regions and therefore safe to delete with the above
option.

* The R-Key Split/Remove Left Entry feature has been enhanced with the addition of the Alt-R-Key
Split/Remove Right Entry feature. This splits at the cursor and removes the entry to the right of the cursor
position.

* The D-Key Split/Delete Left Entry feature has been enhanced with the addition of the Alt-D-Key Split/Delete



Right Entry feature. This splits at the cursor and deletes the entry to the right of the cursor position, pulling
all following butt-spliced entries forward.

Bug Fixes
* Fixes memory allocation buildup problem as undos are recalled, created by the parsing undo routine

introduced in 3.7.

* Adjusted the extended delay before shutdown when playback reaches the end of the session in the MT or the
end of the SoundFile in SF caused by the new threading technique changes in version 3.7.

* Fixes SoundFile View file corruption that could occur when re-building mixes to HotTracks with the
destination file open in the SoundFile View.

* Trapped range marking functions in Select Mode that were not supposed to be active when Select Mode was
engaged.

>---<

Version 3.7
Enhancements
* A new breakthrough in the engine threading technique now allows incredible latency perfromance gains.

MME performance with RME Hammerfall cards can now accept 2 x 64 sample buffer settings for awesome
latency results. This modification should also benefit most other soundcard MME performance depending
on driver capabilities. RME ASIO settings will now also function at 1 x 64 on good machines.

* Enhanced the F-Key restore routines to bypass certain Windows functions that were blocking some of my
High Level threads. This results in drastically better performance with less interference at very low latency
settings.

* Enhanced live layer switching during playback. New routines offer much higher performance allowing more
tracks to switch layers live without buffer overrun problems, even at low latencies.

* The undo function has been enhanced to now parse for File, Fx, Video and Midi changes and skip these
sections if possible. This enhances the recall undo performance considerably when VST synths and many
video file filter graphs are part of the session.

* The Return Track Solos have been enhanced to maintain the in-place solo feature while still allowing pre
and pst aux send channel information to reach the return bus. Now you may solo Return tracks and hear the
blend of all aux send information coming through that track.

* A new option has been added to the File View popup menu called ReFresh Selected Entries PeakData Files.
This option will force a peakdata refresh on all selected files. Use this option after first opening an edl file
created outside the SAWStudio environment such as one created from the Edl Convert Pro program. In most



cases, PeakData files are not created by external SAWStudio edl manipulation programs and will need to be
created in SAWStudio in order to see waveform data in the MultiTrack under most zoom conditions.

* A new feature has been added to the Exploded, Zoom and Wide Mixer views. Left-Clicking in any of the
non-active areas of the Aux Send section of the modules will popup a list of the Aux Send Labels for
reference. You may Left-Click anywhere in the menu to close it. No action will be taken, the list is for
reference only.

* A new option has been added to the Mixer menu called Link Mixer V-Offset To F-Keys. When this option is
ON, the Exploded Mixer and Zoom Mixer response to F-Keys remains as it has always defaulted in past
versions. The vertical offset position along the module is linked and restored with the F-Keys. When this
new option is OFF, the vertical offset is ignored when F-Keys are restored and the modules will remain in
their current section position, for example, if you are scrolled to the EQ section, now jumping to other F-
Key views will leave the Zoom and Exploded Mixers still at the EQ section. The vertical offset position will
always be saved with new F-Keys, but ignored during the restore when this option is OFF.

* Removed the ONTOP status of the Exploded Mixer view so it would not interfere with the Midi Workhop
and other displays.

* Added Asio support for Smpte Generate.

* Re-activated and corrected Waveform Threshold display lines for Dynamics in Automation Mode.

* Record Meter Peaks may now be cleared by Left-Clicking anywhere in the meter LED display area.

* Control Track Cue switching is now active during Live Input Mode. This allows preset automation entries to
be set along the timeline and jumped to when using the virtual console as a live PA console. Cue entries can
set for each song or song segments and you now have the ability for unlimited snapshop automation recall.

Video Track Viewer Version 2.4
* Video Viewer modifications to take advantage of the undo parsing which will only close and rebuild file

filtergraphs when needed.

Bug Fixes
* Fixed crash that could occurr when Right-Clicking a region from the Regions View which had no peakdata

file. The peakdata file is now correctly built before the region playback begins.

* SoundFile View Recording Level is now correctly defaulted to zero db.

* Fixed code that could cause a playback crash under certain conditions when all Input, Return, or Output
tracks were assigned in a mix.

* Trapped illegal assignment and XYPan switches from getting placed into the automation database when
using the Blend Session function.

* Edl sessions are now automatically scanned when opened to strip illegal automation data and also reorder



the position information properly.

* Fixed a problem which caused all TopMost windows to change to Non TopMost when canceling one VST
window’s TopMost flag.

* Modified code to allow a hidden Non TopMost VST window to be brought to the top by Double-Clicking
it’s entry in the Fx Patch views.

* Fixed code to send TempoMap Sequential Measure Change info correctly to Fx plugins and the Midi
WorkShop.

* Current tempo information is now correctly updated in the Midi WorkShop every time Tempo TimeLine
Mode is engaged.

* Fixed crash that could occur under certain conditions when doing video slip and move track operations.
Also trapped these operations from creating multiple undo entries when combined with audio tracks.

* HotTrack Solo mode is now switching correctly when using the I, R, and O zones.

* HotTrack Solo mode now correctly clears when closing a session or opening a new session.

>---<

Version 3.6c
Enhancements
* Modified the buffer flush routine for VST plug-ins to improve engine stop time for certain VST plug-ins.

Also included the cursor change to the waiting icon while the buffers are flushed.

Bug Fixes
* Fixed code for buildmix operations which use the hi-res SampleRate Conversion routines to stop

compatibility interactions with certain patched plug-ins that use the floating point processor. This fixes
buildmix operations that would cause maxed-out results in the mix file.

* Blocked Threshold lines from displaying in the MultiTrack View when Automation Mode is active.

* Fixed a small problem that could cause crashes with certain plug-ins when storing active settings to a
memory cell.

>---<

Version 3.6b
Enhancements
* Slowed down the mixer settings scrolling adjustment mode to be less sensitive to small mouse changes



resulting in an overall feeling of more control.

* The SRP/Rec latch operation has been enhanced to automatically detect a marked area and override the latch
function for auto punch-in at the marked area.

Bug Fixes
* Adjusted SRP punch-in code to help eliminate Record Buffer Overruns under certain conditions on certain

systems.

>---<

Version 3.6a
Enhancements

Bug Fixes
* Fixed code that was broken by the change in 3.6 to link the video entries to MT entry moves and copies. The

problem would show up in as false entry conflict messages and copies to different tracks that were not
correctly aligned.

>---<

Version 3.6
Enhancements
* The Input zone on the Record Meters has been enhanced with two new options. Adjust Input Level and Reset

Input Level. These options can be used to adjust the actual signal level of the recorded data on the way to the
harddrive. Even the level of digital input sources can be adjusted here. Both of these options are available
while recording is active or inactive. If you change a record meter to another track by using the popup Track
zone, the current input level will be transferred to the new track. If you Shift-Left-Click any record button to
clear input assignments back to default, all input levels will be reset also.

* Track and Mixer Chan Labels may be entered now even while playback is active. If Record Meters are open,
the engine must be stopped to enter labels due to the already opened and linked record files.

* Pressing the Alt-B-Key or Alt-E-Key will mark an entire MT Entry including its softedges.

* MT Automation Entries will now maintain their relative positions within a Vari-Pitched entry if the VP
Factor is later changed.

* A new option has been added to the Options Menu called Auto Record/SRP Latch. When this option is
activated, clicking the SRP button will also latch and engage the Rec button. Pressing the Shift-Key when
engaging the SRP button will overrdie this option. When this option is not engaged, the SRP button works
independently UNLESS the Shift-Key is also pressed. This option saves with the preferences.



* The BuildMix To Current HotTrack has been enhanced to add the destination track label or track number to
the default output files.

* Added Soft Clipping Detection into the Hi-Res SRC algorithm to eliminate wrap-around clipping problems
when using the Levelizer near max percentages with the Hi-Res SampleRate conversion.

* A new option has been added to the Control Track Options Menu called Output Bypass. When this option is
selected, all Control Track output data is suppressed and. the listbox will display as dark gray. The listbox
will still chase current entries and can be still be used for Cue Location points.

* Opening a session with an attached Library edl that has pathing problems will now notify you in the warning
dialog that the problem is in the Library session as opposed to the main edl session.

* A new option has been added to the Library File Menu called Lock All Library Windows. When this option
is activated, closing a session will not clear the current Library windows. You may now open a new session
that does not contain Library data and merge the current Library links directly into that new session. If the
new session already contains its own Library data links, you will be prompted to clear the lock and load the
new data, or not.

* Using Select Mode with video entries has been enhanced. Whenever selected entries include video entries,
video and audio will moved together, regardless of which type of entry is grabbed. Both types of entries will
contribute to movement limits resulting from bumping into other nearby entries. All movements will be
forced to frame boundaries to maintain proper video entry placement.

* Video entries have now been included in the slip track functions, including the all layer slip track function.

Bug Fixes
* Fixed the code to trap certain problems that could occur when opening complex SAWStudio sessions into

StudioLite.

* Library Views will no longer clear open Libraries when selecting the Open Edl Library or Open Diectory Of
Wav Files prompt if you cancel the operation from the Open File Diaolg.

* Placed a trap into the Control Track Handler that should help eliminate crash problems under certain
conditions when stopping directly on a Control Track entry.

* Fixed Crash that could occur under certain conditions when using the Shift-Home-Key function in Select
Mode.

* Modified punch-in routine to maintain track sync when recording multiple tracks from virtual console
channels as inputs.

Video Track Viewer Version 2.3
* Video Viewer modifications to correct PAL render to firewire issues on some systems with XP.



>---<

Version 3.5
Enhancements
* The Exploded Mixer View now responds to F-Keys. This allows the E-Mixer to be controlled more easily

for SAWStudioLite. The view may now be set to be visible or not based on F-Keys. It may also be set to
default to a visible condition based on the default F-Key setup.

* VST Synth Load And Save Preset commands are now active during Live Input Mode for easier testing of
saved patches.

* Selecting groups from the Select Mode Group menu now assigns the first entry of the group as the Key
Entry so group selection can be immediately followed by a snap move or copy operation without the need to
first click on a Key Entry.

* Asio Driver Reset Requests are now processed automatically with no need to restart playback manually.

* A new enhancement has been added to the MultiTrack and SoundFile Views. The NumKeypad (with
NumLock ON) can be used with the Ctrl key to change to different preset waveform scaling factors. Ctrl-
Numkey-1 will set the scale back to full zero db.

* A new feature has been added for marking ranges. Pressing the Alt-End-Key in normal mode marks an entire
track no matter where the current cursor position is.

* The MultiTrack Menu has been updated with some of the basic keyboard editing functions.

* The code for live layer switching has been enhanced for slightly better performance at low latencies.

Bug Fixes
* Modified the Src Load detection routine for more accuracy under certain types of edl conditions.

* Added more buffer size to allow settings to be properly saved for some of the larger footprint VST synths
such as the SpectraSonics products.

* Using the X key softedge feature on the exact boundary of the last entry of a track now correctly deletes any
existing softedge for that boundary.

* Using the Asio Skip First Buffer option now correctly compensates the sync position of a new recorded
region.

* Reloading new preference files with an active Midi Control Template is now handled correctly.



* The Select Mode Insert function has been modified to correct problems under certain selected
configurations.

* Hot Track Solo Mode no longer disengages when the Ctrl Key is used with certain operations.

* Record Meter Input Source Mixer Channel selection now operates correctly even when Return and Output
channels are re-ordered in front of Input tracks.

* Modified SoftEdge code that could cause small crackle sounds at the start of entries with softedges that
followed VariPitch entries under certain conditions.

* Setting Tempo To Marked Measures now correctly handles the time signature denominator when not equal
to a quarter note.

* Channel Out Assign switches for Lite are now correctly trapped for switches beyond the max 12 devices.

Video Track Viewer Version 2.2
* Video Viewer modifications for better firewire video capture performance.

>---<

Version 3.4e
Enhancements
* Modified VST initializing routine for much faster performance. Individual plugins may still require preload

time for samples and param data when first patched in.

* Added a special routine to clear virtual midi port data and flush buffers just before the playback engine
stops, to help stuck note problems with VST synths. This also helps leftover reverb and echo trail data from
outputting when restarting the engine. Many VST synths do not automatically clear their internal buffer data
when the engine is stopped.

* The Build Mix option has been enhanced to allow mixes to be built which include VST synth outputs. This
means you can transfer midi data from the Midi Workshop directly to audio tracks through VST synths
while building a mix. You do not have to playback in realtime and record the synth output data to a track.
Selecting individual midi tracks and VST synth tracks and using the BuildMix to Current HotTrack, gives
you a simple and fast way to transfer the VST output data as audio data to MultiTrack tracks.

* A new option has been added to the Regions Menu called Create Blank Region. This option creates a blank
region which links to a blank mono wav file. This region can be inserted and manipulated like any other
region. Blank regions can be used to extend the end of a track to allow for decaying effects trails like reverb
or echo.

* A new enhancement to the X-Key crossfade feature has been added. If the cursor is tabbed directly to an MT-
Entry boundary before using the X-Key crossfade feature, the current crossfade, if any, is cleared and set to
zero.



* The special audio mute function linked to the Midi WorkShop has been enhanced to now detect and leave
VST synth tracks active as Midi output rather than audio output.

Bug Fixes
* Fixed the T-Key transfer to SoundFile function. It is no longer blocked by the Dbl-Click Transfer To

SoundFile View flag.

* Double-Clicking the same wav file in the Library View list box a second time will now still correctly switch
focus to the SoundFile View.

* The Zoom Mixer Automation View Filter link now works correctly on re-ordered tracks.

* The Zoom and Full Mixer now correctly update the MT nottrack when using the Ctrl-Left-Click name label
feature to enter multiple chan names.

* Trapped a problem with the Blend Session code that could cause crashes with regions linked to missing
files.

>---<

Version 3.4d
Enhancements

Bug Fixes
* Fixed mix template compatibility issue with older templates that could cause format errors when booting

with default mix templates.

* Fixed edl crashes that could ocurr with some VST plug-ins that use both parameter and chunk method
settings saves. Older edls with active VST plug-ins of this type would crash on loading the edl in 3.4c.

* Adjustments to fix problems with first and last entry snap-to-softedge function.

Video Track Viewer Version 2.1
* Adjustment to routine that could return false entry info under certain conditions.

>---<

Version 3.4c
Enhancements
* The Asio engine has been enhanced to allow buffer sizes that are not even-powers of 2. This should provide

compatibility with most every Asio driver available. If your driver allows, set sizes to match SAWStudio
sizes (like 64, 128, 256, 512 etc) for best performance.



* A new option has been added to the Asio Protocol menu called Asio Skip First Buffer PreLoad. This option
can be used with certain Asio drivers that send an extra callback at the time of engine start which would
normally cause the first playback buffer to be thrown away. This option saves with the preferences. You can
determine whether you need this option with the following test: Create a track of audio on track 1 containing
a few metronome clicks or kick drum accents. The first accent should be at the exact beginning of the track.
Start the cursor at zero and playback. If your driver requires this option, you will notice the attack of the first
accent is missing and you will only hear the trailing decay. You can enhance this test by setting the ASIO
driver latency size to 1024 or more samples. If the attack is missing, activate this option and try again... this
should fix the problem. The Echo Layla driver requires this option active. The current Soundscape Mixtreme
ASIO driver also needs this option. If you update drivers in the future, redo this test in case the driver code
has been altered in this regard.

* A new option has been added to the VST Property Page Options menu called Cancel 'Always OnTop' Status.
This option cancels the ONTOP status of the window, allowing mis-behaved dialog boxes on some VST
plugins to display ontop of the plugin window. This option will remain set even when the window is hidden.
The option will be cleared when the plugin is unpatched.

* Enhancements to the VST code handling for better performance and more VST Synth compatibility.

* Two new options have been added to the Mixer menu called Pre-Fx Patch Signal Flow and Eq/Dyn Signal
Flow. These options allow the signal flow of the input chan modules to be altered on a chan by chan basis.
The Pre-Fx Patch insert point can be moved in front of the Eq and Dynamics section, and the Dynamics may
also be moved in front of the Eq. Left-Click any chan to toggle the option on/off. Ctrl-Left-Click any chan to
toggle all chans at the same time. Moving the Pre-Fx Patch point to the front can be very useful when using
VST Synth plug-ins. This allows you to use the Eq and Dynamics section of the chan strip to directly
process the synth output signals. These settings save with the Mixer Templates and also with each session
edl file. These settings clear when sessions are closed. If you use a default Mixer Template, you can arrange
the default console signal routing any way you like and those settings will be used each time the console is
reset.

* A new enhancement to the VST Plugin window allows you to Right-Click on the blue pyramid options icon
to toggle Live Mode on/off. This helps when adjusting VST Synths because the internal engine is started
activating the synth outputs.

* A new option has been added to the VST Plugin Options menu called Assign SoftSynth Multi-Out Chans.
This option displays a popup menu of synth output chan choices. The stereo / mono grouping of the synth is
displayed next to the associated pre-assigned SAWStudio track. The track assignments follow in sequence
starting with the track that the synth is patched into. The outputs are kept inactive for performance reasons
until selected on this menu. The alternate outputs of the synth are then routed to the pre-patch insert point on
the associated tracks. By altering the signal flow of the pre-patch point, you may route the synth signals
directly into the console Eq and Dynamics section for direct processing. These assignments save with the
session edl and also with the SAWStudio presets.

* File Dialog Boxes have been enhanced to maintain dual monitor awareness and enable sizing.

* The automation View Filter now displays a red outline around the Automation button in the Multitrack for



positive indication of it's on/off status.

* A new feature has been added to the automation View Filter. When activating the View Filter, the Zoom and
Exploded Mixer views, if visible, will jump to the vertical offset required to display the filter control type.
This places the control within easy reach for adjusting. The module will VScroll only if the current Hot
Track module is visible.

* A new option has been added to the TimeLine menu called Auto Snap-To-Grid When Shifting Entries. When
this option is active, the grid will automatically turn on when grabbing and shifting MT Entries. The grid
will turn off when the entry is released. This mode leaves the cursor free to move without constraints, but
forces all MT Entry moves to snap to the grid. If the grid mode was already active before the move it will be
left in its active state.

* A new option has been added to the Library File menu called Refresh Library Window. Selecting this option
will refresh the current window updating the listbox with any newly added items.

* Fx patches may now be re-ordered in any of the patch list boxes. Select the entry you wish to move and
press Ctrl-UpArrow to move the effect up in the list, or Ctrl-DnArrow to move the effect down in the list.
This procedure can be done live during playback with no interruption of signal flow. This function does
NOT save an undo file since it does no real irreversable damage to the session.

* Priority has been given to the Select Mode BackSpace-Key when record meters are active. This allows you to
switch into Select Mode for a quick edit while record meters are active without having the BackSpace-Key
default to a Record Retake operation.

* A new feature has been added for jumping to the next and previous softedge. Pressing Alt-Left-Arrow jumps
you to the previous softedge position. Pressing Alt-Right-Arrow jumps you to the next softedge position. If
there is no softedge for the current entry, the jumps are to the entry boundaries, just like the tab function.

* The X-Key SoftEdge CrossFade has been enhanced. If there is no marked area, pressing the X-Key creates a
softedge of even proportion on both sides of the splice your MultiTrack cursor is in front of.

Bug Fixes
* Fader level readout displays between -70db and -79db will now display correctly on automation moves

within that range.

* Fixed the Fade To Next Automation Entry routine to eliminate close double starting entries that would occur
under certain fade conditions.

* Adjusted the automation display routines for more accurate slope drawing.

* Double-Clicking a video track entry into the viewer to Edit Mode now correctly ignores the Double-Click
SoundFile Transfer option setting.

* When reloading preference files that are set to ASIO, the ASIO Driver Setup option is now correctly
enabled.



* When reloading preference files that are set to MME, any active ASIO drivers are now correctly shutdown.

* Auto Punch-in entries now correctly adjust for live input delay offsets.

* When building a mix with multiple out files, device files set to NONE will now be correctly ignored during
the file exists test.

* Modified Auto Slope rotuines to eliminate display and playback crashes under certain automation entry
position combinations.

* Moving marked automation entries horizontally now adjusts the entries correctly when the mark beg
position is off the screen.

* The File View window now correctly modifies file names and paths when the session contains deleted
internal file entries.

* Adjustments made to the meter decay code for more consistency as the buffer size gets smaller.

* VST Synths that use the chunk method for saving and loading settings will now save and restore presets
correctly.

* Adjustments made to the code for unpatching VST Synths now stops certain synths from crashing the
system when repatching.

* Traps have been set for uninitialized names in VST Built-In Preset lists.

* VST modifications to correct for certain plugins not updating the screen after preset loading.

* The link to the Exploded Mixer View from the Full Mixer view has been fixed after being broken in 3.4b.

Video Track Viewer Version 2.0
* Changing the FireWire Frame Advance setting while the Render RealTime To FireWire option is active,

now correctly adjusts internal frame seek variables to keep FireWire output from freezing.

* Corrected a crash problem that could occur when shutting down the main program with the Video Viewer
Edit Mode Active.

* Pressing Ctrl-B or Ctrl-E on a video track entry now correctly marks the entire video clip.

>---<

Version 3.4b
Enhancements



Bug Fixes
* All slope value calculations have been corrected to perform as displayed. This allows much smoother fades

overall and perfectly smooth fades with the auto slope calculation function all the way down to DC signals.

* Links to the E Mixer and W Mixer have been fixed to properly display the current hottrack after all methods
of Track re-ordering.

>---<

Version 3.4a
Enhancements

Bug Fixes
* The Group Menu selections now correctly respond to track re-ordering.

* Record Meter Mixer Channel input source selection now correctly responds to track re-ordering.

* The video track viewer now correctly ignores movement in any window except the MultiTrack window.

* Reloading preset preferences now correctly handles the ASIO initialization and menu checked items for the
Audio Driver Model.

>---<

Version 3.4
Enhancements
* The SampleRate/Vari-Pitch routine has been enhanced for high resolution capability. The MultiTrack menu

now includes options for setting the RealTime SampleRate / Vari-Pitch Quality. The Process/MixDown
menu now includes options for setting the BuildMix SampleRate Quality. The options are:

* Lowest / Fastest. This option is the same as the current conversion routine. It is the fastest (very realtime)
but can introduce artifacts on certain steady state signals like high frequency sinewaves. These artifacts do
not occur as easily in real music complex waveforms and therefore can still sound perfectly fine to the
human ear. This option allows realtime conversion of multiple tracks in the MultiTrack on most any
machine that can run SAWStudio.

* Low / Fast. This option introduces some up-sampling and filtering to help remove artifacts, but starts to
load the cpu due to the increased number of calculations involved. This option cleans up the artifacts up to
about 15k and should still allow realtime playback of a good number of tracks, dependent on your machine
power.

* Med / Med. This option increases the up-sampling and filter configuration to increase the output quality
(clean to 18k) at the expense of higher cpu load. RealTime playback of multiple tracks will require a very



fast machine.

* High / Slow. This option increases the up-sampling and filter configuration more to increase the output
quality (clean to beyond 20k) at the expense of higher cpu load. RealTime playback of multiple tracks will
become more difficult.

* Highest / Slowest. This option increases the up-sampling and filter configuration to deliver the highest
output quality (clean to beyond 80k) at the expense of a very high cpu load. RealTime playback of multiple
tracks will require an intensly well tuned machine.

The higher quality settings should most likely be reserved for the BuildMix setting where realtime
performance is not an issue. These options save with the preferences.

* A new view called the File View window has been added. This window displays a list of all files involved in
a session. All Audio, Video and Midi linked files are displayed. You may select individual or multiple files
and change the paths or names or both from the popup options menu available by Left-Clicking the small
blue pyramid logo zone. This window locks out all further program operation until closed. Using these
functions changes only the session edl links and does not alter the files or file locations themselves. You
must move the files to their new destinations and rename them outside the SAWStudio environment. You
are notified to save the new session edl and re-open it to refresh the session to the new parameters after the
files have been altered to match. Do not continue editing the current session after file paths and names have
been altered or random corruption of the edl can occur.

* A new popup Group Menu has been added to the Mixer and MultiTrack Views. Right-Clicking on the
titlebar of any Mixer view or the MultiTrack view will popup a Group Selection / Assignment menu. There
are 32 group assignments and a few special groups for mixer and MT section groupings. Left-Clicking on
any option selects that group for the mixer channels or MultiTrack tracks depending on which window you
activated the menu from. Pressing Shift-Left-Click will assign the currently selected channels / tracks to the
selected group and prompt for a group name. Pressing Ctrl-Left-Click will clear the selected group
assignment. The group selections are addative so you can select multiple groups one at a time for special
operations. When you are finished with the group operation simply Right-Click in one of the highlited group
displays to clear the group as normal. The group assignments will save with the edl and mix templates.

* Automation slope maximums have been extended by a factor of ten to approximately 22 secs at 44100.

* A new enhancement has been added to the Change Slope Within A Marked Range function (the / key). By
marking a range in Automation Mode and pressing the Shift-/-Key, the slope will be calculated automatically
between each entry within the range, adjusting itself for a smooth transition that just fits the gap between
entries. This always guarentees a smooth transition, however it does not guarentee a zipperless transition on
sustained low frequency waveforms. In those cases, a fixed slope of 200ms or more is needed to remove the
zipper noise.

* Now, only Automation entries that respond to slopes are displayed with slopes. The slope displays now have
a higher resolution for a more accurate reflection of the actual time to complete the slope cycle.

* Making adjustments to sloped automation entries will now maintain the original slope.



* The Recover EDL Undo option has been enhanced. If there is an active session, only the undo files for that
session name will be displayed. If there is no active session, all undo files for all sessions will be displayed.

Video Track Viewer Version 1.9
* The current Video Track Entry under the cursor can now be nudged in either direction one frame at a time

by pressing the Shift-Key and the Forward or Backward Step buttons on the Viewer, or by pressing the Shift-
Left-Arrow or Shift-Right-Arrow keys when the Viewer is the active window.

* The Video Track now accepts layers. You may change layers, while the MultiTrack is the active window, by
pressing the number keys as with any other track. Or you may Right-Click to pop up the Track Properties
menu and change layers there. You may also use the menu to Copy Marked or Selected video sections to
another layer to build a composite track. Video Track layers can be extremely useful when comparing
multiple camera angle source footage. Place each camera's video on a different layer, in proper sync
position, and simply switch layers to check different shots at any position. Layers may be switched during
playback for an instant camera angle comparison.

Bug Fixes
* VST Synths with up to 16 outputs can now be handled with no crash during playback.

* Modified preload routines to fix SRP problems with certain soundcard drivers. This fixes Layla and Gadget
Labs known problems.

* Asio Output Buffers are now cleared each time the engine is started to help fix looping buffer problems with
certain soundcard Asio drivers. This fixes Layla known problems.

* Modified Asio record routines for more accuracy of SRP sync.

* Modified Live Input routines for more accuracy of SRP sync.

* SoundFile cursor position updates have been corrected in Zoom Magnify Mode for various functions like
Zero-Cross detection.

* The SoundFile Sample Info View window update routines have been adjusted to correct display problems
that could keep the window from updating under certain conditions.

* The Yamaha 03D Midi Control Template mutes have been fixed.

* Solo Mode is now correctly disengaged when activating any track reorder command.

* In Select Mode, the Alt-Key is now correctly blocked from extending the selection from the previous, when
the Shift-Key is pressed to initiate a move.

* Refreshing a soundfile in the SoundFile View will now correctly update all associated MultiTrack entries,
whether peak data is cached or not.

* The PgUp key failure to repaint the MultiTrack under certain exacting size settings has been fixed.



* F-Key files of higher resolution are now scanned for window sizes larger than the current screen resolution
and corrected to eliminate crashes when loading cross resolution F-Keys.

* Renaming track labels will now correctly update the new name in the Zoom, Exploded and Wide View
ClientY areas.

* Blend Session will now leave all FX patches intact. The patch bar displays in the mixer views will remain
active.

* Adjustments to MT loop playback to stop lockups that could occur while adjusting mixer controls at the
precise moments of the loopback.

* Fixed FX_BEGIN_PROCESS API function to include the patch list index for Pst and FRes patches.

Video Track Viewer Version 1.9
* Opening Image Files has been fixed.

* DVC Pro DV formatted video files are now correctly recognized.

* Missing Video Files are now handled more elegantly when using the Ctrl-Key to skip warning messages.

>---<

Version 3.3
Enhancements
* The BuildMix Setup dialog has been enhanced for sessions with multiple output files. You may now toggle

each output file between Stereo, Mono and None by clicking in the filetype zone. Toggling the file to None
will cancel generation of that mix file. This allows multiple output assigns, such as Aux Sends to headphone
output devices, to remain assigned without the unecessary generation of mix files during the BuildMix
operation. This setting saves with the edl session so each time you re-open the session, these settings will be
restored.

* Midi Control Surface data has been separated into its own thread to lessen much of the load from the main
MT threads when lots of control surface data is being sent. This allows heavy Control Surface loads, as are
needed for controllers like the Mackie Control, to mesh seemlessly with low latency buffer settings used for
Live Input Mode.

* The XY Pan now responds to pan slope values in all directions, thereby eliminating zipper noise during
motion. The Node points are NOT attached to slope values, therefore you should still toggle them only at
zero cross points or silence in order to avoid any clicks.

* Multiple track reordering has been added. Single tracks may still be dragged into a new track order by using
the Shift-Left-Drag feature. If one or more tracks are selected (track number inversed), then Shift-Left-
Clicking on the destination track will move all selected tracks to this new position and group them together.



If moving toward the top of the Multitrack the top of the clumped group will reside at the destination track.
If moving toward the bottom of the MultiTrack, the bottom of the clumped group will reside at the
destination track.

* Undos with Select Mode active will now also restore the Key Entry info.

* The DirectX and VST shell window Bypass Switch will now respond to marked area automation writes,
with the cursor inside the marked area, creating a begin and end entry at the marked area boundaries. For
example, if you write a switch bypass within a marked area, the bypass will happen at the begin boundary
and the switch will be reset at the end boundary.

* The Memory Cell channel store and recall features have been enhanced to now include Return and Output
channels.

* The MultiTrack cursor will now change shape to notify you any time one or more tracks are selected. Other
latched modes that alter the cursor will take precedence over this feature.

* The Mixer cursors will now change shape to notify you any time one or more channels are selected. Other
latched modes that alter the cursor will take precedence over this feature.

* The Save As name is now cleared when a session is closed and set to the session filename when a new
session is opened. This should help stop accidental overwrites of the wrong session.

* Redesigned the MultiTrack smooth scrolling routines when pushing against the edges with the left mouse
button. You no longer need to push against the mouse to keep the scrolling active.

Video Track Viewer Version 1.8
* The Video Track Viewer has been enhanced to allow the keyboard left and right arrows to step thru video

frames while in Edit Mode with the same functionality as the Step buttons.

* The Video Track Viewer Special Options menu has a new option called Use Audio For Edit Mode
Playback. This option activates audio playback direct from the current video file that is loaded in Edit Mode
during Edit Mode playback. This option saves with the video preferences.

* The Video Track Viewer Special Options menu has a new option called Viewer Visible As Default. This
option allows the viewer to default onscreen on program startup. This option saves with the video
preferences.

* Canceling from the Video Track Viewer File Open dialog now leaves the current open edit file active.

* The Video Track Viewer will maintain its size and position through edl changes. It will not be closed when
closing edls, but will still be automatically opened if the edl was saved with the viewer visible.

* The Video Track Viewer scrub routines have been enhanced to multi-threads to create much smoother
scrubbing response, even on file formats that are not known for efficient seeking action.

* The Video Track Viewer now offers analog video-only capture from most USB cameras and some analog



TV cards. You may capture direct thru any codec installed in your system to create mpeg or other
compressed formats in one pass, provided your machine can handle the performance aspects of the
compressor algorithm.

* The Video Track Viewer now allows single frame stop animation capture from either firewire or analog
capture devices. Clicking on the step foward button in the viewer or pressing the spacebar will capture 1
frame at a time.

Bug Fixes
* Engaging any record mode operation while Live Input is active will now correctly exit Live Input Mode and

then automatically engage the record operation. Live Input Mode is not needed to record live input signals.
Engaging any record or play operation will automatically engage live input signal assignments.

* The Alt-Drag of a marked MT-Entry area now corrects properly for SampleRate and VariPitch parameters.

* Adjustments to the Reverse Audio code to handle softedges at file boundaries and memory caching
correctly.

* Adjustments to the Select Mode copy routines to fix problems with Vari-Pitched entries causing an entry
conflict message to pop up in the middle of the operation under certain conditions.

* Adjustments to the MTC Sync Light screen display updates that could cause MT display shutdown on
certain Motherboard/Hardware/OS combinations.

* Adjustments to the MTC Trigger code to help eliminate possible random freeze ups when triggering that
would require a mouse click or key entry to reset.

* The Control Track View now adjusts the text color for the Contemporary Shade to correctly display the
ClientY text headings.

* The Control Track View now correctly clears the Midi Note Trigger table when first starting the program.

* Using the MT-Entry Reverse option during playback now correctly re-syncs the MultiTrack.

* The EQ Reset Flat switch now correctly automates all bands flat when written in Automation Mode.

* The Build Mix To Fx Modules option now correctly forces and latches the sample rate to the MultiTrack
rate.

* All message dialogs now clear any mouse clip zones to free the mouse movement correctly to respond to the
dialog.

* Live marking during SoundFile View playback using the B and E keys, now correctly disengages when
playback is stopped even if you never end the mark zone manually.

* Fixed the automatic reset of chase trigger mode when incoming smpte stops and the session is at the end of



the timeline.

* Fixed the mixer views to always display the mixer hot channel when changing F-Key views, unless a mixer
view is locked.

Video Track Viewer Version 1.8
* Adjustments made to the Video Track Viewer DirectShow code to fix memory leaks caused by FilterGraph

components not clearing properly during operation and shutdown of the viewer.

* Fixed audio dropout problem that could occur under certain conditions with the Video Track Viewer
Capture To Firewire option.

* Fixed Video Track Render Session to only receive data from Output Track 1.

>---<

Version 3.2a
Enhancements

Bug Fixes
* Fixed crash problem when using Live Input Return channels, caused by the shared live input sync fix in 3.2.

>---<

Version 3.2

Enhancements
* The DirectX and VST Built-In Presets options are now accessable during playback or Live Input Mode.

* The MWS Virtual Port Buffers have been enlarged to handle complex midi sessions feeding multi-timbral
VST synths thru one MWS Virtual Port.

* Changed the DirectX and VST Plug-In Titlebar display fonts to the smaller label font size to display more
information.

* The Export Regions feature now retains the last used folder path.

Bug Fixes
* Patching to the Final Res View patch point when the current Hot Track is not an output track now correctly

forces the patch to output track 1.

* When Audio and Midi data are part of a session and an empty audio track is selected, the selected track is
now forced into operation instead of track 1, thereby muting all audio tracks correctly. This can also be



accomplished by using the Mute Audio button in the MidiWorkShop.

* Fixed sync problem that could occur when recording from shared input devices on multiple console
channels as the recording source. The second shared channel and all following would start to drift from the
first channel as a group.

* The Mixer Menu Live Input Mode option is no longer grayed and disabled in SAWStudioLite.

>---<

Version 3.1c

Enhancements
* A new option has been added to the DirectX and VST Plugins Options menus called Built-In Presets. This

option opens a list of built-in presets that come with the individual plug-ins (if any).

* Live Input Mode has been activated for SAWStudioLite to facilitate VST Synth scrubbing in the Midi
WorkShop Add-In. All operation details of SAWStudioLite Live Input Mode are now the same as for the
full SAWStudio version.

* Engaging Live Input Mode now changes the cursor shape to give visual feedback when in any of the Mixer
views or the MultiTrack view.

Bug Fixes
* Trapped a problem on certain Sony Vaio and Dell laptops that would cause the cursor clip routines to fail,

not locking the mouse within certain zones which could then cause GPF's as data values extend past legal
limits, for example when grabbing a mixer fader.

* Modifications to the Asio code now creates compatibility with the MidiMan Delta series and Digi002
soundcards.

* Trapped loss of mouse focus in Zoom or Full Mixer vertical scroll mode when the Windows taskbar is
overlapping the bottom of the mixer views. A good suggestion is to autohide the taskbar to give full use of
screen real estate with no overlap, or adjust the F-Key views to leave space for the taskbar with no window
overlap.

>---<

Version 3.1b

Enhancements
* Added new visual feedback routine when clicking on command zones in various windows within the

program. The zone text will temporarily shift slightly to indicate that the click was received. Shades have
been updated to acommodate this routine, be sure to download the new shades versions that you use.



* VST Synths patched to a track will now automatically force that track active and allow the MultiTrack play
operation to function even if there is no other active data from the MT, Video Track or Midi WorkShop.

* A new Built-In Command has been added to the Control Track Built-In Command Menu called Midi Ascii
String. This command allows you to enter straight Ascii Text strings and even include Ctrl char codes such
as carriage returns and linefeeds. Ctrl codes are entered by using the "^" character followed by the Ctrl code
letter such as "^m" for a carriage return (dec 13) and "^j" for a linefeed (dec 10).

* A new option has been added to the Options Menu called Auto Record SoftEdge. This option allows you to
set a SoftEdge value to be applied automatically to every record region entry dropped onto the MultiTrack.
If the recording drops into the middle of existing regions, both the in and out splices will receive the auto
SoftEdge. Setting this value to 0 Ms de-activates this feature. This option saves with the preferences.

Bug Fixes
* Fixed Control Track lockup that could occur when jumping to a Stop/Cue/Preload command in the Control

Track View and then starting playback.

>---<

Version 3.1a

Enhancements
* Modified the Asio code to allow more compatibility with more Asio soundcard drivers. The buffer size

setting is now automatically matched to the Asio setting which is set in the Asio Driver Setup control panel.
The buffer size for Asio mode is no longer adjustable in the Audio Device Setup window, although the
number of preload buffers may still be adjusted and utilized to control latency and performance issues.

Bug Fixes
* Trapped Asio driver buffer sizes that are not even powers of 2 which do not match SAWStudio buffer size

options exactly.

* Resetting Audio Sync Devices now correctly re-initializes all sync variables for immediate access to Smpte
generation without restarting the program.

* Cancelling an MT PreLoad operation now correctly ends all initialized plug-in processes.

>---<

Version 3.1

Enhancements
* Improvements have been made to live input track latency. With small buffer settings (2 at 128 output, 6 at

128 input) you can start to experience virtual realtime performance for live input signal monitoring.



Selecting a mixer channel as a record source now activates live monitoring capability. The Mono Switch
setting of the channel determines whether a mono or stereo file is created. If the channel is set to an input
device source, live input signals will be routed thru the channel strip, utilizing all eq, gate and compressor
functions as well as fx patches and aux sends. If the channel is assigned to an output, the signal can be
directly monitored. If aux send masters are assigned to output devices, they can be used as headphone feeds,
back to the performer. The recording signal is taken pre-fader after the Pre Fx patch. The main fader and
mute and solo switches can be used to control the control room monitor mix without affecting the recorded
signal. If the channel input is set to the MultiTrack, the recording will pickup whatever signal is on the track,
which could be disk data or a VST synth patched pre and record directly from the track output with no need
to physically route the signal thru A/D or D/A converters and cables. All three record modes will activate the
monitor thru capability.

* Pressing the Shift-Key while starting MultiTrack playback will now internally switch all tracks to
MultiTrack source, for playback of MultiTrack data even while the track is assigned to a Device-In source.
This is a temporary condition for this playback only. All Device-In assignments remain intact.

* A brand new option has been added to the Mixer menu called Live Input Mode. This mode (not available in
SAWStudioLite) places the entire virtual console into Live Input operation. You may also toggle this mode
in any mixer view by pressing the L-Key. When this mode is active, all input channels that have been
assigned to active input audio devices or have VST Synths patched in will go live. All FX patches are active
for all plug-ins to operate. The entire console routing is available to truly turn the virtual console into a live
PA Sound Reinforcement console. The latency is completely controlled by the audio device in and out
buffer settings. The new advances in the live input latency engine enhancements now allow this mode to be
very realtime when buffer settings of 4 at 128 or lower are achieved. You should find that most stable
SAWStudio machines will now be able to achieve these buffer settings due to the new engine enhancements.
You may exit this mode with the L-Key or pressing the Stop button on the MultiTrack transport in the top
client area. Note that when using live inputs, plug-ins that withold buffers or change buffer sizes (such as
Time Compressors and Pitch Shifters) may cause glitches or even stop the engine due to the extra demands
for more data out of realtime.

* Multiple Input Channels may now be assigned to the same source Input Device for internally duplicated
signal creation. This can be useful when assigning two channels to the same device and setting one channel's
Mono selection to Left and the other to Right. This allows complete separation of input devices as mono
signals for use with the Live Input Mode. Multiple Return Channels may also be assigned this way.

* Asio Driver Protocol has now been added to the Options menu. Low buffer latencies should be attainable on
most machines if your audio card has ASIO drivers. An Asio Driver Setup option is also included to allow
Asio Driver Control Panel settings to be altered.

* Record Templates now retain track offset information. If record tracks are not sequential, the track offset
information will be applied starting from the current track where the record template is opened. For instance,
if the record template is saved with tracks 1, 3, 5 and 6 in record mode, and then the template is recalled
starting at track 11, tracks 11, 13, 15 and 16 will be placed into record.

* More hooks for the first release of the Midi WorkShop add-in module.

Bug Fixes



* Live Input Tracks now process correctly to Output Tracks when they are the only assignment on that output.

* The Time Display is now correctly updated when changing Workspace Views while Record Ready is active.

* Fixed Regions View Titlebar screen display problem that could occur with certain video card drivers.

* Fixed crash that could occur in SAWStudioLite when opening sessions created in SAWStudio with active
data on layers greater than layer 4.

* Fixed Mono setting from being changed when starting playback in Offset Mode.

>---<

Version 3.0

Enhancements
* More API enhancements to accomodate the Midi WorkShop.

* Enhancements to the Grid Mode toggle have been added. Right-Clicking in the TimeLine Grid Zone under
the time readout display will toggle the Grid Mode On and Off. Left-Clicking the Grid Zone will popup the
grid settings and toggle the Grid Mode On if it is currently Off.

* The Midi WorkShop view option has been added to the MultiTrack Left Client Track popup menu, allowing
you to display it during playback when the main menus are locked out.

* The Slip Track options now also work in Automation Mode.

* The Track Properties Menu Clear All MT-Entries options have been renamed and enhanced to clear all MT-
Entries and Automation Entries at the same time.

* A new option has been added to the Track Properties Menu called Clear All Entries On All Background
Layers. This option clears all MT-Entries and Automation Entries on all hidden layers leaving the current
top layer untouched.

* The Save And Trim Session option has been enhanced with the choice of including data on all layers or only
the top active layer for each track. This can further reduce trimmed session size and clean up unused extra
data from layers no longer needed in the final mix.

* A new feature has been added for marking an area in normal MultiTrack mode. You can now press the Shift-
End-Key to mark from the current cursor position to the end of the session.

* Modifications made to the CM MotorMix Midi Control Template to accomodate the current MotorMix
labeling. The F1 Button (Play) and the F2 Button (Stop) functions have been switched. The Next and Last
Button functions have been moved to the F3 (FFwd) and F4 (Rew) Buttons. The Record Function has been
moved to the Enter Button.



* Due to complications with WheelMouse Click sensitivities, the WheelMouse toggle between scroll and
zoom mode has been changed. Whichever mode you set as default in the MultiTrack WheelMouse menu
option can be temporarily toggled to the opposite by pressing the Alt-Key while you engage the mouse
wheel.

* SAWStudio now retains the last property page displayed for DirectX Plug-ins when saving and opening
sessions. This maintains accurate settings for certain plug-ins that require a certain property page to be
selected in order to function properly.

* Track Re-Ordering now saves undo files.

* New options have been added to the Options Menu called Control-Track Midi Output To Comm1 and
Comm2 and Comm Port Setup. These options allow the Control-Track Midi commands to be routed to the
Comm ports along with or instead of the Midi Ports. This allows control of RS232 type theatre equipment
direct from SAWStudio. The Comm Port settings can be adjusted with the Comm Port Setup option.

* The Custom Commands option in the Control-Track View has been activated. This popup menu allows you
to select any entry in the Control-Track listbox and add it to the list of Custom Commands. This list is
automatically updated and saved and reloaded each time you start the program. You may remove a Custom
Command from the list by Shift-Left-Clicking it on this popup menu. Left-Clicking adds the entry to the
Control-Track at the current MultiTrack Cursor position.

Bug Fixes
* The Tempo Grid Measure setting now works correctly.

* The Slip Track options now correctly maintain automation positions when doing all layers simultaneously.

* The Layer Display Count now correctly shows a plus sign whenever other layers contain MT-Entries or
Automation Entries.

* Video Track Viewer updated to properly display black frames when cursor is jumped by various interface
options to empty video track sections.

* Rec and RecRdy operations of a Master / Slave network connection now work correctly on either machine.
An SRP operation from the Master machine now correctly controls the Slave playback while recording on
the Master. An SRP from the Slave correctly keeps the Slave independent of the Master.

* Tempo percentage Snap To Grid now works correctly within multi-entry TempoMaps.

* The TimeLine display now works correctly at all zoom levels when using Tempo Mode and a zero locate
offset position.

* Added some traps to certain MultiTrack zones during playback for cleaner interface operation.

* MTC Chase Sync operation now correctly resets itself if playback fails for any reason after triggered.

>---<



Version 2.9

Enhancements
* A new option has been added to the Control Track View Options Menu called Midi Receive Trigger Active.

This option toggles the Control Track Note On/Note Off Midi trigger features. When this option is Off,
Control Track Midi trigger information will be discarded. This option is saved with each session Edl. When
sessions are closed, this option is turned Off automatically. Any sessions previously saved which use
Control Track Midi Note triggering will need to be opened and re-saved with this option active. They will
operate normally after that.

* Full implementation and inclusion of the Mackie Control template. Most all mixer controls and many
editing controls as well as F-Key Views are active. Check the help file for details. Button layout templates
should be available from Mackie shortly. Call Mackie and request your Lexan template. In the meantime,
you may download the pdf button layout template avaialable at our website. It will print at exact size. Have
fun punching out the holes :)

* Implementation and inclusion of the Mackie Baby Hui template. Check the help file for details.

* The Full Mixer View now displays 6 patch bars in the channel Aux Zone referencing the 6 Aux Send On
switches, allowing you to instantly see all channels with active aux sends.

* The Left-Drag MultiTrack scrolling has been re-designed for easier control. When holding the Left Mouse
button and pushing at the MultiTrack wave display area edges, the multitrack now scrolls in any direction
under direct control of mouse movements, rather than in an autoscroll mode. You can keep scrolling by
applying a slight pressure towards the edge direction you are moving. By holding the mouse still at the edge,
the scroll will stop, allowing you to control the pace and exact stopping point much easier than before. This
feature is now active during MultiTrack play mode also.

* The Locate points have been enhanced to allow for automatic marking during the jump. Pressing the Alt-Key
while selecting a Locate point will mark from the current position to the new position at the same time the
jump is made.

* A new feature has been added to the Mixer Views. By Right-Clicking on the Close button of the Full, Zoom
or Wide Mixer view, you can lock or unlock that view. Moving around in any of the other views will not
cause the current locked view to chase along. You may still change chans in the locked view itself, but it
will no longer be linked to affect other views. The Close button will change to display a small padlock when
the view is locked.

* The EDL Undo function now resets the MultiTrack Cursor position to its undo saved position.

* Processing times for screen redraws and zooms under heavy CPU load has been improved with enhanced
dynamic latency code.

* Modified thread code in the Video Track Viewer for overall smoother playback response in both Win 2000
and Win XP.



Bug Fixes
* Fixed the screen redraw problem that would lockout screen updates after using the Track Properties option

Copy Selected Entries To Layer on multiple selected tracks.

* Fixed the screen redraw problem that would lockout screen updates after using the Blend Session option if
the Blend Session routine had difficulty inserting entries and exited early.

* Fixed the screen redraw problem that would lockout screen updates after using the Slip Track feature if the
routine had exited early.

* Trapped live layer switching during playback from tracks which start with an empty layer. Also, layers will
not switch during playback to empty layers.

* Fixed MultiTrack screen drawing problem which could leave one line of garbled data at the bottom of the
MultiTrack when scrolling the display vertically under certain conditions.

* Fixed MultiTrack screen drawing problems that could garble the MT ClientY area under certain scrolling
and marking combinations in Select Mode.

* Fixed accuracy of Compressor Ratio calculations when adjusting the ratio during playback.

* Modified Mixer ClientY display routines to help with drawing problems under heavy playback load.

* Modified code to handle Softedges that overlap the end of the next entry without creating and endless
playback loop.

* The Disable Track feature now correctly sets the EDL modified flag.

* Fixed gpf condition that could occur when building mix files with wide range of samplerate conversion and
bit depth increase, for example building a 44100 16 bit file into a 192000 24 bit unpacked file.

>---<

Version 2.8a

Enhancements

Bug Fixes
* Fixed TCP/IP Remote lockups that could occur under certain conditions after Right-Clicking to stop

playback.

>---<



Version 2.8

Enhancements
* A new option has been added to the Video Track Viewer Options Menu called Render Realtime To Overlay

Video Out. This option can be used with the Matrox dualHead video cards that support the DVDMax feature
to output the Video Track video, full screen to a second computer monitor or TV Monitor. The DVDMax
feature can be activated in the Matrox settings advanced section under the DualHead options tab. Other
video dualHead cards may also work if they output an overlay rendering to their TV out hardware.

* The Recent Session File List is now updated everytime there is a session save with a name change. This
includes saving a fresh session on program exit.

* Added percentage readout display in taskbar icon during minimized background operations like BuildMix.

* You may now open record templates across Return and Output tracks that are re-ordered. For instance, if a
Return track is re-ordered to track 2 and you attempt to open a 4 track record template starting on track 1,
the template will now skip the Return track and continue onto the following 3 tracks, instead of stopping at
the Return track.

Bug Fixes
* Fixed Source Buffer Underrun errors and playback crashes that could occur under certain MultiTrack

conditions with Pre-FX patches on output tracks, caused by some of the 2.7 enhancements.

* Fixed FireWire video track output problems in Windows XP.

* Trapped extra user input commands during timed error messages.

* Fixed Fx Patch window displays to lock onto the last output track when the HotTrack is set to the Video or
Control Track. This will also open the correct (last output track) patched plug-ins when Double-Clicking on
them.

* Fixed full screen restore problem when restoring from minimized background operations like BuildMix.

>---<

Version 2.7

Enhancements
* The TCP/IP options have been activated, and new TCP/IP items have been added to the Options Menu. All

TCP/IP options will save with the Preferences.

The Activate TCP/IP Host/Master Mode option allows the program to operate as the Host/Master machine



across a standard ethernet 100 base-T network. Activating this option displays the Host/Master signature on
the Main window titlebar and allows the program to accept up to 8 Remote or Slave machine connections, in
any combination.

The Activate TCP/IP Slave Mode option allows the program to operate as a Slave machine that can sync to
another machine running SAWStudio as the Host/Master. The Slave machine will link and synchronize to
the Master machine when a connection is established. When a link is first established or the Master machine
activates an Open Session command, the Slave will attempt to open its own local edl using the same drive
and path name from the Master machine. If it does not find the edl at the duplicated path it will substitute the
default session file path setting and look there. If both fail to find the edl, then it will simply ignore the open
command. In Slave mode, each machine plays its own version of the edl through its own soundcard outputs.
You can mix the outputs of each machine with an external mixer, or stay completely virtual and feed the
slave machine outputs back to a Master machine MultiTrack input with the channel source set to a pair of
soundcard inputs on the Master machine. You can use this mode to duplicate session playback on two
machines for live theatre, one machine serving as a backup for live performances. You can also use this to
spread the load across two machines, extending different instrument tracks onto the Slave machine under a
common edl name. When you start playback on the Master machine, the Slave will cue and begin playback
in perfect sync... all without Smpte or Mtc connections... simply an ethernet network connection. Actual
hardware lock can be acheived by using WordClock between the Master and Slave machines. You may use a
single master WordClock source to feed both machines, or send WordClock from the Master machine
converters to the Slave machine converters. If the Slave has record channels active, it will enter SRP-Record
mode when the Master begins playback. If there is a marked area in the MultiTrack, auto punch-in/out will
be engaged for that area. Editing commands remain independent between the Master and Slave machines.
Any work done on a session on the Slave must be saved independently on the Slave. When the Master closes
the session, the Slave will prompt, if needed, to save any session changes before closing its session.

Slave commands supported:
OPEN_SESSION
CLOSE_SESSION
MT_AUDIO_PLAY
STOP_AUDIO
SET_MT_SAMPLE_POS

The Activate TCP/IP Remote Mode option allows the program to operate as a Remote machine that can
control another machine running SAWStudio as the Host/Master. The Remote machine will link and
synchronize to the Master machine when a connection is established. When a link is first established the
Remote will attempt to open a copy of the same edl on the Master machine across the network. You will
now be able to operate the Master machine from the Remote machine. Opening, closing and saving sessions,
playing, recording, retaking, and editing the Master machine session. The Remote machine does not use its
soundcard, it does not even need one installed. During playback, the Master machine sends all position and
meter information across the network to the Remote. Audio only plays on the Master machine. The Remote
machine acts truly as a sophisticated remote interface. When you save the session, you are saving the Master
session as if you were editing on the Master machine. Device names in the Mixer Assign section will display
Master machine soundcard devices, not the devices on the Remote machine. The actual Remote devices are
not available during a Remote session. FX Plug-ins are not supported yet. The FX Choices list will gray-out
FX Plug-ins on the Remote machine that are not installed on the Master machine.



Remote commands supported:
OPEN_SESSION
CLOSE_SESSION
SAVE_SESSION
RECALL_EDL_UNDO
REDO_EDL_UNDO
MT_AUDIO_PLAY
MT_AUDIO_PLAY_MARK
MT_AUDIO_PLAY_LOOP
MT_AUDIO_REC_RDY
MT_AUDIO_REC
MT_AUDIO_SRP
MT_AUDIO_REC_PUNCH_IN
MT_AUDIO_REC_PUNCH_OUT
STOP_AUDIO
OPEN_MT_TRACK_REC_METER
CLOSE_MT_TRACK_REC_METER
MT_REC_RETAKE (Shift and Ctrl versions also)
REC_SET_INPUT
REC_SET_TRACK
SET_MT_SAMPLE_POS
SET_MT_HOT_TRACK
SET_MT_TRACK_LABEL
SET_MT_TRACK_LAYER
SET_MIXER_CONTROL (Entire Mixer)
SET_ALL_SOLOS_OFF
SET_AUTOMATION_MODE_ON
SET_AUTOMATION_MODE_OFF
DELETE_SEQ_ENTRY_AT_POS
SPLIT_KEEP_MT_ENTRY
SPLIT_MARK_MT_ENTRY
SPLIT_REMOVE_MT_ENTRY
SPLIT_DELETE_MT_ENTRY
UPDATE_MT_ENTRY (Alt-Shift and Ctrl versions also)
CLEAR_MARKED_AUTO_ENTRIES

Be respectful of the supported commands. Using unsupported commands will result in random undesirable
edl results. More commands will be added in later updates.

When Editing on the Master machine, it is recommended that all Remote connections be broken to avoid
possible problems due to unsupported operations. Reconnect Remote machines only when attempting to edit
remotely.

The TCP/IP Port option allows you to enter the network port to be used for network communications. The
Master and Slave/Remote machines must use the same port. There is a list of possible available ports in the
dialog for setting this value.



The TCP/IP Host Computer Name/Address option allows you to enter the network computer name or
TCP/IP address for the Host/Master machine. This option is only used for the Slave and Remote machines.

The TCP/IP Slave Sync Latency Adjust option sets a latency plus or minus offset in samples to compensate
for delays in the network transmission and differences in soundcard latency. This value is used to move the
playback starting position to an earlier or later value than actual. Network transmission delays are not
exactly repeatable, but this value can help tighten the sync to within a few dozen samples.

* A new option has been added to the Driver Protocol option in the Options Menu. You may now select the
24 Bit WDM Compatible MultiMedia option which allows full 24 bit operation for newer soundcards which
use only the WDM driver model. Previous Multimedia compatibility would only work in 16 bit mode.

* The U-Key Update MTEntry function has been enhanced to follow the Auto ZeroCross setting in the
Options menu.

* The ScrollWheel button may now be Double-Clicked in the MultiTrack view to toggle between ScrollWheel
Inc/Dec or Zoom mode.

* A new option has been added to the Control Track View Options Menu called Set Cue Base Name. This
option allows you to enter a cue base name which will be used automatically as the name for all following
Cue Location entries until changed or cleared. This can help you locate all cue locations, for example, that
you entered during a vocal overdub session as markers by first setting the base name to "Vocal OD". All
entries can be easily seen, and edited after the overdub, because they will all be labeled "Vocal OD" in the
Control Track View listbox.

* Two new options have been added to the Control Track Built-In Command list, called Midi Bank Select and
Midi Bank Select / Program Change. The first option allows you to send a Bank Select command to your
chosen Midi channel, and the second option automatically follows the Bank Select with a Program Change
command.

* The FX API has been updated to include the seamless integration of the soon to come Studio Midi
WorkShop PlugIn.

* The Midi Control template API has been enhanced to allow full use of the Mackie Control surface features
in a soon to come Mackie Control integrated template. This also allows an expanded version of the Motor
Mix template in this release, with access to all Aux Send, Eq, Compressor, Gate and Key controls. Be sure
to see the HelpFile or pdf Manual for MotorMix Controller operation details.

* VST SoftSynths may now be patched to an empty track without the need to place a blank entry at the track's
end for the processing loop to be active.

* The Library Wav File Import function has been enhanced. If the selected wav file is open in the SoundFile
View when using the import function, marked area positions will be utilized, allowing you to import a small
section of the file instead of the entire file.

* Automation fades and individual entries written while playback is stopped, now force a zero ms slope value
on all MT-Entry start boundaries for an instant change at the boundary.



* Left-Clicking in the MT TimeLine area during normal MT playback now performs a live jump to the current
cursor position, much the same as a Locate point jump during playback.

* Reverse MT-Entries are now marked with a small white hatch mark in the top left entry corner for
identification, like vari-pitched entries.

* A new feature called Replace MT-Entry has been added. Placing the MT Cursor on an entry and pressing the
Shift-R key will replace the entry with the currently selected Region Listbox region.

* A new option has been added to the MultiTrack Menu called L-Btn Edge Vertical Scroll. This option
controls the edge detection for MT vertical scroll with the Left Mouse button. Normal SAWStudio behavior
has this option activated. You can still do MT vertical scrolling with the Right-Hold mouse functions, even
when this option is not active.

* Offline automation writing within a marked area, which creates an auto entry on both boundaries, has been
modified to only operate when the cursor is within the marked area. If the cursor is outside the marked area,
only a single auto entry is created at the cursor position, ignoring the marked area.

* The Mixer Channel Store/Recall menu can now be activated by a Left-Right-Chord-Click as well as the Alt-
Right-Click combo. The mouse chord can be done by holding the left mouse button and then tapping the
right mouse button at the same time.

* The BuildMix Base and Device filenames may now be cleared to their default settings by Shift-Left-Clicking
on them in the BuildMix FileName Setup dialog.

* Enhanced Layer Switching during playback performance.

* A new option has been added to the MultiTrack Track Properties Menu, for Input Tracks only, called Enable
Track FX Auto Bypass. When active, this option scans incoming FX data and outgoing FX data and
automatically bypasses the FX processing for that track when both buffers contain all zero data values. This
helps give back CPU time to the rest of the MultiTrack during blank track sections. The output buffer scan
allows reverb trails to dissipate before bypassing further processing. Be aware that certain plug-ins with
meter decays might freeze meter displays because buffer processing has been bypassed and displays might
not complete their decay. Also, do not use this option for tracks that alter overall track length like Time
Compressors, because those plug-ins must process every buffer to properly output the new length data
stream. This option responds to the Ctrl-Key for all tracks, and also Selected tracks for specific track
activation.

* The Video Track Viewer may now be stretched out of proportion by dragging the left or right border.
Dragging the top or bottom border will still retain proportion.

Bug Fixes
* Eliminated screen flashing when closing Control Track User Input Dialogs.

* Fixed Control Track Midi-Note-On/Midi-Note-Off command from being corrupted after edting its values.



* Channel Settings Files (.cht) will now transfer FX PlugIn settings correctly between different SAWStudio
workstations. This fix corrects the problem where different workstations have different FX PlugIns installed,
thereby causing the PlugIn order to be different between systems.

* WaveForm drawings of close zoomed waveforms no longer draw a solid line from center up or down to a
high valued first pixel, keeping the joints of close zoomed MT Entries clean.

* Actively assigned XY-Pan Outputs with no actively assigned XY-Pan Inputs is now trapped with a warning
message.

* Inserting a Region to Grid within a marked area now correctly inserts the first entry if the marked area
begins at zero.

* The Track Properties Disable Track option is now correctly grayed during active Playback or Record.

* Right-Clicking in a Library View of .wav files, now builds peakdata files correctly when none exist before
playback begins.

* Automated mixer FX bypass switches now correctly detect whether plugins have been removed before
displaying FX patch icon bars.

* Double-Clicking in the Final Res View now opens the correct plugin, even if the current hottrack is not an
output track.

* Aux Send Masters now respond correctly to the Ctrl-Click increment/decrement zones to change 1 db per
click.

* The Ctrl-Track now correctly adjusts to samplerate changes.

* Solved edl corruption problem that could occur with multiple patches of the same plugin and certain edl-
undo combinations. This corruption showed up as extra param sets displayed in the plugin tracklist with
mis-matched FX Patch bars in the mixer.

* The Ctrl-Track view is now correctly updated with all position changes in the MultiTrack.

* Dynamics track keying has been fixed to correctly detect empty or inactive tracks and clear the key buffer
accordingly. This fix also applies to the FX API that controls the Levelizer keying function.

* Offline automation writing within a marked area now correctly handles multiple changes on the same
boundaries, such as multiple Eq bands.

* Exiting and canceling Offset Mode with the Right-Click or Ctrl-O key, now correctly clears the offset values
and resets the original values during playback.

* Fixed FX API Start SRP and Rec functions.



* Fixed crash when pressing Ctrl-8 during playback.

* Fixed the Video Track Viewer conversions/extractions from being 1 audio frame short.

>---<

Version 2.6f

Enhancements
* Blend Session has been enhanced for quicker loading times.

Bug Fixes
* Fixes to the undo routines connected to video edits.

* Modified some code to help eliminate redundant MultiTrack screen redraws in certain operations.

* Track Properties popup menu items that do not apply to Return and Output tracks have been correctly
disabled. Layer displays for Return and Output tracks now properly look only at automation data.

>---<

Version 2.6e

Enhancements
* A new option has been added to the Regions menu called Import New Region. This option takes its

information from the currently open SoundFile in the SoundFile View and imports the marked area to a new
import destination file, then creates a new region in the session, linked to the new import destination file.

* The Save and Trim option has been enhanced to clear all BuildMix Filenames in the new trimmed session to
free any links to the original session.

* The Import and Save and Trim functions have been adjusted to size down the blank time before and after
regions in the final created files from 500 ms to 200 ms.

Bug Fixes
* Fixed problem which locked out the use of the period key in dialog boxes.

* Fixed problem which could cause peakdata files to remain open after sessions were closed under certain
conditions. This could cause sharing violations when trying to manipulate the file outside SAWStudio while
SAWStudio is still open.



* More adjustments made to correct the crash with the UAD powered plugins during a BuildMix operation.

* More adjustments to the VST initialization routines to help compatibility with certain VST plug-ins.

* Fixed code to correct the dissapearing SAWStudio About Box that could occur under certain conditions.
Also made the About Box be an OnTop window to force it above plug-in displays.

* Fixed undo problem with the Levelizer Remove Silence command. The fix was in SAWStudio. No need to
update the Levelizer.

>---<

Version 2.6d

Enhancements

Bug Fixes
* Modifications to the VST code to allow compatibility with the Universal Audio Powered Plug-Ins. Try to

get SAWStudio's buffer size down to 256 or less to bring the Powered Plug-Ins latency within reason. Also,
be careful not to place DirectX plug-ins that alter the buffer size (like Time Compressors and Pitch Shifters)
in front of these plug-ins, because they may not respond properly to varying buffer sizes.

This modification will also help fix certain other VST plug-in screen updating and loading problems.

* Fixed possible crash problem if large SoftEdges completely overlap tiny MT Entries.

>---<

Version 2.6c

Enhancements
* The Record Meter Windows have been enhanced to allow horizontal sizing. The window can be sized down

to 1 record meter or up to the max opened meters. The window can then be saved while open in an FKey or
Alt-FKey. FKeys saved with open Record Meters will retain the window size as a maximum lock. Whenever
the Fkey is used, the current Record Meters will size down to fit the max saved size. If more meters are
currently opened than will fit, they can be accessed by using the left or right arrow keys or Left-Clicking near
the left or right edge of the window. This feature now allows you to create two simple FKey views, one view
with one meter, and one view with as many as you might ever use at one time that fits across the screen.
When doing a recording session with 16 meters open, you can simply use one FKey to instantly compact the
meters down to 1 meter while playing back the last recording. This allows you to have access to the mixer
and multitrack views without all the meters on top, but still keeps the meters open for access to the retake
commands if you decide to do a retake. Then, using the other FKey, you can instantly expand all the meters
across the screen again to do another recording.



Bug Fixes
* The Update SoundFile Region function has been fixed to allow upper / lower case changes in the Region

name.

* Automation now displays correctly on mixer channels during playback when the Control and Video Track
are displayed at the top of the MultiTrack.

* Dynamics threshold lines now display on the correct track when the Control and Video Track are displayed
at the top of the MultiTrack.

* Crashes caused by playing a varipitched or samplerate converted file to the end and then immediately
exercising a zero-cross detection near the file end, have been fixed.

* Fixed code that was causing ticks and pops with softedges used on vari-pitched or samplerate converted
entries.

* Changed code that checks for existing files to extend the filepath size from the older Windows routines.

>---<

Version 2.6b

Enhancements
* The MouseWheel now also controls the Zoom functions in the SoundFile View Window. This action is

independent of the MouseWheel option selection for the MultiTrack.

* The Control Track View has been enhanced to include a marked time between entries option. Left-Click the
first entry of interest, then Alt-Left-Click the next entry (further down the timeline), and the area between
them will be marked and displayed in the Marked Time zone on the MultiTrack.

* The Control Track View has been enhanced to allow Cue Location selections using the mouse or keyboard
within the listbox during playback, to jump and continue playback for instant live cueing operations.

* A new option has been added to the channel Store and Recall popup menu called Clear Current Channel.
This option clears the current channel to default settings. If the current channel is one of a group of selected
channels, all selected channels are cleared.

* Two more new options have been added to the channel Store and Recall popup menu called Save All To File
From Memory and Load All From File To Memory. These options allow any memory cell to be saved to a
disk channel template file or loaded from a disk channel template file. The file extension used is .cht.

Video Track Viewer 1.2
* The LayBack To FireWire option has been enhanced to allow the Play button to also pause the layback.



Bug Fixes
* The Control Track View now properly chases cursor movement in the MultiTrack initiated with the Left and

Right Arrow keys.

* Fixed Fx Automation problems that could cause loss of multiple automation entries written to the same
sample position, after automation editing or overwriting operations. The Studio Graphic Eq plug-in Hi-Cut
and Lo-Cut parameters were affected by this problem.

* Recalling channel data from memory cells during playback, now correctly ignores assignment switch data
that cannot be altered while playback is active.

Video Track Viewer 1.2
* The LayBack To FireWire option DV Type-2 files audio connection has been corrected.

* Video Track Viewer now properly chases when selecting Cue Locations in the Control Track View.

>---<

Version 2.6a

Enhancements
* The Control Track View window no longer has the On-Top window attribute, so it may now be mixed in

behind othe windows in the F-Key views if desired.

Video Track Viewer 1.1
* Two new options have been added to the Video Viewer Menu called Use NTSC DV Output Format and Use

PAL DV Output Format. Selecting one of these options rebuilds all filter graphs to force DV Render and
FireWire outputs to the selected NTSC or PAL format. Make sure to adjust your TimeLine to the proper
Smpte Format. For example, 29.97 Frames Per Sec for NTSC and 25 Frames Per Sec for PAL. These
options save with the Video Preferences.

* Pressing Stop when capturing from FireWire, now closes the capture file to write the final header
information and then automatically re-opens it up in EditMode, ready for editing and insertion onto the
Video Track.

Bug Fixes
* Fixed problems when trying to record on input tracks that are below re-ordered output and return tracks.

* Fixed Record track menu and stereo channel menu listings when tracks are re-ordered with input tracks
below return and output tracks.

* Fixed layer copies of marked areas which was causing automation entries to copy multiple times on top of
each other.



* Fixer Remove Silence lockups on long length areas.

* More work done to stabilize Memory Region and PeakData caching lockups.

Video Track Viewer 1.1
* Trapped crashes that could occur on certain systems with certain FireWire device drivers whenever an

attempt was made to access a FW device that was not powered up or plugged in.

* Fixed EditMode playback using the Render Realtime to FireWire option.

* Fixed EditMode Render Realtime to FireWire when the VideoTrack contains no video entries.

* Fixed possible lockups that could occur under certain conditions when stopping an EditMode playback.

* Fixed EditMode Image File oversize trapping and DV FireWire rendering.

* Trapped DV format crashes when using PAL or NTSC DV files in a system set to output in the opposite
format.

>---<

Version 2.6

Enhancements
* The Video Track has been activated. The new viewer is built-in and can be popped up from the View Menu

or by Left-Clicking the VideoTrack Label area. Left-Clicking the pyramid logo pops up the Video Track
Menu. Left-Clicking the V-Letter zone jumps the MultiTrack directly to the Video Track, similar to the I, R
and O zones at the bottom of the MultiTrack View. The viewer is based on the DirectShow interface and
therefore offers access to the many varieties of filetypes and functions that this interface supports. It is
highly recommended to use the latest DirectX version available. At the time of this writing, that would be
DirectX 8.1 for Windows 2K and XP, and DirectX 6.0 for Windows NT. FireWire DV capture and output
will most likely require Windows 2K or Windows XP.

The viewer has two distinct modes of operation; Edit Mode and TimeLine Mode.

Edit Mode:
The Edit light will turn on when in Edit Mode. You can toggle Edit Mode on and off by Left-Clicking the
Edit light. This mode separates the viewer from the MultiTrack timeline and causes it to act on its own,
similar to SoundFile View. The top client area of the viewer displays the current frame count in this mode,
and the current In Frame and Out Frame.

Selecting the Open Video File option from the Video File Menu, opens a video file into the viewer and
forces Edit Mode active if it is not already. Any video file type that has a codec in the system can be opened.
This includes DV/Avi, mpg, indeo, certain quicktime formats and others.



Left-Clicking in the scrub zone at the bottom of the viewer allows you to scrub through the video file from
front to back. The scrub zone always represents the entire length of the file. Shift-Left-Clicking near the red
center line in the scrub zone will slowly jog the video forward or backward depending on which side of the
red line center position you are.

The play and stop buttons are active to play the video. Pressing the Shift-Key and the play button will play
the clip from the In and Out frame positions. Pressing the Ctrl-Key and the play button will loop the clip
from the In and Out frame positions. No audio is played in this mode. The step forward and backward
buttons allow you to step, one frame at a time, in either direction. Left-Holding one of these buttons steps the
video in very slow motion, about 100 ms per frame.

The In and Out buttons allow you to mark in and out frames for creating and extracting clips from the total
file. Pressing the Ctrl-Key and the In or Out button will clear the associated frame mark. The Create New
Clip And Add To MT option from the Video Clip Menu, creates a clip from the in and out frame markers and
adds the clip to the Video Track at the MultiTrack cursor position. The clip will be displayed as a video
entry on the Video Track in the MultiTrack. If there is an existing clip under the cursor position, the new
clip will butt-splice itself to the end of the current underlying clip. The Create New Clip And Insert To MT
option will force the new clip to cut itself into any underlying existing clip at the exact cursor position.

You may also use the Open Video File And Add To MT or Open Video File And Insert To MT options from
the Video File Menu to open a video file and place the entire file as a clip onto the MultiTrack in one simple
operation.

You may Double-Click any Video Entry on the Video Track and it will open that clip into Edit Mode. You
may then use the Re-Name or Delete Clip options from the Video Clip Menu, or remark in and out frames
and make new clips.

There are many options available in Edit Mode under the Video Convert/Extract Menu. The convert and
extract options use the In Frame and Out Frame settings to control the portion of the file that is included in
the operation. You may convert directly to DV/Avi Type 1 and Type 2 formats, with or without audio, or
choose the Convert To Custom Avi File option to select any compressor in the system for both audio and
video options. You may also extract audio to a Wav file from any portion of the video file, and then place
that audio on a track in the MultiTrack for further processing and mixing.

TimeLine Mode:
The Edit light will turn off when in TimeLine Mode. Left-Clicking in the MultiTrack will automatically
switch the viewer to TimeLine Mode. In this mode the viewer locks to the MultiTrack timeline and forces
the video playback in sync with the MultiTrack audio. The top client area of the viewer displays the current
Smpte Time in this mode, even if the MultiTrack is using a different TimeLine display mode.

Left-Clicking in the scrub zone at the bottom of the viewer allows you to scrub through all video clips on the
TimeLine from front to back. The scrub zone always represents the entire length of the session. Shift-Left-
Clicking near the red center line in the scrub zone will slowly jog the video forward or backward depending
on which side of the red line center position you are. The MultiTrack cursor position is locked to the viewer
position and will always remain in perfect sync with the viewer scrub position.



The play and stop buttons are active to play the MultiTrack. All MultiTrack audio and processing is played
in this mode. The step forward and backward buttons allow you to step, one frame at a time, in either
direction. Left-Holding one of these buttons steps the video in very slow motion, about 100 ms per frame.

Video entries on the Video Track may be moved and copied exactly like audio entries on the MultiTrack.
The in and out boundaries may be adjusted exactly like audio entries. All video formats can be handled
without conversion in the TimeLine Mode. Only DV format files can be live rendered to the Firewire output
without conversion. Individual file framerates will be automatically conformed to the MultiTrack framerate
setting. You will be warned if a clip does not match the current settings when the clip is placed on the
TimeLine. It is recommended that you set the MultiTrack project Samplerate and Smpte Framerate prior to
adding clips to the MultiTrack.

Clips may be arranged and adjusted on the TimeLine and then audio from those clips can be extracted, in
sync, directly to a selected HotTrack using the Extract Audio To MT option from the Video Convert/Extract
Menu. This option responds to a marked area of the MultiTrack, or the entire track if not marked. Select a
blank audio track, then activate this option and all audio will be extracted and placed on the track, in sync,
from each separate clip.

Other Features:
Many features of the viewer operate in both modes with slight differences. In either mode, you may Right-
Click on the video image display to popup information about the current video clip and/or file. The current
number of files and clips in the session is also displayed at the bottom of the info dialog.

The Delete All Unused Clips option from the Video Clip Menu will remove all clips and associated files not
being used in the session on the TimeLine. This can help keep the system memory and resources load to a
minimum, as each opened video file taxes the system through the use of DirectShow Filter Graphs. The
Delete All Clips option will completely clean the video clips and files database and allow you to start fresh.

The viewer may be zoomed to various preset standard sizes using the Zoom option from the Video Track
Menu. You may also size the viewer to any size by grabbing the window edges and dragging to the desired
size. The aspect ratio will be automatically maintained. The scaling is done with the DirectDraw interface
and maintains a high quality size adjustment to keep the video looking sharp.

You may render the final MultiTrack audio and video splices to a brand new DV/Avi file with the Render
To DV/Avi Type-1 File or Render To DV/Avi Type-2 File options from the Video Track Menu. All audio
assigned to Output Chan 1 is merged, in sync, with the video clips on the Video Track to build a single
finished video file. Video clips of different formats will be automatically converted to the DV format during
the render.

If your system supports FireWire (1394) ports, you may select a FireWire device by using the Select
FireWire Device option from the Video Track Menu. You may then select the Render RealTime To FireWire
option to send the video out to an external camera or converter box live, in sync, with all TimeLine or Edit
Mode operations. The FireWire device selection as well as the viewer size and position can be saved as a
default by using the Save Video Viewer Preferences option from the Video Track File Menu.

The live scrub and TimeLine FireWire output can sometimes jitter or skip while it attempts to maintain
perfect sync with the MultiTrack playback. To output a perfectly smooth final render to an external FireWire



device, you should use the LayBack To FireWire option from the Video Track Menu. This option opens a
finished rendered DV/Avi file and outputs it directly to the FireWire port using the port clock for a perfect
playback.

You may also capture DV video directly into the viewer from the FireWire port. You may use the viewer's
play button to toggle between capture and pause, allowing you to stream different video clips back to back
into one file if desired. The stop button completes the capture process and properly closes the file.

The Special Options selection on the menu offers a quick way to test your video system performance for the
current video file conditions. This works in both TimeLine and Edit Mode. The Test Static Seek Time option
measures how many milliseconds per frame it takes to seek independent frames one by one. This is how the
system works during scrub modes. The Test Running Seek Time option measures how many milliseconds per
frame it takes to seek successive frames that may be built upon information contained in the previous frame.
This time should be faster in most instances. This is how the system works during playback. The viewer
display size may influence these times considerably and you should try to adjust your viewer display size to
keep running times under 20-25 ms per frame, thereby not overly loading down the system, and allowing
plenty of remaining CPU time to maintain good MultiTrack performance.

* Two new SampleRate choices have been added to the MultiTrack SampleRate menu. They are 176400 and
192000.

* The Custom SampleRate option has been activated on the MultiTrack SampleRate menu. You may select
any rate between 3000 and 400000.

* SF and MT playback, when zoomed in below the 256 samples per pixel level, keep the playback cursor
frozen onscreen and automatically resets the play position back to the starting point, as in the original
design. A new function using the Shift-T-Key now allows you to transfer to the actual stopped playback
position while in this close zoom if desired.

* Enhanced performance of live layer switching.

* Smpte Format now saves with the preferences.

* The Select Mode Include Orphan Automation setting now saves with the preferences.

* The Zoom Mixer Label area may now be used as an available area to side scroll the mixer view by Left-
Dragging the mouse to the left or right edge of the window. This now works the same as the Full Mixer
View window.

* The Edit Input Box dialog used for entering various labels and values throughout the program has been
enhanced with the addition of an Ok zone on the TitleBar. Left-Clicking the Ok Zone in the upper right
corner of the window may now be used to close and accept the input, exactly like pressing the Enter-key.
Left-Clicking the Close Zone or outside the window or pressing the Esc-key will close and cancel the input.

* The Record Retake menu has been enhanced with separators between choices, making it easier to select the
desired option. A keyboard shortcut has also been added. Pressing the Backspace-Key after a recording will
activate the ReTake To Last Record Position option; Pressing the Shift-Backspace-Key will activate the



ReTake To Current Cursor Position option; Pressing the Ctrl-Backspace-Key will activate the ReTake All
option.

* The last record start play position is now retained, even after playing the MultiTrack to listen to the last
recording before utilizing the Record Retake option.

* The NumPad number keys are now assigned to zoom levels for the MultiTrack and SoundFile views. The
values are as follows: 1-Key = 1; 2-Key = 4; 3-Key = 16; 4-Key = 64; 5-Key = 256; 6-Key = 1024; 7-Key =
4096; 8-Key = 16384; 9-Key = 65536. Note that the keyboard NumLock mode must be active.

* The Control Track View window now includes a Jump To Control Track zone in the Client-Y area. It looks
like a capital letter C. Left-Clicking in this zone jumps the MultiTrack view directly to the Control Track.

* Moving and copying entries on the Control Track can now be done using the Backspace-Key and Ctrl-
Backspace-Key, similar to moving and copying automation entries on other tracks. Mark an area
surrounding the desired entries, place the cursor at the destination position and press the Backspace-Key to
move the entries, or press the Ctrl-Backspace-Key to copy the entries to the new position.

* The MultiTrack View Window now allows the use of the Q-Key to drop Cue Locations on the Control
Track at the MultiTrack position while playback is stopped or active. The Q-Key activates a Cue Location
command, the Shift-Q-Key activates a Cue Location / PreLoad command, and the Ctrl-Q-Key activates a
Cue Location / Play command. If Playback is stopped, a dialog pops up allowing you to name the cue and
also attach a Midi Note-On/Off trigger. Left-Clicking in the Midi Trigger readout pops up a menu displaying
the full range of Midi notes. There is also a Last Midi Input option that will accept the last Midi note played
from a keyboard or other Midi device. While the menu is active, the Client-Y area of the Control Track
View Window will display live, all incoming Midi notes above the Midi-Trigger column heading.

* The Control Track View Window now allows the use of the Right-Click and SpaceBar-Key to toggle
playback, and the Return-Key to preload playback or stop. This feature used along with the Cue Location
command creates an excellent markers list. Each Control Track command type has special leading characters
in the listbox to help locate them. The Stop commands will have '- - -' in front of the name. The Cue
commands will have '@' in front of the name, and the Midi commands will have '> ' in front of the name.

* The Control Track View Window now displays the popup Options Menu, by Left-Clicking on the blue
pyramid logo. Three options are listed; Set Midi Receive Chan, Set Global Play Midi Trigger, and Set
Global Stop Midi Trigger. The Midi Receive Chan selects a midi chan just for the Control Track commands.
The Global Play and Stop triggers allow you to set a Midi Note assignment to act as a global play and stop
command. When the system is cued and in a preload wait state, these keys can be used to start playback, or
cancel the preload.

* A new shortcut key for saving and updating the session has been added. Pressing the Ctrl-S-Key will save
and update the session. Please note the new arrangement of the session options on the File menu and the
slightly changed menu underlined keys for those options.

* Opening a Library EDL now offers repathing choices to find linked files in different locations. This allows
opening edl's across a network with automatic file link relocation.



* Multi-Selection ListBoxes have been enhanced to allow for multi-selection functions of up to 5000 items at
a time, with a warning message if you exceed those limits.

* The Save And Trim Session has been enhanced with the addition of three longer Region Handle options; 10
secs, 20 secs, and 30 secs. Be careful though, because these long handles could actually add length to the
overall trimmed session, depending on the session layout.

* All new MessageAnd Dialog Box routines that allow complete control over placement on dual screen
monitors. The Options Menu now contains a new option called Message/Dialog Box Position which opens
up a submenu of possible choices. The choices are: Top Left, Top Center, Top Right, Center Left, Center,
Center Right, Bottom Left, Bottom Center, Bottom Right and Follow Mouse. This choice can be saved with
the preferences.

* A new option on the Options Menu called Monitor Configuration opens up a sub menu with choices for
Single, Dual Left To Right or Dual Top To Bottom monitor configurations. This setting allows the program
to keep popup messages and dialogs that follow mouse positions from splitting across the gap between
monitors. This choice can be saved with the preferences.

* Enhancements to the FX API now pass Tempo Map changes along to the plug-ins and also allow the plug-
ins complete access to the Tempo Map storage data.

* The VST implementation has been enhanced to handle VST Virtual Instruments and SoftSynths. A new
option on the VST Window will offer a selection for a Midi-In Port if the plug-in is a sythn. You will need
to get your playback latency low in order to take advantage of these instruments. A setting around 4 buffers
at 256 size works pretty well. Make sure to have a blank region of audio farther down the track the synth is
patched into so Studio will not think the track is empty. Start MT playback and then the synth will be
playable. To record, assign the synth track simultaneously to another output track. Set that as a straight
device out. Patch a physical cable from the device out to the device in and then select that device on a track
to record. Use SRP-REC and you can play the synth and record to any track.

* A new option has been added to the File Menu called Save And Re-Path Session To New Drive/Folder. This
option allows you to browse for a new drive/folder and save a new edl, forcing all edl and video files to re-
path to this location. This option will close the current session when complete.

* A new Time Display Mode Toggle option has been activated. By Right-Clicking in the Time Display zone,
the time mode will toggle between the current and the last selected mode. For example, select Tempo mode,
then select Smpte Mode. Now Right-Clicking in the Time Display zone will toggle between the two modes.
The keyboard shortcut for this feature is the Ctrl-T-Key.

* The User Input Smpte Dialog and User Input Control Track Dialog now accept the Escape-Key for
canceling the input and the Return-Key for accepting the input.

* The Mixer Mono Switch has been enhanced with a popup menu of mono choices. Left-Clicking on the word
"Mono" next to the button pops up an options menu. The choices are: L Plus R (-6db); L Plus R; L Only; R
Only; L Minus R (-6db); L Minus R.

* A new option has been added to the MultiTrack Menu called MouseWheel. This option offers two choices:



HotTrack Inc / Dec and Zoom In / Out. This option saves with the preferences. This controls the behavior of
the mousewheel in the MultiTrack view. In either case, the Shift-MouseWheel will always control the
HotTrack in a page inc / dec mode.

* A new option has been added to the Library View File Menu called Add Selected To MultiTrack HotTrack.
This option adds the selected Library entries to the current HotTrack, back to back, one behind the other.
The shortcut key is the Ctrl-Insert-Key.

* The Regions View has been enhanced. When inserting Regions onto the MultiTrack from the Regions View,
using the Ctrl-Key with the Insert button or Insert-Key, now inserts the entries to the current HotTrack, back
to back, one behind the other. If a marked area has been defined, then each entry will be looped repeatedly
on the track for the length of the marked area. Multiple selected Regions will be looped onto successive
tracks.

* When using the Grid and Ctrl-Inserting a region in a marked area, the length of the region is now
automatically truncated to the grid length forcing all entries to add properly on the next grid point regardless
of whether the region length is too long to fit. This operation tracks tempo map changes. This makes
building a click track to tempo an extremely simple procedure.

* Two new shortcut keys have been added to the MultiTrack View to assist in doing minor fader adjustments.
The Greater-Than-Key (used by itself without the Shift) will increment the hottrack fader .25db. The Less-
Than-Key (used by itself without the Shift) will decrement the hottrack fader .25db.

* A new feature has been added when writing offline automation. Creating a marked area on the MultiTrack
and adjusting any console control that writes automation will now adjust the marked range to the new setting
and reset the old setting at the end of the range. This feature writes the new value at the Mark Begin position
and then writes the original value at the Martk End position automatically.

* A new channel Store/Recall menu has been added to the mixer views. Alt-Right-Clicking in any of the mixer
views pops up the Store/Recall menu. The options allow you to store all or part of the mixer channel settings
to one of four possible memory cell locations. You can then recall those settings from any of the memory
cells to the same or a different mixer channel. This allows instant copying of channel settings, including Fx
plug-ins with all the plug-in parameters between channels. If the recall channel is one of a selected group of
channels, the recall operation will duplicate the settings and Fx plug-ins on all selected channels. You can
also use this for a quick compare between different settings on a single channel. For example, storing
different eq settings to different cells, and then recalling them for an instant compare between settings.
These functions work during playback also for realtime comparisons.

* Narrowed the active mixer view edge value which controls side scrolling and stepping of the Zoom and Full
Mixer views when Left-Clicking near the channel edge. This should help eliminate non-intentional side
scrolls.

* A new option has been added to the MultiTrack Track Properties menu called Disable Track. Selecting this
option disables an input track and removes it from the multitrack load. Pressing the Ctrl-Key when
activating this option operates on all tracks. Activating this option on one of a selected group of tracks
operates on the selected group. This option saves with the session edl file.



* A new option has been added to the MultiTrack menu called Dbl-Clk Transfer To SoundFile View. This
option allows you to de-activate the MultiTrack Dbl-Clk Entry Transfer To SoundFile View feature. The T-
Key option is still available to perform the same function with the keyboard. This option saves with the
preferences.

Bug Fixes
* Adding Fx Plug-ins when the Hot Track is beyond the last audio track is now correctly trapped.

* Trapped extra loop cycles that could slow down MultiTrack Entry drawing under certain conditions.

* Fixed Left-Arrow and Right-Arrow Select Mode nudging.

* Fixed AuxSend Master Pans.

* Ctrl-Delete in the Regions View now correctly pulls all following MT-Entries forward.

* The Echo Delay plug-in now correctly processes delay-time automation changes.

* The Play-Mark and Play-Loop buttons now correctly update on screen redraws requiring preset conditions.

* Wide Mixer View selecting and clearing channels in the Client-Y area is now fixed.

* Label displays are now correctly updated in the Client-Y areas of all mixer windows when entering a new
label.

* Fixed BuildMix lockup that could occur with certain plug-ins that withheld massive amounts of data during
processing.

* Fixed lockups that could occur with multiple rapid undo's and redo's.

* Group interactions between the Wide Mixer and Zoom Mixer have been corrected.

* Recording filenames created from MultiTrack or Region labels are now correctly parsed for illegal
characters. The label will be left intact, but the filename created will replace illegal characters with a '-'. This
fixes problems which displayed a warning message about trouble opening or creating files during a record
operation.

* Trapped for empty key tracks when using dynamics keying across multitracks to fix possible program
crashes.

* SoundFile Edits in the SoundFile View now correctly free and reload any Ram cached connected Regions
and update the MultiTrack display.

* The Control Track View now correctly chases the Control Track Entries during playback.

* The Control Track View now correctly updates when editing entries with the tracks re-ordered.



* HotTrack Solo Mode now works correctly even when tracks are re-ordered with the Video or Control Track
at the top, or when the navigation hot chan link is turned off. Fixed broken links to different navigation
functions.

* Fixed MT Cursor display updating when overlapping windows in the MT while SoundFile View is actively
playing.

* Recording thru a stereo channel while the channel is assigned for delayed monitoring now correctly adjusts
the recorded region length for the delay. This helps eliminate region end boundaries that could otherwise go
past the end of the file length.

* Fixed the crash that could occur under certain conditions when slipping a marked area of multiple tracks by
using the Shift-Left-Hold within a marked area.

* Adding a new Locate Point now sets the EDL modified flag.

* Fixed interaction problem between Live Input Chan recording and SRP playback. This problem could cause
glitched record buffers with bursts of random noise.

* Adjusted routines that control the time display during playback to stop the time display numbers from being
corrupted under certain conditions when switching workspace views rapidly.

* Fixed crash that could occur when adding multiple Library entries to the MultiTrack at one time under
certain memory caching conditions.

* Fixed the Vst Load and Save Presets options.

Video Track Viewer 1.1
* Trapped crashes that could occur on certain systems with certain FireWire device drivers whenever an

attempt was made to access a FW device that was not powered up or plugged in.

* Fixed EditMode playback using the Render Realtime to FireWire option.

* Fixed EditMode Render Realtime to FireWire when the VideoTrack contains no video entries.

* Fixed possible lockups that could occur under certain conditions when stopping an EditMode playback.

>---<

Version 2.5

Enhancements
* A new option has been added to the TimeLine menu called Snap-To-Grid. This option toggles the snap-to-

grid on an off. Pressing the G-Key operates this option also. When this option is on, two vertical bars will



surround the current time mode display text under the time display area, and the cursor will snap to invisible
grid points based on the grid size set for each timeline mode. Moving entries will also snap along the grid
points forcing the enties to start on an exact grid point. This option saves with the preferences. The Ctrl-
Insert option of the Regions view (which adds the selected Region repeatedly along a marked area) will also
respond to the Snap-To-Grid mode making it easy to build a click track from a small Region of data.

* A new option has been added to the TimeLine menu called Auto Snap-To-Grid In Select Mode. When this
option is active, the snap-to-grid will be turned on every time Select Mode is entered, and turned off when
Select Mode is exited. If the grid was active prior to entering Select Mode, it will be left undisturbed. This
option saves with the preferences.

* A new option has been added to the TimeLine menu called Grid Settings. This option opens a sub menu
allowing you to set grid sizes for each of the TimeLine Modes. These sizes save with the preferences. Left-
Clicking in the current time mode display area (when Snap-To-Grid is active and the two vertical bars are
displayed) links directly to the associated TimeLine Grid Settings option, without the need to go through the
menus.

* A new option has been added to the TimeLine menu called TempoMap Settings. This option opens a sub
menu allowing you to change tempo parameter values at specific positions along the timeline, thus creating
a tempomap. This tempomap saves with the Edl session files. When not in Select Mode, you may use the
Shift-Right-Arrow-Key or Shift-Left-Arrow-Key to jump to the next or previous tempomap entry.

Set Tempo At Position sets a new tempo from this position forward to the end of the timeline or the next
tempomap entry. This entry is allowed only on beat boundaries.

Set Tempo To Marked Measures At Position sets a new tempo calculated from a marked area from this
position forward to the end of the timeline or the next tempomap entry. This entry is allowed only on beat
boundaries.

Set Time Signature At Position sets a new time signature from this position forward to the end of the
timeline or the next tempomap entry. This entry is allowed only on measure boundaries.

Set New Measure Count At Position sets a new measure count from this position forward to the end of the
timeline or the next tempomap entry. This entry is allowed only on measure boundaries. You may use this to
re-start the measure count at any value from 1 up to the current measure count. To clear a previously
changed measure count, simply enter the original sequential measure count value, which is the default value
displayed in the dialog.

Clear TempoMap Entry At Position clears the current tempomap entry. This entry is allowed only on an
exact tempomap entry boundary.

Clear Entire TempoMap clears the entire tempomap.

* The MultiTrack cusror position will now update to the final stop position even when the zoom level is less
than 256 where the cursor does not scroll duing playback. This behavior can be overridden by the Auto-
Rewind button. This behavior now remains consistent with the behavior when the screen is zoomed out
beyond the 256 ratio.



* The Regions View and Library View Title Bar region count now follows the currently selected group.

Bug Fixes
* FX automation is now correctly identified and handled with regard to View Filtered fades, clears, moves,

stretches and other manipulation.

* SRP punch-in on the fly now corrects and adjusts for possible negative region start values. This eliminates
corrupted region entries from being created during SRP punch-in..

* The SoundFile Sample Info view is now properly initialized whenever first displayed, even if no soundfile is
currently open.

* Marked Time, Relative Time and SoundFile View time now correctly ignore Smpte Start Offsets in Smpte
Display Mode.

* Edl files are now properly closed and released when all connected regions are deleted from the edl. This
allows file manipulation outside the SAW environment while SAW and the edl are still open.

* The Dynamics Key selection menu now correctly ignores track re-ordering and selects the proper channel
for keying.

* Fixed program crash that would occur when opening 34 or more record meters at once.

* Fixed lockup that could occur when using the auto-punch-in record feature and the Enter-Key was pressed to
exit the recording before the auto-punch-out position was reached.

* Closing a SoundFile in SoundFile View now breaks any active MultiTrack transfer cursor link.

* MultiTrack Cursor positioning initiated from an Fx plug-in now correctly chases mixer automation.

* Fixed the SRP or Rec buttons during a live punch-in/out on the fly from interfering with trigger or chase
sync operations.

* The Add SF options on the File menu no longer force the SoundFile View open when building missing peak
data files.

* Fixed Lockup that could occur when Right-Click stopping SoundFile playback at the precise moment that
the SoundFile runs out of data and stops automatically.

>---<

Version 2.4

Enhancements



* New Hi-Speed, Hi-Resolution Eq algorithm replaces the console Eq, Plug-In Eq and Dynamics Keying Eq
filters. The new algorithm effectively removes all low end dc offset and noise artifacts due to math
truncation and filter band interactions. It actually uses less CPU load at the same time it doubles the internal
math decimal places. It also extends the Bandwidth from .1 to 3 octaves. Take a close listen and enjoy the
new smoothness and transparency. Note that edls using the earlier console Eq or Studio Eq plug-in will need
to be re-adjusted because the sound changes might be noticable due to the more accurate algorithm. The
most noticable change will be in the old Q or Bandwidth setting. The old Eq affected a much wider range of
frequencies at the same bandwidth setting. The new algorithm uses a 6 db drop for the bandwidth cutoff
points, while the old algorithm used an approximate 3 db bandwidth cutoff point. I have included a routine
which detects the older edls and attempts to calculate new settings to maintain as close to the original curve
as possible. The routine also attempts to alter all Eq automation changes. In most cases this should work
fine, but you should listen closely and make any further adjustments you need. I think you will agree that the
inconvenience of re-adjusting older edls will be offset by the higher acuracy and extended functionality of
the new algorithm.

Note: Due to the Edl version changes, version 2.4 Edls are not backward compatible to earlier
versions. Keep copies of Edls if you plan on stepping back to earlier program versions.

* BuildMix To Current HotTrack operations now stamp the mix position in the new Region. This allows the
use of the Shift-Insert operation at a later time to insert the Region at its original synced position.

* Added a small enhancement to the FX API. The FX_BEGIN_PROCESS function now passes the current
index position in the patch listbox to the plug-ins in the FX_Handler_Int_Param1 variable.

Bug Fixes
* More work done to trap and eliminate internal resource and API function parameter errors.

* The Standard MultiMedia Driver Menu item is now correctly checked on startup and on a new preference
load if needed.

* More work done to improve stability of Hot-Patching plugins during playback.

* Reverse MT-Entries now correctly adjust when offset starting positions, softedges, vari-speed and
samplerate conversion elements are active.

* BuildMix To Current HotTrack operations with samplerate conversion are now correctly marked and placed
in the MultiTrack.

* Shift-Delete operations on Marked Area MT-Entires now work correctly on first entries and entries starting
at zero.

* Corrected SoftEdge values listed on MT-Entry popup menu for roundoff error on very small values.

* Fixed SoftEdges which take place on tracks which contain SampleRate Conversion or Vari-Pitch operations.

* Increased SampleRate Conversion resolution to improve roundoff error with all rate conversion calculations.



* Eliminated multiple device BuildMix operations from interfering with each other when SampleRate
Conversion was active.

* Adjusted Dynamics Gain popup menu to fit screen at 1024 resolution.

* The SoundFile Sample Info view is now properly initialized when first displayed.

* SoundFile Record Mode now correctly restores focus to the SoundFile View after closing the Record Setup
window.

* Tempo settings now correctly save with the session edl files.

* Fixed MultiTrack waveform display slowdown when zoomed in close which was caused by disk access
changes in version 2.3.

* More work done to eliminate the MultiTrack display bug that causes track information display corruption
under certain random conditions.

* Library Views can now correctly open SAWStudio or SAWStudioLite Edl versions in either program.

>---<

Version 2.3

Enhancements
* The Options Menu has been altered to now include an option called Driver Model. This option opens a sub

menu displaying a choice of driver models. The Standard MultiMedia choice is the common Windows
MultiMedia driver mode. The Hi Performance MultiMedia choice eliminates certain redundant diver
function calls during playback/record operations for slightly higher performance possibilities. Not all
soundcards support this mode. The DWave Protocol is an original driver model offering much more direct
communication between the soundcard and the application for very high performance possibilities. This
mode is currently still under development.

* A new option has been added to the Options Menu called Auto Monitor Switching Protocol. This option
pops up a sub menu which allows support for various proprietary monitor switching protocols to be selected.
This option allows SAWStudio to control automatic punch-in monitor switching for various soundcards that
have implemented a proprietary method of such control. The only current choices are Off and the RME ZLM
Protocol for use with RME soundcards. This option saves with the preferences file.

* When Browsing for missing files, the Browse dialog now displays the full path of the missing file in the
titlebar to help you with your search.

* Improved Disk Thread routines for more than double sustained playback performance.

* Improved Disk Thread routines for a significant increase in recording performance on slower drives.



* Improved Playback PreLoad routines for faster preload times.

* Low level engine re-design now allows SoftEdge entry overlap to be any length. SoftEdge crossfades can be
30 secs if desired, still implemented in realtime with no background stem files built. Note that for the length
of each overlap, the track count increases by one... so be careful of overrunning your machines track load
capabilities.

* The Automation Gallery current folder can now be saved with the preferences.

* Sync Trigger now detects and ignores backwards timecode which is sometimes generated by certain decks
while rewinding.

* Repeated Double-Click transfers from the MultiTrack to the SoundFile window will no longer require an
extra click to make the MultiTrack window the active window.

* The Auto Zero Cross option has been added to the Options Menu. When activated, marking and splitting
functions will perform an automatic zero cross detection. This will snap the cursor to the nearest zero cross
point before performing the operation. This option saves with the preferences.

* The MultiTrack Play Mark and Play Loop buttons have been activated. The end position and loop are not
sample accurate or seamless due to the numerous MultiTrack routing and effects processing options that
might be engaged at any time.

* Moving and snapping marked automation entries now responds to selected tracks, performing the operation
across multiple tracks at once.

* Stretching marked automation entries now responds to selected tracks, performing the operation across
multiple tracks at once.

* Deleting marked automation entries now responds to selected tracks, performing the operation across
multiple tracks at once.

* Copying a marked area to another layer now responds to the Ctrl-Key for all tracks, or selected tracks,
performing the operation across multiple tracks at once. Vari-Pitch and SoftEdge data are now also copied.

* The Copy Marked Area To Layer option has been enhanced. New Regions will now only be created for
Regions which do not completely fit within the marked area. If there is no marked area, the entire track is
copied, using the current Regions unmodified.

* A new menu option has been added to the popup Select Mode Properties menu called Include Orphan
Automation. When this option is activated, automation entries that are not attached (within the boundaries of
a Region entry) that lie between the first and last selected entries will be included in the operation.

* Brightened the hi-light at MT-Entry boundaries for easier visual of entry cuts.

* Two new options have been activated on the popup Track Properties Menu called Slip Track To Cursor
Position On Current Layer (Marked Area) and Slip Track To Cursor Position On All Layers (Marked Area).



These options will slip a marked range of track forward or backward to the MT cursor position. Pressing the
Ctrl-Key when activating these options will affect all tracks. Or, if the current hottrack is also a selected
track, all selected tracks will be affected. These options adjust all entries and automation within the marked
range. If the marked range begins or ends within a region boundary, the region will be split at the range
begin or end position depending on the direction of the slip. The first option works only on the current layer,
the second option does all layers.

* When in normal display mode, a marked range on the MultiTrack may now be grabbed and slipped forward
or backward. All entries and automation within the range will be affected. If the current hottrack is also a
selected track, all selected tracks will be affected. If the marked range begins or ends within a region
boundary, the region will be split at the range begin or end position depending on the direction of the slip.

* When auditioning regions from the Regions View or Library Views, the region length is now displayed in the
Marked Time readout display in the MultiTrack window.

* Deleting mutliple Regions in the Regions View is now quite improved in performance.

* Vari-Speed and Vari-Pitch adjustments made during playback will now keep the value entry window
onscreen so you may continue making fine adjustments without having to popup the properties menu again
and again.

* Two new options have been added to the popup MT-Entry Properties Menu called Sweep Vari-Speed To
Destination Value and Sweep Vari-Pitch To Destination Value. Both of the these options will cause a
smooth sweep of the Vari-Speed/Pitch factor by splitting and adding regions within a marked area, each
with a slightly incrementing or decrementing Vari-Speed/Pitch value. The marked area may not span the
starting entry boundaries and you must be careful about expanding entries running into the next separated
entry. If you do not acheive the desired results, simply use the undo option and try again with altered
settings.

* A new option has been added to the File Menu of the Library Views called Add Selected To MultiTrack.
This adds the selected entries to the MultiTrack at the cursor position starting from the HotTrack and
continuing in sequential order downward. The Insert-Key is the keyboard shortcut for this option.

* The Dynamics Key control on the console now displays channel labels to make selecting the key channel
easier.

* Added new GeneralMidi Midi Control Template.

* A few new options have been added to the popup Track Properties Menu. The Remove Silence From Track
(Or Marked Area) options will strip silent sections of audio from solid tracks of data. The Automatic
selection immediately splits and removes the silent regions, while the Split/Mark selection turns on Select
Mode and selects (marks) the regions to be removed. You get to look at the details and when ready, simply
press the Delete-Key to remove them. These options also respond to selected tracks and will perform the
operation on all selected tracks at once. You may also mark an area on the MultiTrack to limit the range of
the operation. These options use default settings for the Attack, Release and Threshold settings applied to
the algorithm. These may be set and saved with the preferences. If you activate the Gate on any track, you
may override the settings for that track by adjusting the Gate settings.



* Added support for the Tempo settings in the FX API. This has now been updated to Version 1.1.

* Two new options have been added to the File Menu called Add SoundFile To MT and Add SoundFile As
Region. Both of these functions operate just like their counterparts without actually opening the file into the
SoundFile View, thus keeping the SoundFile View from popping up on top.

* The View Menu has been adjusted so each view has a unique key letter assignment. The views may be
selected by pressing and releasing the Alt-Key and then pressing the V-Key to select the View Menu, then
pressing the unique key value for the view of interest.

* More stationary buttons have been enhanced with a momentary flash to signal their activation.

* A new option has been added to the Process/MixDown Menu called BuildMix To Fx Modules. This option is
similar to the other BuildMix options except that SAWStudio does not create any output files directly. It
performs the mix and passes all data through the Fx modules allowing Fx modules to create their own
special output data as files or as a CD burn.

* The Record Meters will now scroll within a fixed window size. If the Record Meter window right edge
expands to the max screen horizontal border as you add more record meters, the meters will offset within the
existing window size. You may scroll the meters left or right to see meters that are not visible by pressing
the Left-Arrow-Key or Right-Arrow-Key. You may also Left-Click the mouse near the left or right edge of
the Record Meter window to single step the meters or you may Left-Hold the mouse and push on the left or
right edge of the Record Meter window to smooth scroll the meters continuously. You may also use the
Wheel Mouse to scroll left or right. If an F-Key is saved with the Record Meter window active and
positioned, whenever that F-Key is used, the Record Meter window will position and lock to that max size.
As you add more meters than will fit in the preset window size, the offset action will occur.

* Any Record Template loaded or created within a session will now save with the Session EDL file. When
you later open that session the Record Template settings will also be loaded.

* Activating a record track in the MultiTrack on an untitled session will now popup the Save As dialog
prompting you for a folder and session name before recording linked files.

* Two new options now appear on the Options Menu called Activate TCP/IP Rcv Mode (Host) and TCP/IP
Port. These options are the beginnings of an exciting new TCP/IP remote network and internet hosting
capability being introduced into the SAWStudio engine. This is still under development and in the near
future will allow third party companies complete control of the SAWStudio interface from a remote
interface of their own design. These options currently only have meaning to other developers working with
this new control protocol along with Bob. These options should be left off, as they offer no benefits to the
user at the current time.

Bug Fixes
* 2.3 Maintenance Fix to eliminate crash when building a mix file using plug-ins that alter buffer sizes, like

time compression.



* 2.3 Maintenance Fix to eliminate crash when console dynamics are keyed from an empty track.

* The Record SRP punch-out routines have now been modified to eliminate system hangs when the session is
heavily loaded. This should correct all lockup problems with auto-punch recordings as well as manual SRP
punch-in/out recordings. Once a punch-out is in progress, the cursor will change to the hourglass mode and
all subsequent transport controls will be blocked untill all new entries have been dropped to the MultiTrack.
This can take a few seconds on loaded sessions. Wait till the cursor turns back into the arrow mode before
proceding with other commands.

* The Record routines have been re-designed to handle heavier loads without glitching or loosing data on
route to disk.

* Record Buffer Overruns are now properly trapped and will shutdown recording.

* Menu command access through the keyboard is now correctly locked out during playback/record.

* The Save And Trim Session function is now trapped for zero length files and regions.

* Copying multiple MT-Entries to an earlier TimeLine position will now correctly include the last MT-Entry
on the track, if it is also part of the selected group.

* Double-Click transfers from the MultiTrack to the SoundFile window are now correctly trapped when Select
Mode is active.

* Chase Trigger Mode is trapped from re-starting when a MultiTrack playback overrun message is onscreen.
When the message times out, or is cancelled by a mouse click, the chase trigger mode is re-engaged. This
prevents lockups on overloaded chase trigger sessions.

* Adjusted code to correct an FX corrupted data warning when using a default mix template with pre-patched
plug-ins, after new plug-ins have been added or old plug-ins removed from the system.

* Missing Pst Patch Plug-Ins will now correctly display in the Pst FX Patch window.

* Missing FRes Patch Plug-Ins will now correctly display in the FRes FX Patch window.

* Eliminated trapped mouse zones that lie under overlapping windows. Now active controls will stay latched
even as they move beneath overlapping windows and release the latched mouse when the mouse button is
released.

* Keyboard focus now returns to MultiTrack after popping up the Record Setup Window.

* Certain Vari-Pitch keyboard value entries which would cause incorrect calculations are now corrected.

* Removing and clearing entries from the Final Res patch window is now handled correctly when the current
Hot Track is not an output track.

* Copying a marked area to another layer will no longer complain about zero length regions when the marked



end position resides on an exact region boundary.

* EQ Freq changes made during playback now correctly max at the nyquist frequency for the current session
samplerate.

* The Dynamics Key control on the console is now correctly trapped during playback. This setting must be set
when in a stopped condition.

* Fixed Mutes On Panasonic WR-DA7 Midi Control Template.

* FinalRes patches that alter the buffer size are now correctly trapped in playback and buildmix operations.

* Fixed overspill waveform drawing in SoundFile View Sample Edit Mode.

* Adjusted Alt-FKey programming to accept the workspace even without a visible active window.

* Ajusted FKey restore to properly restore the Main window settings that were saved with the FKey.

* Routine modifications to enhance region altering function performance while Region Memory Caching is
active.

* Max Track Length calculations now correctly include trailing SoftEdges.

* Region Memory Caching now correctly adds the proper amount of extra data needed to support the SoftEdge
settings and file rate and Vari-pitch factor for the connected MT-Entries. If more than one entry is linked to
a common Region with different SoftEdge and VP Factor settings, the Region will not be cached.

* Inserting entries to the MultiTrack now correctly updates the insert cursor position if it is altered for any
reason during the insert operation.

* Selecting a view from the View Menu, now correctly changes that view to the active window.

* Save And Trim Session has been modified to correctly handle SoftEdges on MT-Entries of different Vari-
Pitch Factors and SampleRates.

* Fixed Live Input Channel init routines that could have caused faulty device assignments when multiple live
input channels were active.

* User Input special dialog boxes now correctly disable all windows to trap all input except for the dialog box
itself.

* The Exploded Mixer View Dynamics Gain Reduction Meter now correctly resets when playback is stopped.

* The Exploded Mixer View now correctly tracks the height of the Main Window.

* Corrected Return and Output Track re-assignment of FX Patches when reading SAWStudio sessions into
SAWStudioLite.



* Re-designed the Shutdown routines to eliminate random crashes on program exit in Windows 2000.

>---<

Version 2.2

Enhancements
* Vari-Speed/Pitch Setting and Clearing has been enhanced. You will be prompted if there is a conflict

because of expanding entry size. You may choose to adjust all following entries to accomodate the expanded
size or force the setting to adjust to accomodate the largest expansion it can without moving following
entries. Butt-Spliced Entries will be treated as a single group unit. This applies to Select Mode multi-entry
operations also, and the prompt answer will apply to all entry conflicts that follow.

* The MT-Entry Properties Menu has a new option add called Reverse Audio. This option reverses the audio
of the MT-Entry when active. This option responds to multi-selected entries in Select Mode also.

* The File Menu session section has been re-organized to add a new option called Blend Session. This option
allows you to blend an existing session with the current session in two different ways.

If you offset the MultiTrack cursor to a section of blank tracks underneath the current session tracks, you
can blend the existing session information in sync with the current session information. The session being
blended will offset each element to the new track and cursor position. Global data for each track being
blended will be applied as long as the underlying track was empty at the time of the blend.

If you offset the cursor position to the end of the current session, new data being blended will be offset in
position, but global data for the track will not be applied, since there are already global settings for tracks
that already have data in front of the newly blended data. In this case, the new global mixer default data will
be written in as automation entries at the start of the blended data.

Automation data will be blended into its new proper location.

Currently, FX Plug-in data will not be blended.

* Enhanced disk handling routines to eliminate cache slowdowns on repeated play areas.

* Adjusted Region Memory Caching to leave at least 128 megs of physical ram for the operating system.

* Re-designed the MTLoad calculation to use the High Performance micro-second timers. This allows for
greater accuracy and also eliminates the 59% readout problem on the duals.

* The MultiTrack I, R and O zones have been enhanced. Alt-Left-Clicking in one of these zones jumps you
back to the last selected hottrack for that section. This allows you to jump to the output section, for example,
and then immediately jump back to the last hottrack you were working on in the input or return section.



* The Exploded Mixer View is now transparent to F-Key changes. This view will remain onscreen in its
current position as an always ontop window.

Bug Fixes
* Expanded Variable Storage arrays to handle driver callbacks with less chance of overruns on heavy CPU

loads.

* Fixed multi-channel record problem on dual processors which would cause random dropped buffers.

* Trapped auto SRP punch-in from causing zero length regions when the SRP is started past the marked area
punch-out position.

* Scaling the SoundFile View waveform display with the Up/Dwn buttons during SoundFile Fixed Position
Scroll Mode now correctly redraws the fixed playback position marker.

* HotTrack Solo Mode now works correctly with the wheel mouse and the Right-Hold-Scroll operations.

* Record FileNames are now checked for duplicates and the duplicate names are appended with an '_a' to help
differentiate them during the recording process. You should still avoid using duplicate track labels and try to
keep this from happening.

* TimeStamped MT-Entries should now behave correctly when dragging and copying them on the
MultiTrack.

* Multiple Recording meters of different formats will now display correctly if lower numbered tracks are dis-
armed.

* Trapped Divide By Zero error that could occur with the Video Viewer immediately after opening a file that
could not be decompressed.

* SAWStudioLite versions now correctly display Record and BuildMix Setup Windows, allowing proper
access to each filename.

* Any attempted FX Buffer Size Change in a Final Res FX Patch now stops the MultiTrack and displays a
warning message.

* Clicking on an Exploded View channel FX Patch zone, now pops up the patch window so that it is never
covered up by the channel strip itself.

* FX Plug-in automation is now properly initialized during a BuildMix operation.

* SampleRate Conversion range has been increased and trapped to warn in cases of out of range parameters.
11025 to 48000 range conversions will now work correctly.

>---<



Version 2.1

Enhancements
* Mtc Sync Trigger and Chase Trigger modes are now active. The operation of the trigger modes is

interwoven into the interface in a very transparent manner. A new Sync Light display has been added to the
top of the MultiTrack under the Solo Light. This light flashes yellow whenever a trigger mode is activated
and waiting for sync. The Mark/Relative Time display changes to a Waiting For Sync display and shows the
incoming timecode reading during the lock-up phase. When the trigger point is reached, the Sync Light turns
green.

Activating the Mtc Trigger Sync Mode from the Smpte/Midi menu sets the system ready to read incoming
timecode for triggered MultiTrack playback or recording. This mode only looks for external sync when you
first press the SpaceBar-Key or Return-Key. The Sync Light flashes yellow notifying you that the system is
waiting for external timecode to start the MultiTrack operation. You may press the SpaceBar-Key or Return-
Key again to cancel the waiting mode. You may also override the waiting by Right-Clicking or pressing any
play or record buttons to immediately begin the operation.

The system reads the incoming timecode and immediately jumps the MultiTrack position to the proper cue
point, then adjusts the position by the Trigger Advance and Latency Adjust values, pre-loads the data and
starts playback when the timecode reaches the cue position.

This is a one time operation. When the MultiTrack is stopped, you are free to edit and play without the
external sync until you initiate the waiting sequence again with the SpaceBar-Key or Return-Key.

Activating the Mtc Chase Trigger Mode, allows for more unattended operation. The Waiting For Sync mode
is started automatically, with no intervention from the user, and when the MultiTrack is stopped, the Waiting
For Sync mode is automatically activated again. You are still free to edit and play without the external sync
even while the system is waiting.

In either mode, when record meters are open, the system automatically activates a record operation and
punches in at the cue point. Depending on the Sync Trigger Record = SRP option, SRP mode is engaged. If
you have a marked area, SRP is always engaged and an auto punch-in and out will occur in that section.

You may also Left-Click on the Sync Light to temporarily toggle the Trigger Mode on and off. The system
remembers the mode it was in when it toggles off and resets the same mode when it toggles on.

* A new option has been added to the Smpte/Midi menu under the Smpte /Mtc Sync sub-menu called Mtc
Trigger Sync Advance. This option determines how many seconds of pre-load time is added when
determining the trigger point. On fast systems with smaller session loads, you can set this value to 2 or 3
seconds. On dense sessions which take a few seconds to pre-load before playback, you should set this value
to 4-6 seconds. If this value is set too low, the session will miss the trigger point and simply drop out of lock
and stop the operation. This value saves with the preferences.

* A new option has been added to the Smpte/Midi menu under the Smpte /Mtc Sync sub-menu called Mtc
Trigger Sync Delay Frame Count. This option determines how many frames are thrown away when the first
sync signals arrive.This allows you to adjust for skewing problems as a tape deck with sync code comes up
to speed or a sync generator that creates initial noise or spikes when first started, before settling down to a



steady code output. This value saves with the preferences.

* A new option has been added to the Smpte/Midi menu under the Smpte /Mtc Sync sub-menu called Mtc
Trigger Sync Latency Adjust. This option allows you to compensate for Midi latency by offsetting the trigger
point by a certain number of subframes. This allows you to adjust for inherent system delays and gain a
more accurate sync. This value saves with the preferences.

* A new option has been added to the Smpte/Midi menu under the Smpte /Mtc Sync sub-menu called Sync
Trigger Auto Format Detect. This option activates a format auto detection function when sync is first
received. If this option is on, whenever a new format is detected in the incoming timecode, the format is
changed to match and the MultiTrack is re-cued. If this option is off, you may preset the format and it will
not be changed even when timecode is received in a different format. This can be useful for receiving 29.97
MTC code for instance, because there is no provission in the MTC protocol to define this format. This value
saves with the preferences.

* A new option has been added to the Smpte/Midi menu under the Smpte /Mtc Sync sub-menu called Sync
Trigger Auto Stop Detect. This option activates the auto stop detection function. If this option is on,
whenever incoming sync trigger timecode is lost for any reason, the program dis-engages any active
MultiTrack operation. This value saves with the preferences.

* A new option has been added to the Smpte/Midi menu under the Smpte /Mtc Sync sub-menu called Sync
Trigger Record = SRP. This option initiates an SRP record operation whenever active record meters are
present and a trigger sync function is engaged. This value saves with the preferences.

* The Sync Light is also used for sync generation operations. Whenever a generate sync option is activated, the
Sync Light will turn green during any operation that is generating sync.

* When using the Shift-Key to remove a selection from the recent file list, the list will automatically clear and
popup again, ready for the next removal or selection operation.

* Inserting multiple entries directly to the MultiTrack from a Library View window is now enhanced for
speed. Waveforms are drawn at once instead of looped over and over one at a time.

* The file header check routine has been enhanced to accept most Broadcast Wave files. These can now be
opened and appended properly in the SAWStudio environment.

* Every Region created by recording directly into the MultiTrack, now maintains its original time-stamped
position. Inserting the Region later by the Insert To MT zone or the use of the Insert-Key, works as normal
and inserts to the current cursor position. Using the Shift-Key when inserting with either method, forces the
insert at the original time-stamped position. All time-stamped Regions display the '@' symbol after the
name.

* SoundFile View playback will now respond to live re-positioning of the playback cursor. Left-Clicking to a
new playback position within the file will immediately jump the playback cursor and continue playback at
the new location.

* Marked Area begin and end boundaries may now be altered live during loop playback in the SoundFile



View.

* A new option has been added to the Options Menu called SoundFile Fixed Position Scroll Mode. When this
mode is active, SoundFile View playback will center the playback position and live scroll the entire
waveform display past this fixed play position. If you zoom in below zoom level 8, the display will resemble
a realtime oscilliscope.

* A new Solo Mode has been added to the interface. Left-Clicking on the Solo Light at the top of the
MultiTrack turns on Hot Track Solo Mode. The light turns solid red and the current Hot Track is soloed.
Changing to another Hot Track automatically causes the solo to follow, always keeping the Hot Track
soloed. The solo buttons are locked out when this mode is active. You may change Hot Tracks from the
MultiTrack, Full View or Zoom View mixers. Left-Clicking on the Solo Light again, turns this mode off.

* A new option has been added to the Edit Menu called Recover EDL Undo. This option allows you to see all
undo files (.u01 - .u99) for each session in a folder. You may select any one of them trying to recover a
session that was somehow lost or corrupted.

* The SoundFile View Sample Info display window has been adjusted for smoother display updates with less
screen flashing.

* Midi Control and Midi Sync ports have been enhanced to perform full merging and splitting of sync and
control data. Both ports may now be the same, although keeping them separate is still highly recommended.

* SoundFile View Top Client Area buttons now flash when clicked for positive feedback to the user that the
button was activated.

* Added the Ctrl-OK option to skip all similar warnings to the first File Repath dialog that is displayed when a
file can not be found in its edl referenced position.

* Vari-Speed/Pitch Clearing has been enhanced. You will be prompted if there is a conflict because of
expanding entry size. You may choose to adjust all following entries to accomodate the expanded size or
bypass the operation. This applies to Select Mode multi-entry operations also, and the prompt answer will
apply to all entry conflicts that follow.

* A new feature has been added to all mixer views. You may now click into any of the meter displays to
popup a Meter Options Menu. The Clear Current Meter Peaks option will clear the current meter's peak
limit displays. The Clear All Meter Peaks will clear all meter's peak limit displays.

Bug Fixes
* Modified code in the MME driver callback threads to block multi-processor callbacks from creating an out

of sequence pattern for multi-in/out driver channels. This should eliminate glitching on multi-channel
operation with multi-processor machines.

* Final Res patches are now sending the correct Bytes Per Sample data to the plug-ins.

* The Peak Data File refresh routine has been corrected to eliminate problems with files of certain exact
boundary byte counts.



* The Goto Smpte Position function now works correctly at 24 and 25 frame formats.

* Fixed a problem with moving entries on high number tracks in EDL's with tracks re-ordered in certain
configurations.

* Multiple FX automation entries at the same location will no longer cancel similar entries out.

* The MultiTrack cursor now correctly re-draws after moving the MultiTrack window.

* Multiple clicks on the Solo Mode Light when no solos are active are now properly trapped and will not foul
up the solo mode display.

* Copying an MT Marked Area to another layer, now correctly bypasses warning messages about underlying
entries on the destination layer.

* Copying Selected Entries to another layer from all tracks (using the Ctrl-Key), now correctly bypasses
warning messages for tracks not containing selected entries.

* Corrected access rights problem when using the Directory of Wav Files option in a Library window to
reference a CD-ROM drive.

* Canceling a multiple selection Import from a Library window now correctly exits the loop.

* Regions added to a full Regions View listbox window will now correctly scroll the listbox to make the
added Region visible in the list.

* Midi Hardware Fader Controllers will now properly bank switch and chase the mixer hot channel even when
tracks are re-ordered out of sequence.

* Undo files now retain the Mark Begin and End positions.

* Scrolling the SoundFile View left or right when zoomed to the maximum sample edit mode level now works
correctly.

* Mixer Meter peak limit displays will now remain accurate, even when changing hot channels.

>---<

Version 2.0

Enhancements
* Pre-Release status has been removed.

* This marks the first release version of SAWStudioLite.



* ZeroCross detection has now been added. Pressing the Z-Key in an active SoundFile in the SoundFile View
or with the MultiTrack Cursor over an MT-Entry in the MultiTrack View now finds the nearest ZeroCross
lowest energy point within 800 samples on either side of the cursor. In the MultiTrack, the ZeroCross point
is found by searching the resultant file contents after applying any SampleRate coinversion or Vari-Pitch
factors first.

* The Save And Trim Session command has now been enhanced to automatically delete pre-existing trim files
when you re-do a trim session. This allows you to make multiple tries on the same trim and not continue to
increase the size of the new trim files.

* FX Patch windows Track Label areas have now been extended to the window right boundary, allowing
displays of long label names without being cut off.

* SampleRate, Dither and Resolution changes will now set the session modified flag which causes prompting
to save the session when closing the current session or exiting the program.

* The Pan processing now responds to slope values, creating smooth pan automation with no clicks or pops.

* A new menu option has been added to the Automation menu called Set Default Pan Slope. This option sets
the default slope value used for pan controls. This value saves with the preferences.

* When Automation mode is active, pressing the Backspace-Key will snap a marked group of automation
entries to the current cursor position. Pressing the Ctrl-Backspace-Key will snap a copy of a group of
marked automation entries to the current cursor position. Pressing the Left-Arrow-Key or the Right-Arrow-
Key will nudge a marked group of automation entries in the respective direction.

* Right-Clicking on the MultiTrack or SoundFile View Zoom+ or Zoom- buttons, now pops up a zoom
selection menu allowing you to go directly to any specific zoom level referenced as Samples per Pixel.

* Using the keyboard entry option of the Enter Smpte Value dialog box now automatically advances to the
next input selection after typing 2 characters without the need to press the Tab-Key.

* New key modifications for consistency have been included. The Full, Zoom and Wide Mixer views now
respond to the Shift-Ctrl-Left-Arrow-Key and Shift-Ctrl-Right-Arrow-Key to jump to the previous and next
console sections. The Tab-Key is no longer used for this operation. The Wide Mixer view now also responds
to the Ctrl-Left-Arrow-Key and Ctrl-Right-Arrow-Key to jump to the first and last console channel.

* The Full, Zoom and Wide Mixer views now respond to the Tab-Key, Shift-Tab-Key, Ctrl-Tab-Key and Shift-
Ctrl-Tab-Key exactly the same as the MultiTrack view, controlling jumps to MT-Entry boundaries and
Automation Entry positions.

Bug Fixes
* All mixer views now correctly update when entering MultiTrack labels.

* Using Auto SRP punch-in with the record file open in the SoundFile View will no longer cause an exception
error.



* Transferring the MultiTrack Cursor Position to and from the SoundFile View now correctly accounts for
SampleRate and VariPitch factors.

* The Vst PlugIn Window track number now displays correctly.

* All scrolling modes are now correctly cleared if MT playback stops due to a CPU overload.

* Traps have been put into the Memory Region and PeakData caching routines to bypass zero length entries.

* Splitting Vari-Pitched MultiTrack Entries at certain positions no longer displays entry too large warning
messages.

* Fx Automation data is now corrected for re-ordered or missing Fx modules.

* Adding multiple entries to the MultiTrack at one time will no longer interfere with the Region Memory
Caching option.

* Fixed Record Filename adjustments after saving a session with a new name.

* The Enter Label box now correctly remains inside the right screen edge boundary.

>---<

Version 1.9 Pre-Release

Enhancements
* Alternate F-Keys are now active. You may create alternate F-Keys by pressing Alt-Shift-FunctionKey and

recall these alternate F-Keys by pressing Alt-FunctionKey. Two new options are available on the File menu
under the F-Key File option called Open Alternate and Save Alternate. These options open an F-Key File to
the alternate F-Keys and save an F-Key File from the alternate F-Keys.

* You may now add an effect to any of the FX windows without causing the effect to automatically open its
setup window by Shift-Left-Clicking on the FX window Add button.

* The Exploded Mixer View window is now an ON-TOP window which will not get covered up by other
windows. It is also responsive to channel marking by Left-Clicking and Alt-Left-Clicking and clearing by
Right-Clicking in the ClientY area, similar to the Zoom Mixer View.

* You may now enter channel labels by Shift-Left-Clicking in any of the mixer view label display zones. Ctrl-
Left-Clicking in the mixer label zones will continue advancing automatically to the next channel until you
cancel the operation by closing the edit box with a Left-Click or by pressing the Esc-Key.

* When opening an EDL that has trouble finding its files, you will now be prompted to try auto re-pathing to
the drive the EDL resides on, or go directly to a Browse window to pick an alternative search path yourself.
If your EDL resides on the drive where the soundfiles are, simply clicking OK will automatically find and



re-path all the files. If the files cannot be found on the EDL drive, you will be prompted again and given a
second chance at the Browse window to manually setup a new search path. You will be prompted again for
each missing file and be allowed to enter up to 10 alternate paths.

* Library Windows are now automatically cleared when closing a session. Opening a new session will fill
Library Windows with any links that were originally saved with the session or clear the Library Windows if
the session contained no Library links.

Bug Fixes
* Deleting automation entries on Return and Output tracks is now fixed.

* Mute automation initialization on output tracks is now fixed.

* SRP recording under heavy load should no longer glitch or spot noise into the recorded files.

* Added code to eliminate potential PeakData file corruption under heavey SRP loaded session overdubs.

* Added code to trap bad punch in offset calculations before they migrate to the added region entry
boundaries. This should help in stopping random corrupt MultiTrack entries after an SRP punch-in.

* Added code to stop playback buffer overruns on heavy loaded SRP sessions when the punch-in file is
opened and therefore being updated in the MultiTrack during the SRP punch-out operation.

* Default Mix Templates now correctly update out of order channel modules when closing a session.

* The Solo Mode Flashing Light status now correctly follows undo and session changes.

* The Echo module now correctly initializes Cross Mode, if set, when opening a session.

* The Exploded Mixer View now correctly responds to currently marked group channels.

* The MultiTrack Label Edit box now correctly displays the proper Input, Rtn, or output track in the titlebar.

* Modified shutdown routines to handle proper close down of complex sessions before exiting the program.

* Fixed EDL Open problem for edls with all six Library Windows active.

* Full size softedges now behave correctly at any playback start position.

* Closing a soundfile now correctly clears the SoundFile View titlebar.

>---<

Version 1.8 Pre-Release



Enhancements
* Aux Send Controls now follow the Chan Fader Taper curves.

* Midi Control Fader Packs now follow the Chan Fader Taper curves.

* A new option under the Mixer Navigation Links menu called Mixer Views To Hardware Controller, now
links the current mixer HotChan to a hardware controller. Every time the HotChan is changed, the controller
will follow aligning the first fader to the HotChan. This option saves with the preferences.

* Enhanced the MotorMix Midi Control Template to give access to all 6 aux sends using the rotary knob
adjusters coupled with the rotary selector knob.

* The XY Pan has been enhanced with individual node point control. You may now click on each of the 8
node surround points on any channel, and the node will toggle between active and inactive. The node turns
red when it is inactive. When a node is inactive, audio from that XY Pan will not feed that particular output
bus. You may use this feature to keep music out of the center channel for instance. These nodes may be
automated, allowing you to toggle them during automated playback.

* The Mixer has been enhanced with the addition of Solo and Mute buttons on the Output Tracks. The solo
routines have been modified to allow the mute switches to be free from the solo operation, thereby allowing
mute automation to still function correctly even on soloed tracks. The output and input solos may be
operated together, and output group solos may even be nested with individual channels still contained within
the group. The routines keep an internal updated count on each channel that is soloed, no matter where from.
Whenever any solo is activated, a new flashing Solo Mode Light in the top right corner of the MultiTrack
client control area will keep you informed. You may Left-Click on this flashing light to automatically clear
all active solo switches.

* New Timed message display notices for Saving and SnapShotting sessions, and for Buffer Overrun and
Underrun conditions.

* New Offset features have been added to the MT-Entry Properties menu. When an entry offset has been set,
using this entry as the Key Entry during Select Mode move and copy operations and pressing the Alt-
Backspace-Key, causes the offset position to be the reference for the current destination cursor position. The
Set Offset To MT Mark-Beg Position option allows you to set an internal offset reference for the entry. Set
the Mark Beg position to the desired offset position within the entry boundaries and select this option. The
Jump To Offset Position option jumps the cursor to the current offset position. The Clear Offset Position
option clears the current offset. The offsets save with each entry in the edl files.

* Improved the speed of adding multiple selected Regions to the MultiTrack in normal or loop mode.

* MultiTrack selected tracks and Mixer selected channels are now cleared when closing the current or opening
a new session.

* Enhanced the SRP/Rec operation to automatically force the playback loop, even if all tracks are empty. This
now allows for Smpte Gen recording even on an empty MultiTrack. The first record meter track assignment
is used, and it must be assigned to a valid output path.



* The Spacebar-Key and Enter-Key now function in all Mixer Views the same as the MultiTrack View to
control playback and record operations.

* The Automation F-Key and Shift-F-Key have been enhanced. These keys create a fade to next automation
entry, and normally default to the channel fader. If, however, you pick any other control type and activate the
View Filter to display only that type, these functions will create a smooth transition on that control type also.

* The Zero Locate point now creates an undo file and saves with your session files.

* The Control Track has been activated. This track at the bottom of the MultiTrack can be used to hold
Control entries that can influence the MultiTrack play and record functions and also send Midi commands to
external devices. Control entries are displayed as vertical colored lines in the Control Track. You may move
entries by enclosing them in a marked area and then Left-Dragging to a new location. Tapping the Right-
Mouse-Button while dragging sets the copy flag which then copies the entries at the new location. You may
also clear entries within a marked area by pressing the Delete-Key.

The Control Track View window is available from the View menu or by Left-Clicking in the Control Track
label area. The Control Track window allows access to the various Control Entry Types and also displays
the current entries in listbox format in sequential fashion as they are positioned along the timeline.

The Control Track window will chase the current cursor position in the MultiTrack. Left-Clicking an entry
snaps the MultiTrack cursor position to that entry's position. Left-Double-Clicking an entry in the listbox
opens up the entry edit dialog box. You may select single or multiple entries in the listbox and press the
Delete-Key to delete the selected entries.

Left-Clicking in the Built-In Cmds zone will pop up a menu of command types. Selecting a command then
pops up a dialog box with the various parameters applicable to that command type. You may change any of
the parameters that are displayed in yellow text and Left-Click the OK zone to enter the command at the
current MultiTrack Cursor position. Command parameter string formats are displayed for each command
type under the parameter string zone.

The current command types are as follows:

Stop Playback
This command causes playback to stop at this position.

Stop Playback / PreLoad
This command causes playback to stop at this position and then does an immediate MultiTrack preload and
waits for your command to activate playback.

Stop Playback / Cue Next
This command causes playback to stop at this position and then cues to the next Cue Location position.

Stop Playback / Cue Next / PreLoad
This command causes playback to stop at this position and then cues to the next Cue Location position and
does an immediate MultiTrack preload and waits for your command to activate playback.



Cue Location
This command sets the current MultiTrack Cirsor position as a cue point.

Midi Program Change
This command sends a Midi Program Change command to external devices.

Midi Note On
This command sends a Midi Note On command to external devices.

Midi Note Off
This command sends a Midi Note Off command to external devices.

Midi Note On / Off
This command sends a Midi Note On followed by an immediate Midi Note Off command to external
devices.

Midi Hex String
This command sends a Midi string of Hex numbers to external devices.

Midi Dec String
This command sends a Midi string of Decimal numbers to external devices.

Bug Fixes
* Changes made to the thread shutdown routines to adjust for differences in Win ME and Win 2K. This

should eliminate lockups and other random fault errors when exiting the program.

* The new scan EDL routine has been modified to handle bad file handles correctly.

* Re-designed Mixer View display routines to eliminate many repeated zone clipping function calls to
Windows responsible for random screen display updating problems.

* More work done to control Open and Save Dialog Boxes. They should now open near where the mouse
pointer is, be modal and lockout other commands and windows while active, and not allow duplicate boxes
to open simultaneously.

* The MT Track Properties menu is now correctly trapped from popping up on the Video and Control tracks.

* In the MT, the Ctrl-Up-Arrow and Ctrl-Down-Arrow now jump to the top track and bottom track, regardless
of track order.

* Fixed crashes caused by the XYPan on Return Tracks.

* Fixed XYPan Center from trashing the output data when set to zero db.

* When zooming in past the peakdata display during playback the cursor will now correctly display in a frozen
position until you zoom back out into the peakdata information.



* The MT cursor no longer dissapears when changing HotTracks with RecRdy engaged.

* Writing an offline automation entry now properly flags the mixer readouts to update the chase correctly
when moving to an earlier position without ever moving to a later position first.

* Bringing files into the current session from a Library window will now check for peakdata files and refresh
them if needed.

* Meter display routines have been corrected to keep stray meter images from occuring when switching
channels during playback.

* Eq Hi / Lo Cut switch parameter data for multiple Eq patches now saves and restores correctly.

* The LTC Smpte generated signal is now properly delayed to match the MultiTrack playback when live input
channels are active.

* Opening a new session now correctly clears the Full Mixer and Zoom Mixer Titlebar reference to any
previously opened Mix Template files.

* Using the File Update command on an untitled session now correctly transfers and updates the new session
name entered in the file dialog box.

* The PeakData Memory caching routine has been modified to detect bad regions before trying to load them,
helping to eliminate crashes.

* Soloed channels will no longer interfere with automation of mute switches.

* Src Load display values now adjust for the end of disk data and will properly display a zero value from that
point till the end of the session instead of the 99% value.

* Mixer settings are now correctly updated on screen when playback starts or position is altered after making
manual override changes in non-Auto Mode following previously written automation of the same control
type.

* When deleting overlapping automation entries using the View Filter, all entries within the marked range will
now be correctly deleted.

* Automation moves and copies across different module types are now correctly trapped.

>---<

Version 1.7 Pre-Release



Enhancements
* An exciting new feature has been added to the Mixer menu called Chan Fader Taper. This option allows

you to select from different fader control tapers that affect how the fader reacts in its sweet spot.

Standard Log is the new default and it is a true log taper reacting very much like a long throw physical
console fader in its movement to db ratio. There is a comfortable working range in the center of the fader to
make finer adjustments to db level changes.

Expanded Log expands the sweet spot around the zero db position to allow for smaller increments in db
changes with longer movements of the fader in both directions.

Condensed Log condenses the sweet spot closer towards a more even or linear reaction near the zero db
position.

Linear is the original SAWStudio default, which creates an even scaling of motion to db changes.

Custom is a special selection that allows you to alter the way the fader reacts in 5 actual scaling zones. When
selecting this option, an exploded view of channel 1 is displayed and the main fader will show three nodes
along the right side of the fader zone. These three nodes control the +6db, -12db and -36db points starting
from the top down. The +6db node controls the plus section of the fader above the zero db position,
providing two separate scaling areas above and below the node. The other two nodes control the reaction of
the fader below the zero db position, providing three more scaling zones. By grabbing these nodes and
sliding them you can control the actual stretching or shrinking of the various zones and determine how the
main sweet spot center area of the fader reacts to movement. You may also select one of the preset tapers
while this special edit mode is active which will allow you to start with them as a basis for building your
own taper. The custom taper is updated when you close this special exploded view window.

Selecting any one of these options and then saving your default preferences will save your selected fader
taper and use it as the default way the faders react each time you open the program.

* The Full Mixer View Link Zones now display patch bars in the Eq, Dyn and Fx zones. The Dyn zone
displays Gate Switch info in the left side of the zone and Compressor Switch info in the right side of the
zone. The Fx zone displays Pre Patch info in the left side of the zone, Post Patch info in the right side of the
zone and FRes Patch info in the center of the zone..

* The Dynamics Gate has been enhanced with a Rvrs button. This button causes the gate to operate in reverse.
When the signal is greater than the threshold, the gate closes down to the floor setting and when the signal
falls below the threshold, the gate opens back up to full. This can be used to create a simple and powerful
ducking processor by assigning the key to another track which will then control when this track lowers its
level. Set the floor value to the desired ducked level and adjust the attack, release and threshold to control
the overall timing. You can also use this mode with self keying to create a new sounding limiting effect.
When the signal rises above the threshold on loud transients, the gate will lower the level to the fixed floor
level. This sounds different than limiting or compression, because the transient is actually dropped below the
level of the rest of the average signal.

* The Open Session function has been enhanced with automatic Network and local drive file path re-routing.
If a file is not found at the original stored path, the EDL file network drive or local drive info is substituted



and the file open is attempted again. If that fails, then the Browse option will be displayed. This new
enhancement allows for a session to be easily moved to a new drive, with no user interaction required to find
the file paths, as long as the EDL is also located on the new drive. Saving the opened session will now save
the new substituted paths. This will also work fine for access across the network, because the network
naming convention will still operate fine from the local drive the session is stored on.

* Record Template information is now saved with the Mix Template files, thereby maintaining a complete
matched set of mix and track layout data with preset record input assignment data.

* The Record Input Assignment has been enhanced. Every track will now remember its last input assignment
and automatically begin with that assignment when record is activated again on that track. You may override
the assignment at any time by clicking on the Input Zone on the record meter or by engaging record with the
Ctrl-Key to recall the current active Record Template. If another meter is already opened with the same
assignment, then the track will auto assign the next higher available input.

Closing the Record Window of all meters will no longer affect the current active Record Template. You
must close the window while pressing the Ctrl-Key to override the current or create a new template.

Pressing the Shift-Key when activating a Record button will clear all previously saved track record input
assignments and engage the auto-assign mode assigning the next higher available input.

* The speed has been enhanced for the Import EditList File function.

* The Automation F-Key Fade operations have been enhanced and added to the Automation menu. The F-Key
will fade down or up to the next automation change or create a fade stretched within a marked area. The
Shift-F-Key will always force a fade up to the next automation change or create a fade up stretched within a
marked area. If no start or end automation change is present, the defaults will be set to mute for the start and
zero db for the end.

* The MultiTrack Change to Active Window is now altered when Automation Mode is active and will process
functions without the need for a second click. This can make it quicker to adjust a mixer control and then
position the MT cursor, then adjust a mixer control again and positon the MT cursor again etc.

* The FX API has been enhanced to allow Plug-Ins to request a Key Buffer directly from any channel and to
control the Solo status of the virtual console for use with a Key Listen switch.

* Session File parameter info is now scanned for changes and automatically updated when opening a session.
This allows for file format swaps within projects without playback problems.

* The channel Aux Sends have been enhanced. Ctrl-Left-Clicking in the Up/Dwn Arrow Zones now
increments and decrements the fader value by 1db instead of .25db.

* A new option has been added to the Mixer menu under Navigation Links called the Full And Zoom Mixer
Views To Wide Mixer View. This option breaks or activates the link between the Full and Zoom mixer views
and the Wide mixer view.

* The Tempo TimeLine Display Mode has been activated.



* Four new menu options have been added to the TimeLine menu under the Tempo Settings option.

Set Tempo allows you to set a default session tempo.

Set Tempo To Marked Measures allows you to mark any number of measures from the waveform display
and automatically calculate a reference default session tempo from the length of the marked area.

Set Time Signature allows you to set a default session time signature.

Set Tick Resolution allows you to set a default session tick beat resolution.

Bug Fixes
* Open and Save Dialog Boxes are now forced on top and will no longer dissapear behind other windows

when the mouse or F-Keys are pressed.

* Fixed Final Res Fx Patches from sending the wrong position information to the FX plug-ins.

* Console Dynamics Gain Reduction Meter has been fixed for more acurate tracking.

* Fixed the Dynamics keying routine to properly detect the end of the key track and clear the key buffer from
that point on.

* Fixed the Dynamics Key Listen switch from possibly toggling into an opposite solo condition when solo's
are toggled OFF separate from the Key Listen switch.

* Added more traps to stop crashes when accessing bad EDL files.

* The EDL Modify Flag is now correctly set when using the Fade To Next Automation Entry operation.

* The channel main faders in the Wide View have been fixed to include the Ctrl-Left-Click in the Up/Dwn
Arrow Zones to increment and decrement the fader value by 1db instead of .25db.

* Fixed incorrect MT-Entry updates when updating a Region from the SoundFile View that is used in the MT
with possible Vari-Pitch/Speed or SampleRate conversion.

* Trapped condition where no active track is assigned to a valid output.

* Copying selected MT-Entries to another layer now correctly copies SoftEdges also.

* Negative VariPitch values now enter correctly.

* Remaining Record Meters will now correctly continue to track their respective inputs even after other
meters are individually closed.

* Setup windows no longer display a Close button in the top right corner of the title bar, thereby forcing you



thru the Cancel or Ok zone to close the window.

* Fixed minor screen display problem with the MultiTrack Master track image under ceratin conditions of
MutliTrack screen scrolling.

* Fixed the crash caused by Left-Clicking on Track Number 1 and then Alt-Left-Clicking to select track 1
again.

* Fixed the F-Key redraw problem when MultiTrack is exactly the same size between multiple F-Keys.

>---<

Version 1.6 Pre-Release

Enhancements
* MultiTrack Playback PreLoad is now active. Pressing either the main or NumPad Enter-Key will now

preload the MultiTrack and wait for the next Enter-Key press or Left-Click OK in the message box to start
playback. Pressing the Esc-Key or Left-Clicking Cancel will cancel the playback.

* The Regions View has been enhanced with a new feature to link a Region to all MT Entries that reference it.
In the Regions View press the Tab-Key to immediately link and snap the MultiTrack to the first use of the
Region. Pressing the Tab-Key again will snap to the next use of the Region... and so on. If you select a
different Region and press the Tab-Key, the incrementing usage count will reset to the first entry usage for
the new Region. Pressing the Shift-Tab-Key on any Region will reset the usage count to the first entry usage.

* The Wide Mixer View navigation has been enhanced. Pressing the Tab-Key now jumps the view to the next
mixer section. Pressing the Shift-Tab-Key jumps the view to the previous mixer section. Pressing the Home-
Key jumps the view to the first chan. Pressing the End-Key jumps the view to the last chan.

* A new Window View has been added called the Automation Gallery View. This view allows you to create
and use Automation Preset Files. Left-Clicking the File button in this window opens a popup menu of
options. The Open Directory Of Automation Files allows you to pick a folder containing .aut files. The
filenames then list in the Gallery listbox. Left-Clicking on a selection displays a thumbnail view of the
automation stored within the file. Left-Double-Clicking a selection or Left-Clicking the Insert To MT button,
inserts the automation into the MultiTrack at the MultiTrack Cursor position. Pressing the Insert-Key does
the same thing. If you mark an area of the MultiTrack, the automation is inserted and sized to fit within that
area. Automation Mode must be active for the insert to function.

The Save Automation File option allows you to name and save a marked area of automation from the
MultiTrack, for later retrieval.

The Clear Gallery Window clears the listbox and the thumbnail display.

The Gallery window can be included in F-Key workspace views.



* Double-Click or T-Key linking an MT-Entry into the SoundFile View now sets the SoundFile View Device
Out to match the assignment routing of the entry's track. This follows subgroup output routing, thereby
allowing you to hear the SoundFile View raw playback through the same device that the MT playback routes
the entry to.

* A new item has been added to the Mixer Menu called Full Mixer Label Position. This option allows you to
place the Full Mixer vertical labels at the Top, Center or Bottom position within the label area. This option
saves with the preferences.

* The channel main faders have been enhanced. Ctrl-Left-Clicking in the Up/Dwn Arrow Zones now
increments and decrements the fader value by 1db instead of .25db.

* MouseWheel support has been added. In the MultiTrack, the Wheel will scroll the view up and down
changing HotTracks by one increment per Wheel click. Pressing the Shift-Key at the same time will change
the view one page at a time. In the Mixer Views, the Wheel will scroll the view left and right changing
HotChannels by one increment per Wheel click. Pressing the Shift-Key at the same time will change the view
one page at a time.

* The I, R and O Jump Zones at the bottom of the MultiTrack have been enhanced. Shift-Left-Clicking in one
of these zones will jump to the next track in sequence of that section and keep incrementing until the end of
the section is reached, at which time the jump will start at the beginning of the section again. These jumps
will follow the physical sequential order regardless of how the tracks are re-arranged.

* Modified F-Key View SAWStudio_1280x1024.fky. Check it out for a look at some new suggested enhanced
workspaces.

Bug Fixes
* The FX Patch Windows now correctly chase the Wide Mixer View.

* Fixed displays of random meter bitmaps that could occur when switching mixer views under ceratin
conditions.

* Adjusted FilePath Setup edit boxes to be non-sizable.

* Fixed PeakData File corruption during recording under certain special conditions.

* Fixed Fault that could occur when using Record Retake All before ever engaging record.

* The Record Meter Window is now properly closed down when Closing the session or Opening a new
session.

* Fixed Smpte Generation problem which was causing bitmap headers to be overwritten. Random crashes
would then occur on screen redraws.

* Sync generation now works correctly in Record Mode. When any Sync Generate mode is active, pressing the



Record button now also latches the SRP button automatically to activate the sync generation mechanism.

* Fixed the Wide View window from forcing itself to the left monitor when doing an F-Key restore on a dual
monitor setup.

* Fixed input edit window from displaying left-over message display prompts that are not part of the current
data input.

* Modified the Save EDL Undo routine to notify user of trouble with the default EDL Undo path and to stop
giving focus to the MultiTrack at the end of its operation.

* Fixed program setup edit boxes so they will allow proper editing in Win2000.

>---<

Version 1.5 Pre-Release

Enhancements
* The MultiTrack Engine has been optimized for dual processor performance boosts. A new option has been

added to the Options Menu called Force Single CPU. This option allows you to force the engine back to one
CPU if desired for testing and comparing or to allow other apps full use of the second processor. This option
will be grayed out and disabled on single CPU machines.

* The Smpte/Mtc Sync options have been added to the Smpte/Midi menu. You may use these options to
generate Smpte LTC timecode to any selected stereo audio device out. The device is selected in the Sync
Device Setup option in the Options menu. The software generated timecode is extremely precise and
maintains exact sync with the audio device clock. The Output Chan controls for the specific device out
allow you to route and adjust the timecode data level. The Output Chan will be automatically labeled and
assigned as a device out. This option will also output a Smpte Stripe file as part of the BuildMix operation.

You may also choose to generate MTC Midi Timecode through any selected MIDI out port. The port is also
selected in the Sync Device Setup option in the Options menu. The software generated MTC code can then
be routed back to a MIDI In port on the same computer or to another computer or hardware sequencer to
lock MIDI Sequencer playback to the MultiTrack playback. Smpte LTC and MTC Timecode can be
generated separately or at the same time. These settings save with individual EDL files.

If Smpte Generate is active, the MultiTrack start position will be adjusted to fall on the next exact frame
bnoundary when playback or a BuildMix operation is started. If Mtc Generate is active, the MultiTrack start
position will be adjusted to fall on the next exact Even boundary.

* The Set Smpte/Mtc Start Offset option has been added to the Smpte/Midi menu. This option allows you to set
the Smpte/Mtc Start Offset from a Smpte Input Dialog Box. The dialog box allows you to adjust the
individual Smpte parameters in a number of ways.

Left-Clicking in the right side of a parameter display zone increments or decrements the value by one



depending on whether the mouse position is above or below the vertical center of the zone.

Left-Holding the mouse in the right side of a parameter display zone changes the cursor to a +/- shape that
then allows you to increment or decrement the value by pushing or pulling the mouse position from vertical
center. The further from center that you push or pull, the faster the movement. Right-Clicking during this
operation will reset the value to zero.

Left-Clicking in the left upper portion of a parameter display zone pops up a menu list of all possible values.
The default value is bolded and the current value has a checkmark displayed next to it.

Left-Clicking in the left lower portion of a parameter display zone latches keyboard entry mode. You may
now type the values and press the Tab-Key to jump to the next zone. Pressing the Return-Key accepts the
values and exists the dialog. Pressing the Escape-Key cancels any adjustments made and exits the dialog.

Each parameter zone has a Lock zone above it and Left-Clicking these zones toggles the zone between
locked and unlocked mode. When a zone is locked, the value is displayed with gray text and the zone is no
longer adjustable.

There is also a Default To Keyboard button that can be latched so that each time the dialog is opened, you
are automatically set to keyboard mode and can begin typing immediately.

Left-Clicking the Close zone in the upper right corner of the dialog will cancel any changes made and exit
the dialog.

* While in Smpte Mode you may Left-Click in the Time Display Readout in the MultiTrack Top Client area to
popup the Input Smpte Dialog Box. Entering a Smpte position will jump the MultiTrack cursor to that
position when the dialog is closed without canceling.

* The Dither options are now active.

* All Split MT-Entries functions across multiple tracks have now been enhanced for faster operation.

* All MultiTrack Delete functions that pull following entries forward now update the MT-Cursor position to
the start of the deleted entries position.

* All Meter options now save with the preferences.

* A change was made to the use of the Shift-End-Key when selecting entries in Select Mode. Pressing the
Shift-End-Key will now select all entries from the last selected entry (or first entry) to the end of the set of
butt-spliced entries on the current hottrack, instead of selecting all entries forward and backward to the end
of the track.

* A change was made to the use of the Shift-Home-Key when selecting entries in Select Mode. Pressing the
Shift-Home-Key will now select all entries from the last selected entry to the beginning of the previous set of
butt-spliced entries on the current hottrack, instead of selecting all entries forward and backward to the end
of the track.



* Adding a Plug-In to any of the Fx Patch windows will now automatically open the Plug-In for adjustment.

* The Add To MT zone in the Regions View has been changed to Insert To MT to reflect the keystroke
connected to it.

* A new feature has been added to the Insert To MT operation. When using the Insert To MT button in the
Regions View or using the Insert-Key in the MultiTrack View to add a Region or group of Regions, you now
have the option of adding automatic multiple copies of the Regions to form a repeating loop. By pressing the
Ctrl-Key when activating the insert operation, the Regions will be repeated down the length of a Marked MT
Area.

* The = Key can be used to center the cursor in both the MultiTrack and SoundFile views.

* Midi-Control Template options have been moved from the Smpte/Midi menu to the File menu.

* The Shift-PgUp-Key in the SoundFile View will now scale the waveform up. The Shift-Ctrl-PgUp-Key will
scale the waveform to max. The Shift-PgDn-Key will scale the waveform down. The Shift-Ctrl-PgDn-Key
will reset the waveform to zero db.

* The SoftEdge Limit has been extended, depending on the samplerate.

* The Slope Values are now set in milliseconds rather than sample count.

Bug Fixes
* Automation fades on Return Tracks will no longer cause Page Fault errors.

* Fixed Vari-Pitch routine bug which could cause random page fault errors when toggling Offset Mode with
Wave Display active.

* Fixed Offset Button display to properly reflect Offset status when MT Window is updated.

* Stopped Native Plug-Ins from stealing the window focus during arrow key track changes in the MultiTrack.

* Shades saved in the default preference file will no longer be lost when re-saving the default preferences
again.

* MT-Entry Delete operations which pull following entries forward, now correctly adjust automation entries
also.

* All MessageBox prompts now display as TopMost windows so they will not be hidden behind other
windows.

* Adding MT-Entries that can cause conflicts under certain conditions are now correctly trapped.

* Changing Shades will now correctly maintain the MultiTrack track height.



* Using the Ctrl-Tab-Key and Ctrl-Shift-Tab-Key to move between automation entries has now been corrected
to properly handle the first and last entry.

* The Echo Plug-In now correctly re-syncs delay times when using the Right-Click option to match left and
right settings during playback.

* Fixed Error Trapping for disk write problems during recording.

* Trapped MT play lockup bug when user interaction initiates a stop action at the same time as the end of the
session initiates an auto stop action.

* Moving or copying Automation Entries now correctly saves an undo.

* Copying Automation Entries to the left on the same track, now correctly adjusts and blends with Automation
Entries earlier on the timeline.

* Fixed crash on playback problem when opening a session with a track containing data only on a layer other
than layer 1 and that layer is the default starting layer.

* Fixed layer display problem that caused the screen to not update properly when covering over the layer
display area under certain conditions.

* Restoring SAWStudio from the TaskBar now correctly restores all windows.

* Out Assign Switches on grouped Output Channels now work correctly.

* Modifications to keep menu bar from graying out in Win ME and Win2000.

* Modifications to label font parameters for a clearer display in Win ME.

* Modifications to keyboard edit boxes to force default selection of entire entry in Win ME.

>---<

Version 1.4 Pre-Release

Enhancements
* The VST PlugIn protocol is now active. The VST PlugIns list in Green in the FX Choices listbox. Only VST

PlugIns that supply their own graphic interface will be listed and usable. A solution for generic VST PlugIns
which depend on the host to supply the graphic interface can be found at <www.SpinAudio.com>. Their
inexpensive program called VST SkinRack can wrap these plugins in numerous and nicely done graphic
skins which will then list and function directly in SAWStudio.

* The FX Choices listbox Group option has been activated. This option allows you to group your PlugIns into
up to 30 named groups. As groups are created, they are automatically saved to disk for exact recall the next
time the program is run.



* The Delete Region(s) function in the Regions View is now hooked to the Undo.

* The FX Final Resolution red patch is now active on the Output Tracks. This patch should be used only for
special output type converters like a CD Burner PlugIn or File Converter (like MP3) PlugIn. It will not allow
buffer size changes and it processes after the dither and soft-clipping routines. If it adds gain, you could clip
the final output.

* The virtual console Gate Threshold, Gate Floor and Compressor Threshold will now display reference lines
in the MultiTrack Waveform display area and the SoundFile display area. In the MultiTrack, the MT Cursor
must be over an active region and in the SoundFile view, an open soundfile must be present.

* The FX API has been enhanced to pass the neccessary window parameters to the plugins so they may
display reference information in the MultiTrack and SoundFile waveform display areas.

* The FX API now includes automation. PlugIns that follow the automation spec can be completely automated
in exactly the same manner as the mixer view controls.

* The DirectX and VST PlugIn windows now include an FX Bypass icon in the top left corner. This allows
each effect to be individually bypassed and this control is automated.

* The Eq PlugIn has been enhanced to the new API automation spec. The interface now offers SAWStudio
type parameter control, including the popup menu list of all settings. The frequencies for each band now
include the entire range from 40 to 15k with many smaller increments in between. The bandwidth now
ranges from 1/10 to 3 octaves. All parameters can be automated, except the reset switch.

* The Echo PlugIn has been enhanced to the new API automation spec. The interface now offers SAWStudio
type parameter control, including the popup menu list of all settings. Echo Delay Times will now display a
reference line offset from the current cursor position when being adjusted in both the MultiTrack View and
the SoundFile View. All parameters can be automated.

* Jump To Mark Beg and End functions have been added to the MultiTrack. Ctrl-Left-Arrow-Key jumps to the
mark beg position and Ctrl-Right-Arrow-Key jumps to the mark end position.

* The SpaceBar-Key and Return-Key have been activated for controlling a recording operation. In the
MultiTrack, when record meters are active, the SpaceBar-Key begins SRP operation, the Return-Key
punches in and out, and the SpaceBar-Key stops the operation. Just pressing the Return-Key starts a straight
record operation and the SpaceBar-Key stops the operation. In the SoundFile Window, the Return-Key starts
recording and the SpaceBar-Key stops.

* Vari-Speed/Pitch options have been added to the MT-Entry Properties menu. These allow individual MT-
Entries to be played back at different speeds without affecting adjacent entries. Speeding up an entry will
also pitch it up and shorten its length and vice versa. This is not a Time Compression or in-place Pitch
Shifting algorithm. Alt-Right-Clicking or Left-Right-Clicking over an entry in the MultiTrack pops up the
MT-Entry Properties menu. You may set a Var-Speed factor in hundreds of a percent, or a Vari-Pitch factor
in hundreds of a semitone. You may also mark a small area with the Mark-End position at the desired MT-
Entry end position and the factor will be calculated automatically. You may adjust the factor to half or twice



the original entry length. When an entry has a vari-speed/pitch factor attached to it, the entry will display a
small white mark in the top left corner of the displayed entry rectangle. You may also clear the factor with
the Clear Vari-Speed/Pitch option.

* The Shades option has been added to The File Menu. You may use this option to load different graphic
libraries that we call Shades, which completely control how the SAWStudio interface looks. The first
available is called Pewter which presents quite a striking and different look to the interface. You may use the
Reset Back To Original Vintage option at any time to switch back to the original SAWStudio interface
graphics. Whichever graphic library is onscreen can be saved with the Preferences as the default. More
Shades will be available for download soon as a fun add-on to the SAWStudio environment.

* More work was done on thread balancing to enhance the ability to resize windows while under heavy
playback load.

* The Import EditList option has been enhanced to maintain its own path and pass its imported filename to the
Save Session options as a starting default name. Mutes are now recognized with the import.

* Track Labels have been added to the FX Patches windows for easy identification of tracks.

* Active Library File windows now save with the Session EDLs. When openeing an EDL which contains
active Libraries, the affected Library windows will be reset to their saved sate. This will close out any
current Library information in that same window. All Library windows that were not active in the EDL will
be left in their current state.

* A new option has been added to the Regions Menu called Export Region(s) To SoundFile(s). This option
allows you to export multiple selected Regions in the Regions View to individual multiple SoundFiles. You
will be prompted for a destination folder and then asked whether or not to create SAWStudio PeakData Files
also. The files created will be named the same as the Region names. (Illegal filename characters will be
substituted with an underscore character). If any destination file already exists, you will be promted to
overwrite or cancel the operation. If you press the Ctrl-Key and answer Ok, all similar warnings will be
skipped.

* The Wave Display Mode now saves with the preferences.

* The EDL Undo Snapshot feature (Star-Key on Numeric Keypad) now overrides the Auto EDL Undo option.
This allows you to turn OFF Auto EDL Undo for quicker editing when sessions are loaded down with tracks
and plugins, and still create an instant undo backup file anytime you wish by simply pressimg the Star-Key
on the numeric keypad.

Bug Fixes
* Files with the Read-Only flag set will no longer cause page faults when opened into the SoundFile View or

for normal EDL operation. They will now be trapped only for record or other write operations.

* The Session Modified Flag is now correctly cleared when usimg the Close Session menu option.

* Grabbing marked areas in the MultiTrack to drag and drop a copy elsewhere, now correctly adjusts the



boundaries when the source entry is not at a zero start position.

* SoundFile SampleEdit mode, broken in version 1.3, has now been corrected.

* Opening an improper Library EDL format file no longer closes the current session by mistake.

* Automating groups of switches at the same time will now correctly maintain channel separation and switch
action throughout the entire group.

* The AVI Video Viewer now correctly only links to movement within the MultiTrack window.

* Entering MultiTrack Labels now correctly refreshes the Return and Output Track Label area.

* Aux Send 5 on the input modules now correctly increments and decrements when using the mouse in the up
and dwn zones.

>---<

Version 1.3 Pre-Release

Enhancements
* Six Library View windows have been added to the program. These windows can be used to open sound

effect EDL library files or other EDL files to link or import regions into the current session. These windows
can be saved in the F-Keys for quick access to regions in other EDL files. Left-Clicking the File button in
one of these windows will allow you to open or an EDL file Regions list or a directory of .wav files into the
window. This will not disturb the current session. You may now audition and view these entries in the
SoundFile View exactly like the normal regions in the Regions View. Left-Clicking the Group button will
allow you to change groups if the EDL has been saved with active groups. Left-Clicking the Link button, will
instantly add the selected entries from the Library window into the current session's Regions View window.
These regions are now part of the current session, with their soundfile reference still looking at the original
Library source soundfiles. Left-Clicking the Import button, will add the entries to the current session and
copy the original source soundfile data to a new destination file that is now part of the current session. A
File Dialog box allows you to accept the default import filename (which paths to the current session name)
or change the name and path to one of your choosing. The base filename will be altered to reflect differences
in file formats as the regions or .wav files are copied. A 500ms blank zone will be added in front of and after
the new region copy to allow for adding soft-edge ramps later. The actual region boundaries are not altered
and do not contain this seperator blank zone. The Import function frees up the current session from any
references to the original Library soundfiles. You may also select entries in the Library window and use the
Insert-Key to link the entries directly into the MultiTrack starting at the current cursor position and
HotTrack. Multiple selections are placed on successive tracks. Drag and Drop to the MultiTrack is also
active by Alt-Left-Clicking an entry to grab it and then drag it to a position in the MultiTrack and Left-
Clicking again to drop it.

* The Save And Trim Session option has been added to the File Menu. This option is completely automatic
allowing you to save the current session to the same or a different folder and trim out all areas of the
soundfiles that are not used in the session. All unused regions are removed also. There are 5 choices for the



Region Handles extra data settings. Region Handles save extra data on each side of the region boundaries
allowing for later editing and extending of the boundaries. All softedge data extensions are also
automatically calculated into the trim. When activating this option, a File Dialog Box prompts for the
destination directory, and suggests the destination edl name (the current project name with '_Trim' appended
to it). You can change to a new folder and/or change the edl name (I recommend leaving the name the same
and just changing the folder). The original files are named the same with the '_Trim' appended. The process
is completely automatic with no further prompting. You will see the progress as the Region's list hi-lites
each region, one at a time, working its way down from top to the bottom of the list. You may cancel at
anytime by pressing the Esc-Key. This will delete the newly created .edl file and all newly created .wav and
.wpd files. Your original session is untouched during this process and remains completely intact.

* The MultiTrack label dialog box now pops-up slightly below the current track, so that you may easily
reference region displays on the track that you are entering a label for.

* The Wide Mixer View may now be completely programmed into the F-Key views. It will hide and show
according to your F-Key programming.

* A new Src Load display in the MultiTrack displays the percentage load of the data gathering routine that
reads and prepares the audio data from the disk or ram and places it into the MultiTrack source track buffers.
If this routine is keeping fully ahead of the MultiTrack and Soundcard demands, then the value will hover
around 0%. If this routine is having difficulty keeping up, the value will rise and stop playback as it reaches
100%.

* The Zoom Mixer label font is now using the default larger size font.

* Pressing the Add To MT button or the Insert-Key in the Regions View now adds multiple selected regions to
succesive MultiTrack tracks, starting at the current HotTrack and incrementing from there for each
additional region.

* The Setting and Clearing SoftEdge options from the MT-Entry Properties menu are now responsive to
selected entries in Select Mode.

* The EDL Modified Flag is now set whenever mixer controls are adjusted. This will prompt you to save the
current session whenever you exit or otherwise change sessions.

* Pressing the SpaceBar-Key will now toggle playback in the MultiTrack, SoundFile, Regions and Library
Windows.

* Right-Clicking in the Regions View or Library View Top Client area will toggle playback on and off. This
can be used to overide the normal behaviour of the listbox area Right-Click restarting playback of the region.

* The Clear Unused Regions option has been added to the Regions Menu. This option removes all regions not
being used in the MultiTrack session on any layer. Referenced files are also cleared if no other region is
linked to the same file.

* The Recent Session FileList option has been added to the File Menu. This option displays a list of the last 30
accessed session files and complete paths, which can be used to quickly re-open commonly accessed session



files. The list is ordered with the most recent session file on top. Pressing the Shift-Key when selecting an
entry will remove that entry from the list.

* The Recent SoundFile FileList option has been added to the File Menu. This option displays a list of the last
30 accessed soundfiles and complete paths, which can be used to quickly re-open commonly accessed
soundfiles. The list is ordered with the most recent soundfile on top. Pressing the Shift-Key when selecting
an entry will remove that entry from the list.

* The Record ReTake option has been added to the Record Remote window. Left-Clicking the Retake Zone
will popup a menu of 3 choices. The ReTake To Last Record Position option removes the last recorded
regions and resets the file pointers for each active file to the last punch-in position. The ReTake To Current
MT Position option splits the last recorded regions at the MT Cursor position and removes the right halfs
and rests the file pointers to this same position. The ReTake All option clears all regions associated with the
active record files and resets the file pointers to the beginning of the file. Be careful, these options are all
final and destructive.

* The I, R, and O zones at the bottom of the MultiTrack will now force the Input, Return or Output section to
the left edge of the mixer views, rather than just being visible.

* Pressing the Ctrl-Key while Left-Clicking the SoundFile View Mrk Beg or Mrk End button marks the entire
soundfile.

Bug Fixes
* Solo switches pressed in Automation mode now work correctly. You may freely enter Automation mode

with solos pressed or not and they will correctly solo the associated channels. Solo switches do not
automate.

* Changing SampleRate or Resolution while record meters are open, now correctly checks file headers and
alters filenames if needed to match parameters. In SoundFile View recording, if you select an existing
filename from the filename dialog box, SampleRate and Resolution parameters will be altered to match the
existing header, and the filename will be kept as a starting filename for the next time SF record is activated.

* Recording in the MultiTrack will now correctly update the SoundFile View File if it is the same as one of
the MultiTrack recording files.

* Right_Clicking in an empty Regions View now correctly detects that the list is empty.

* The Automation Fade To Next Change function now correctly creates an Undo Entry.

* Default Mixer Templates saved with patched FX will no longer cause a page fault when running the
program.

* The Clear Mixer To Default function will now correctly clear FX patch windows if there is no Default Mix
Template saved which includes FX patches.

* Aux Send In Switch programming has been adjusted to trap sync issues and page fault problems when



automated.

* Wide Mixer refresh has been corrected to properly adjust window size to match track type when updating.

* When activating FX Patch windows from Mixer views, they will now correctly follow the current mixer
channels regardless of the status of the mixer view links to the MultiTrack.

* Wide View tracking when mixer view links are inactive should not page fault anymore.

>---<

Version 1.2 Pre-Release

Enhancements
* SampleRate Conversion is now active in the BuildMix options.

* Automatic SampleRate conversion in the MultiTrack is now active. Every region connected to a file which
is a different samplerate than the current session rate will be converted to the session rate, live, in realtime
during playback. The MT-Entry will also be adjusted to reflect its proper boundaries and waveform display.
This does add CPU overhead, so its best to try to keep the session rate set to the rate of the majority of
entries.

* Sample Edit Zoom mode is now active in the SoundFile View. Zoom in past the Zoom In Full position to
display each individual sample point. The Up-Arrow-Key and Down-Arrow-Key will shift the display center
up or down allowing you to see the tips of magnified transient waveforms in detail. The Ctrl-Up-Arrow-Key
or Ctrl-Down-Arrow-Key will reset the display center to center.

* Sample Edit Mode Waveform Drawing is now active in the SoundFile View. When in Sample Edit Zoom
mode, you may grab any sample point by Shift-Left-Clicking on the sample. The cursor changes to an X
shaped crosshair. Dragging the mouse up or down will adjust the value of that sample. As you drag the
mouse left or right once this drawing mode is activated, you can adjust each sample point that you pass over.
The waveform will rubberband to your new shape. The sample you are controlling does not change to the
next sample until your cursor passes over the next sample point square. Therefore, all positons to the right of
a sample square, up to the next sample square, control the sample square to the left of the cursor. If you are
trying to adjust only one sample, lean the cursor to the right of it, becuase if you lean slightly to the left of
the square, you will begin adjusting the sample to the left of the original one you grabbed. Be careful, this is
immediately destructive to the soundfile and peakdata file. There is currently no way to undo this operation.

* DX Plug-ins now display tracks labeled as Input, Return andOutput.

* The Echo Plug-in has been modified to display tracks labeled as Input, Return and Output.

* The EQ Plug-in has been modified to display tracks labeled as Input, Return and Output.

* The Exploded View and Wide View windows have been changed from their On-Top status back to standard
popup windows. This allows other windows to ride on top of them... for instance the FX Patch Builder



windows.

* The Record Meter Input selection will now remember the last input type (stereo, mono, or chan) that you
selected and begin with the same type when openeing up a new set of meters.

* The Open Record Template File option has been added to the File Menu. This option allows you to open a
preset Record Template which can then be utilized by pressing the Ctrl-Key and any MultiTrack Record
Button.

* The Save Record Template File option has been added to the File Menu. This allows you to save the current
last Record Template created by closing the Record Window containing a configuration of meter
assignments.

* Added Midi Control Template support for the Yamaha 01V mixer.

Bug Fixes
* Meter decays now follow samplerate correctly maintaining the same average decay times.

* Sizing mixer views beyond the last channel size will now correctly adjust the starting channel to avoid
channel wrap-around display at the right side of the view.

* MultiTrack marked area displays that were not correctly redrawn after certain operations are now fixed.

* Region Memory caching now correctly includes SoftEdge data which eliminates page faults on SoftEdge
entriies during playback.

* Adding and Clearing SoftEdges now correctly clear and adjust Region Memory caching pointers.

* Active Aux Masters will no longer loop a static buffer if all Aux Sends are disengaged.

* Aux Sends on the same track to different pre and pst configurations at the same time will no longer cause a
conflict.

* Double-Clicking within a patch window to open an already opened DX Plug-in is now correctly trapped
instead of opening a duplicate window that will most likely cause a page fault when attempting to close
them.

* The Echo Plug-in now correctly displays its About screen on top of the plug-in.

* The EQ Plug-in now correctly displays its About screen on top of the plug-in which also now correctly
displays as an ontop window.

* Invalid Input Device assignments on Record Meters are now correctly trapped.

>---<



Version 1.1 Pre-Release

Enhancements
* Changes were made to the Drag And Drop operation. Due to problems with the multi-selection Shift-Key

operation within the Regions View ListBox, the Drag And Drop initiation command has been changed to the
Alt-Left-Click. You may also initiate a Drag And Drop from a Marked Area in the SoundFile and
MultiTrack Views by Alt-Left-Clicking from inside the Marked Area. If the MultiTrack View is in
Automation mode, this option is not functional and the Marked Area is used to manipulate Automation
entries.

* A new automatic file naming convention for SoundFile View recording has been designed. You may
override the default name at any time by Left-Clicking in the Setup Zone at the top of the Record Remote
panel. SoundFile View recording will create an automatic default name when you press the SF Record
button as follows:

If no default Record SoundFile path has been setup in the Options menu File Path Setup dialog, and no
current session name exists, then a file named Untitled_SF.wav will be placed in your SAWStudio program
\Audio folder... for example C:\SAWStudio\Audio\Untitled_SF.wav. If a current session name exists, then
that path and name will be used as a base... for example D:\Projects\CurSession_SF.wav. The _SF is
added to denote SoundFile recording.

If a default Record SoundFile path has been setup in the Options menu File Path Setup dialog, then a file
named Untitled_SF.wav will be placed in that folder... for example D:\Audio\Untitled_SF.wav. If a
current session name exists, then that name will be used as a base and appended to the default path instead
of Untitled_SF.wav... for example D:\Audio\CurSession_SF.wav. The _SF is added to denote SoundFile
recording.

The last used name will be remembered the next time you press the SF Record button within the same
session. Closing the session and/or opening a new session will clear the last used SoundFile record name.

* The current soundfile record file name is now displayed as a label on the record meter during SoundFile
View recording.

Bug Fixes
* Fixed Page Fault Errors that would occur after copying marked areas to another layer and switching and

manipulating the data on the new layer with waveform display ON and Region Peak Memory caching option
active.

* When active MultiTrack playback tracks have no data, the playback is now correctly trapped and canceled.

* Recording meters assigned to console channels as inputs are now correctly trapped if no input device is
assigned to those channels.



* Alt-Left-Clicking in the mixer top client zones to select channels is now corrrectly trapped when not used in
the proper sequence. The idea is to first Left-Click a starting channel, then Alt-Left-Click a different channel
to select all channels in between.

* BuildMix operations which use buffer size changing plugins, especially on the output track, will now build
correctly without glitched buffers.

* The SoundFile View Refresh function will now correctly build 20 and 24 bit packed peakdata files.

>---<

Version 1.0 Pre-Release

Enhancements
* This represents the first public release of the product. It is called a pre-release because there are missing

elements that are still to go in before the actual packaged full release version. This is, however, quite a jam
packed version which should easily get things rolling and introduce you into the new world of SAWStudio
editing and mixing. Most of the basic elements and operation details are covered in the built-in HelpFile...
PLEASE READ IT.... it will greatly enhance your experience. This is a complex environment, but one
which is extremely rewarding once learned. Options that did not make the helpfile at release time are
covered briefly here.

* There is a new zone in the Top Client area of the SoundFile View between the Zoom zones and the Magnify
zones. The Lock zone (denoted by a small padlock icon) can be used to lock the zooms and magnification to
the current settings as you double-click elements into the SoundFile View. When the lock is open, the
zooms and magnification follow the individual elements as they were saved.

* Adjusting either Dynamics EQ band while pressing the Shift-Key will now lock the two bands together and
adjust the other one also. This allows you to set a bandwidth and keep the same spread while you search for
a center frequency.

* Drag And Drop from the Regions View and SoundFile View is now active. Shift-Left-Click on a Region in
the Regions View or on a Marked Area in the SoundFile View. Move the Drag And Drop cursor to the
MultiTrack and Left-Click again to drop the entry. Left-Click anywhere outside the MultiTrack to cancel the
operation.

* Enhanced the Import EDL function to retain its own separate path and not disturb the normal EDL path.
Also added the Ctrl-OK click option to bypass missing file warnings. The import will finish even with
missing files. You can then save it as a Studio EDL and Open the session to Browse and repath the files.

* The Open SoundFile And Refresh option is now active. This will open a soundfile and refresh its preakdata
file which controls screen draw information. You may also refresh the currently open soundfile by pressing
the R-Key in the SoundFile View.

* SoundFile View Recording is now active. Left-Clicking the record button on the SoundFile View pops up the
recording meter and Record Remote window. You may set an input device or channel source by Left-



Clicking in the input zone on the meter. You may record without entering a filename. A default name will be
built using your current session name with an appended _SF (for soundfile). You may override the auto
naming by Left-Clicking in the Setup zone at the top of the Record Remote window. It is recommended that
you take control of the naming and pathing of these files. The Setup window also allows you to change the
SampleRate and Bit Resolution of the recording. When you press the Record button, the file will be loaded
and snapped to the end, and a Marked Area will begin displaying and expanding to indicate the progression
of the recording. When you press the Stop button, the waveform will update and the Marked Area will be
ready for you to adjust and begin creating Regions if you desire.

Bug Fixes

>---<

>====<


